
 

 

 

 

 

CAEPIPE
™

 

Technical Reference Manual 



 

CAEPIPE Technical Reference Manual, Version 10.50, © January 2022, SST Systems, Inc. All 

Rights Reserved. 

 

 

 

 

 

 

 

 

 

 

Disclaimer 

Please read the following carefully: 

This software and this manual have been developed and checked for correctness and accuracy by SST 
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CAEPIPE and CAdvantagE are trademarks of SST Systems, Inc. All other product names mentioned in 
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Thank you for licensing CAEPIPE (pronounced kay-pipe), the simple yet powerful software 
for solving a variety of piping design and stress analysis problems in numerous industries 
listed below. 

Power(fossil & nuclear) Oil & Gas production (onshore & offshore) 
Refinery Chemical & Petrochemical 
Fertilizers Pharmaceutical 
Sugar  & Food Processing Paper & Pulp 
Steel / Metal Process Water & Waste Treatment 
Aircraft and Aerospace Building Services 
Defense Industries Ship Building 

CAEPIPE performs linear and nonlinear static and linear dynamic analyses of piping systems 
by imposing various loads such as deadweight, thermal, seismic, wind, spectrum, time history 
or harmonic, and calculates displacements, forces, moments, stresses, support loads etc. 
Further, it checks whether the piping system is piping code and guideline compliant (ASME, 
B31, European, Swedish, API 610, etc.) and producesconcise, formatted and easy to 
understand reports. 

For rapid modeling, CAEPIPE offers you a friendly and productive user interface that 
rigorously adheres to Windows standards. Open up to four windows simultaneously to get 
feedback on different aspects of the model. Extensive graphical display capabilities allow you 
to zoom, pan, rotate the image and see the model from different viewpoints. CAEPIPE uses 

the industry standard OpenGL® to render 3D images realistically for easy visualization. As 

the model is input and modified, CAEPIPE updates the graphics simultaneously to provide 
visual feedback. It animates deflected shapes and mode shapes, and shows color-coded stress 
contours, among others. 

A true powerhouse in its speed of operation, CAEPIPE uses advanced Windows 
programming techniques such as intelligent repainting, scroll box tracking, multithreading, 
memory-mapped files for faster data access, among others, to make your job easier and 
faster. Every effort is made to keep the program and data file sizes small (e.g., program size is 
~2 MB! And a 665-element piping model is 85 KB!). 

Many thoughtful and useful details in the program allow you to work more productively. For 
example, you can annotate your model with copious comments for enhanced 
documentation, or duplicate repetitive inputwith one hotkey combination or rotate sections 
of the model with one operation. No unnecessary buttons clutter the toolbar nor are you 
forced to use a mouse unnecessarily. The many thoughtful keyboard shortcuts, too, add to 
your productivity. 

Overall, CAEPIPE stands peerless among the tools available today for piping design and 
stress analysis. We invite you to explore the software so that you can make full use of its 
capabilities. Our friendly and knowledgeable support engineers are available to assist 
you.Should you need to reach them, please email:  support@sstusa.com. 

Two sections make up this manual: 

1. Explanation of menus from the different CAEPIPE windows,  
2. Appendices with related information.  

The manual ends with an index. 

file:///C:/Users/PC/Desktop/ULTRA%20CURRENT%20PROJECT/support@sstusa.com
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An Anchor is a support that restrains the pipe movement at a node in the three translational 
and the three rotational directions (i.e., restrains the node in all six degrees of freedom). In a 
physical piping system, this node may be on an anchor block or a foundation, or a location 
where the piping system ties into a wall or a large piece of equipment like a pump.  

 

An Anchor is input by typing “A” in the Data column or selecting Anchor from the Data 
Types dialog. A rigid anchor is entered (i.e., an anchor with rigid stiffnesses in all six degrees 
of freedom) by default. To change the default, edit the anchor by double-clicking on the 
anchor or pressing Ctrl+D in the row that has the anchor. An Anchor dialog is shown next. 

 

Uncheck the “Rigid” checkbox to make the anchor non-rigid (i.e., a flexible anchor), and 
enter numerical values for stiffnesses in the six degrees of freedom. 

Stiffness 

The stiffness for a degree of freedom may be rigid (specified by typing the letter “r” in the 
stiffness field), or some value or be left blank. If it is left blank, there is no stiffness in that 
degree of freedom, i.e., the pipe is free to move in that degree of freedom. Internally, the 
rigid stiffness value is set to 1×1012 (lb./inch) for translational stiffness and 1×1012 (inch-
lb./radian) for rotational stiffness. 

Releases for Hanger Selection 

These releases apply only during the automatic selection of a hanger by CAEPIPE. If you 
checked any of the Release check boxes, the pipe is assumed to be free in that released 
degree of freedom during the automatic hanger selection by CAEPIPE.  You may release any 
combination of degrees of freedom at a hanger node during such automatic hanger selection. 
This feature is useful when hangers are located near equipment, where you want the hangers 
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to carry most of the weight load and thus reduce the load acting on the nearby equipment. 
CAEPIPE, during hot load calculation (preliminary sustained load case) in hanger design, 
releases the anchors (if you selected any of the Release checkboxes) so that the weight loads 
are taken by the hangers rather than by the anchors (which represent the equipment). 

After the hot load calculation, CAEPIPE restores the original values of stiffnesses to the 
released anchors before continuing analysis. Release anchors when they are (typically) within 
four (4) pipe diameters away from the nearest hangers. 

You may release any combination of translations or rotations. Typically, either the vertical 
translation or all translations and rotations are released. To release the Anchor in a particular 
degree of freedom, check the corresponding checkbox. 

.Displacements.  

The dialog for Specified Displacements at an Anchor is shown below. 

 

At an anchor, three types of translations and/or rotations in the global X, Y and Z directions 
may be specified as listed below. 

1. Thermal displacements (up to 10sets can be specified, one each for thermal loads T1 
through T10). Applied only to the corresponding Expansion and Operating load cases.  

2. Seismic displacement (were available for B31.1, B31.9, ASME Section III Class 2, RCC-
M and EN 13480 codes only. Starting Version 10.50 of CAEPIPE, Seismic displacement 
is available for all codes). Solved as a separate internal load case, the results of which are 
added absolutely to static seismic and response spectrum load cases.  

3. Settlement (available under ASME B31.1, ASME Section III Class 2, RCC-M and EN 
13480 codes only). Applied as a separate load case called Settlement.  

You may specify a displacement only if you also specify a corresponding non-zero or rigid 
stiffness in that degree of freedom, i.e., the corresponding stiffness should not be left blank.  
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Check “Displacements in LCS” if you want to enter anchor movements in the local 
coordinate system. These local movements are transformed into the global coordinate system 
and displayed in results.  

Settlement 

For certain piping codes (ASME B31.1, ASME Section III Class 2, RCC-M and EN13480), 
an anchor settlement, which is a single non-repeated anchor movement (e.g., due to 
settlement of foundation), may be specified. This is applied to the Settlement load case. For 
those codes that do not have a provision for settlement (like B31.3), specify the anchor 
settlement as a thermal displacement (which tends to be a conservative approach) for one of 
the temperature load and define that temperature as equal to reference temperature. 

Anchor in Local Coordinate System (LCS) 

Check the box “Anchor in LCS” if you want to orient the anchor along a skewed line using 
its local coordinate system (LCS), which also aids you in specifying Displacements in LCS. 
Notice the naming convention changes (KXX changes to kxx, X changes to x, and so on). 

Note: 

1. Pressure Thrust (End-cap Force) of Pressure P x Inner Area (A) of pipe is not included 
in the Support Loads for Anchors displayed by CAEPIPE at this time.  Since 
CAEPIPE’s results for numerous problems compare well with the results from other 
third-party software, it confirms that the other stress programs are also not including the 
Pressure Thrust (End-cap Force) of pipe in the Anchor Loads at this time. Refer to the 
Verification Manual supplied with CAEPIPE for comparison of results with other stress 
programs. 

If you wish to include the effect of Pressure Thrust (End-cap force) due to internal 
pressure in your piping on the Anchor loads, then you will have to compute the same 
manually (= P x A) and input it as an external force at the Anchor Nodes using the Force 
data type available with CAEPIPE. Please choose the option “Add to W+P” in the 
Force data type dialog. By doing so, the End-cap force (= P x A) will be included in all 
relevant load cases and combinations of CAEPIPE. Of course, when the “None” code is 
selected under Options>Analysis> Code, this End-cap force is included in the only case 
of “Static”. 

2. At an Anchor defined in space to which a pipe support is attached, a “dummy”elementhasto be added. 
This additional element should be defined such that the Local Coordinate System forthis element should 
be the same as the Local Coordinate System of the attached Anchor. 

Example 1: Flexible Anchor 

Nodes on most large equipment are modeled as rigid anchors. If you need to specify a non-
rigid (i.e., flexible) anchor (for example at a nozzle to include vessel flexibility), you can input 
those stiffnesses by editing the anchor. 

Double click on the anchor to show the anchor dialog. 
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By default the anchor has all stiffnesses rigid, no releases for hanger selection and no 
specified displacements. The stiffness fields are grayed, i.e., non-editable and the Rigid 
checkbox is checked. Click on the Rigid checkbox to uncheck it. The stiffness fields now 
become editable. 

 

Type in the required stiffness values and press Enter or click on OK. The anchor definition 
shown in the next figure is now modified to be a flexible anchor. 

 

Example 2: Rigid Vertical Support with Foundation Settlement 

Assume that you need to model a vertical support on a foundation that has settled using 
ASME Section III Class 2 (1980) code for code compliance. 

Vertical settlement (–Y) = 6 inches. 

First, set the piping code to ASME Section III, which has a provision for Settlement load 
case, using the menu Options > Analysis > Code in the Layout window. 

Next, create a rigid vertical support at the required node. Press “a” in the Data field to input 
a default anchor. 

Next, edit the anchor so that it acts as a vertical support only, by modifying the stiffnesses 
similar to Example 1 so that only a Rigid stiffness KY in the Y direction remains. 
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Now the anchor is modified to act as a Vertical 2-way rigid support. Click on the 
Displacements button and type in –6 (inch) for Settlement under Y. You could also input 
thermal and seismic displacements if required. 

 

The anchor is now modified to be a rigid vertical support with a specified settlement 
displacement. 

Example 3: Anchor Release during Hanger Design 
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CAEPIPE lets you model equipment nozzles as anchors. Assume that you had one on a 
turbine, as shown above, and that you have placed a hanger nearby. The main purpose of 
this hanger would be to carry most of the piping weight that would have been imposed on 
the nearby turbine nozzle if not for the hanger. To let CAEPIPE do that, you will have to 
release all six degrees of freedom of the Anchor during hanger design so that the hanger will 
be designed to carry most of the piping weight. 

First, enter an anchor for the node and then double click on it to edit it. 

 

Click on the checkboxes for Releases for hanger selection in the required directions (X, Y, Z, 
XX, YY, ZZ). The anchor will be released in the specified directions during hanger design. 

CAEPIPE restores the anchor to its original state (of no releases) after completing the 
preliminary hot load calculation during hanger design. Refer to the section on Hanger Design 
Procedure for further details. 
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A ball joint is a zero-length pipe element that allows rotations about the three orthogonal 
global axes (similar to a universal coupling joint in the rear axle of a motor vehicle) while still 
allowing the fluid to flow through it.  If you do not want rotation in the torsional or (the 
two) bending directions, input “Rigid” for the respective stiffnesses. Since the ball joint is a 
zero-length element, the “From” and “To” nodes are coincident. Hence, you should leave 
the DX, DY and DZ fields in the Layout window blank (CAEPIPE will not let you enter a 
value). 

A ball joint is input by typing “Ba” or “Ball” in the Type column or selecting Ball joint from 
the Element Types dialog. 

 

The Ball joint dialog is shown. 

 

Weight of the ball joint is input in lbf or kgf and NOT its mass. Whenever mass is required 
for a calculation as in the case of forming Mass matrix for dynamic analysis, or in calculating 
inertia force as (mass x acceleration) for static seismic analysis, CAEPIPE internally 
computes the mass  to be equal to (weight / g-value). 

The rotational stiffnesses, rotation limits and the friction torques are specified independently 
in the bending and torsional directions. The torsional direction (local x) is determined by the 
preceding element’s local x. If a preceding element is unavailable, the following element is 
used to determine the torsional direction. The bending directions (local y and z) are 
orthogonal to the torsional direction (local x). Bending friction is determined by a resultant 
of frictiontorques in local y and z directions. Similarly, bending rotation limit is determined 
by a resultant of rotational limits in local y and z directions. 
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The stiffnesses, rotation limits and friction torque values are available from the manufacturer 
of the ball joints or from their test results. Otherwise, you must use engineering judgment. 

The stiffness values may be left blank, in which case CAEPIPE uses a very small value (1 in.-
lb./rad) internally to avoid dividing by zero during internal computation. 

A rotation limit of zero (0.0) means that the ball joint cannot rotate (i.e., it is rigid) in that 
direction. A rotation limit of “None” or Blank means that rotation is not limited to a finite 
value.  

 

When the applied torque is less than the friction torque, there is no rotation. When the 
applied torque exceeds the friction torque, rotation is calculated as shown above. When 
rotation limit is reached, there is no further rotation irrespective of the applied torque. 

When the option “Use friction in dynamic analysis” is selected, for modal analysis, 
CAEPIPE uses three different stiffnesses for a ball joint depending on the magnitude of the 
applied moment/torque in comparison to the user-specified friction torque. They are as 
follows: 

Case 1: When the applied moment at the ball joint (for the first operating load case when a 
piping code is selected or for the static case when “Piping code=None” is selected) is 
less than the friction torque, the friction is not overcome and the ball joint stiffness 
is internally set to "rigid”, i.e., 1×1012 (inch-lb./radian). 

Case 2: When the applied moment is more than the friction torque, the friction is overcome 
and the ball joint starts rotating (with the user-specified rotational stiffness being 
applied). This rotational deformation takes place until the user-specified rotational 
limit is reached. 

 So, from the time friction is overcome to the time when the rotational limit is 
reached, CAEPIPE internally sets an “equivalent stiffness” for the ball joint as given 
below. 

 If Kb is the user-specified stiffness for the ball joint,  

 Rotation = (applied moment – friction torque)/ Kb ……… (1) 

 The “equivalent stiffness” chosen by CAEPIPE is the slope of the straight line from 
origin to the point (rotation, applied moment) in the figure given above. In other 
words, 
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 Kbe = (applied moment/rotation) …….. (2)  

 Combining (1) and (2), you get 

 Kbe = (applied moment) x Kb / (applied moment – friction torque) ……. (3) 

Case 3: When the actual rotation reaches the user-specified rotational limit for the first 
operating load case/static case, the rotational stiffness for the ball joint is again set to 
"rigid”, i.e., 1×1012 (inch-lb./radian). 

For modal analysis, CAEPIPE uses “equivalent stiffness” for ball joints as described under 
Case 2 above, when the friction torque is exceeded and the computed rotation is yet to reach 
the specified rotational limit, as long as the option “Use friction in dynamic analysis” is 
selected. When this option is NOT selected, CAEPIPE ignores the nonlinearities of the ball 
joint (namely, friction torque and rotational limit) and uses only the user-specified stiffnesses 
for modal analysis. That is why, despite very small moments, large rotations may be 
computed (i.e., a check against user-specified rotational limit is not performed). 

See the topic Expansion Joints for examples. 
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You can model elaborate structural systems inside CAEPIPE alongside the piping to be 
supported. In simple situations, if the structure is much stiffer than the piping is, you may 
not need to model the structure at all but simply treat it as rigid (for example: input Rigid for 
Stiffness in a vertical Limit stop when simulating a support where pipe could rest on a stiff 
beam). But, in cases where you need to account for structural flexibility, use the Beam 
element to model structural support systems alongside piping systems. 

The material, section and load for a beam are different from those for a pipe. Just as you 
would define a material/section/load for a pipe, so too should you define a separate 
material/section/load for a beam.  Look for Beam Material, Beam Section, and Beam Load 
(under Misc menu). 

Upon analysis, CAEPIPE reports forces and moments for beam elements. 

A beam is input by typing “bea” in the Type column or by selecting “Beam” from the 
Element type dialog. 

 

The Beam dialog is shown. 

 

 



Beam 

 

13 

Beta angle 

Beta angle is used to define the orientation of a beam’s local axes. See Beam orientation later 
in this section. 

Beam End Releases 

Each end of the beam (From and To ends) can be released to simulate the type of structural 
support you want to model. That is, you can use a combination of releases to specify whether 
a beam end is fixed, pinned, etc. 

Beam material 

Before you input a beam element, you must define a beam material, section and load. Select 
Beam materials from the Miscellaneous (Misc) menu in the Layout or List window. 

 

A beam material list window is shown. Double click on an empty row to input a new beam 
material. 

 

A dialog for inputting beam material is shown. 
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The material name can be up to five alpha-numeric characters to identify the beam material. 
A more complete description can be entered under Description. Enter modulus of elasticity, 
Poisson’s ratio (Nu), density of the material and mean coefficient of thermal expansion 
between Tref and T1/T2/T3/…./T10 in beam load. 

Beam section 

Select Beam Sections from the “Misc” menu in the Layout or List window. 
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A list of beam sections is shown. Double click on an empty row to input a new beam 
section. 

 

A dialog to input beam sections is shown. 

 

You can either input the data yourself or click on the AISC Library button for a listing of 
different AISC I-beams, channels, tees, etc., that are built into CAEPIPE or click on the 
Library button (next to AISC Library) for a listing of different User Defined Beams. Be sure 
to verify the properties that are shown in the fields after you select a section from the library. 

The name can be up to five alpha-numeric characters to identify the beam section. A more 
complete description can be entered in the Description field. 

The axial area, major and minor moments of inertia must be input. Input of torsional 
constant is optional. If it is not input, it defaults to the sum of major and minor moments of 
inertia. Input of shear areas is optional. If they are not input, shear deflection is not included. 
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Input of depth and width are optional. Presently, they are used only for rendered plots of the 
beam. 

Dialogs for selecting a beam section from the AISC library are shown below: 

 

The type of the beam section (e.g., I beam, W (Wide Flange)) is selected from this dialog. 

Another dialog which shows various available sections for the particular beam section type is 
then shown. 

 

After selecting the section, click on OK and the section properties will be entered in the 
Beam section dialog. 



Beam 

 

17 

 

To create or modify a Beam section library 

CAEPIPE offers you flexibility in creating your own Beam section libraries (user-defined 
libraries). That way, you do not feel restricted by the offered choices in Beam sections and 
can continually keep updating / adding Beam section libraries with your own sections. To 
create a library: From the Main window, select File > New and click on Beam Section 
Library. 

 

A List window for Beam section is shown. 
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You can, as before, start typing directly into the fields, or enter properties through a dialog. 
The only difference is that sections in the library do not have names whereas those in a 
model have names. 

After you are done entering sections, you must save to a Beam Section library file by using 
the File > Save command. 

 

Give the file a suitable name. The file will be saved with a .bli extension. 

 

Beam load 

Select Beam Loads from the Misc menu in the Layout or List window. 
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A list of beam loads is shown. 

 

Double click on an empty row to input a new beam load through the beam load dialog or 
start typing into the fields. 

 

The Load name can be up to five alpha-numeric characters to identify the beam load. You 
can enter up to 10 temperatures depending on the preset number of thermal loads. The 
additional weight is a uniform weight per unit length added to the weight of the beam. This 
could for example be used to add snow load to the beam. Wind load may or may not be 
applied to the beam element by using the check box for Wind load 1/2/3/4 in the dialog or 
typing “Y” or “N” for Wind loads in the List window. 
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Beam orientation 

The Beam orientation is determined by the locations of the “From” and “To” nodes and the 
beta angle of the beam element. The local x-axis of the beam is always from the “From” 
node to the “To” node. The reference orientation corresponds to beta = 0.0. 

A nonzero beta angle (measured from the reference position) rotates the local y- and z-axes 
of the beam about the local x-axis of the beam in the counter clockwise direction. 

The local coordinate system for beams can be displayed for each beam element through the 
List window (Ctrl+L, select Beams, menu View > Show LCS [for Local Coordinate System]). 

Global vertical axis is Y 

Beam is not Vertical 

 

The local y-axis of the beam lies in the local x - global Y plane (i.e., vertical plane) and is 
in the same positive direction as the global Y axis. The local z-axis is the cross product of 
the local x and y-axes. Major bending plane is local x-y, that is, Izz = Major moment of 
inertia and Iyy = Minor moment of inertia. 

Beam is Vertical 

 

The local z-axis of the beam is in the global Z direction. The local y-axis is in global –X 
direction. Major bending plane is x-y, i.e., Izz = Major moment of inertia and Iyy = 
Minor moment of inertia. 
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Global vertical axis is Z 

Beam is not Vertical 

 

The local z-axis of the beam lies in the local x - global Z plane (i.e., vertical plane) and is 
in the same positive direction as the global Z-axis. The local y-axis is the cross product of 
the local z and x-axes. Major bending plane is x-z, that is, Iyy = Major moment of inertia 
and Izz = Minor moment of inertia. 

Beam is Vertical 

 

The local y-axis of the beam is in the global Y direction. The local z-axis is in global –X 
direction. Major bending plane is x-z, i.e., Iyy = Major moment of inertia and Izz = 
Minor moment of inertia. 
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Example 1: Pipe Rack using Beams 

Here, you see how to use a beam element to construct a pipe rack and connect the beam to 
the pipe so that CAEPIPE can account for the rack’s flexibility. The procedure is simple. 
First, you need to create a beam material, section and load in addition to pipe material, 
section and load. 

As the Layout window shows, model the piping (nodes 10 to 40) and the first beam support 
(nodes 100 to 140). Then, create the second beam support (nodes 150 to 190) using the 
Generate command (under Edit menu in the Layout window). Finally, connect piping at 
nodes 20 and 30 to beam nodes 120 and 170 using limit stops. 

 

The “Generate” dialog is shown below: 
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The “Limit Stop” dialog is shown below: 

 

The graphics is shown below: 

 

Example 2: Base Supported Bend using a Beam 

See Example 7 in the Bend section of this manual for modeling a base supported bend using 
a beam. 
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Bellows expansion joints are flexible elements included in high temperature piping systems to 
absorb primarily thermal movement. A Bellows contains one or more convolutions designed 
to withstand the internal pressure while still flexible enough to absorb the axial, lateral and 
bending deflections. Before use, you should note the critical pressure at which the bellows 
becomes unstable. The B31.1 piping code suggests that expansion joints may be employed 
only “when piping bends, loops, and offsets are not able to provide adequate flexibility.” 
(Para. 11.5, 2010).  

Usually manufacturers of these expansion joints publish product catalogs that contain 
technical information about the joints you could use in your systems. The EJMA (Expansion 
Joint Manufacturers Association) also publishes a standards catalog with guidelines that 
“assist users, designers, and others in the selection and application of expansion joints for 
safe and reliable piping and vessel installation.” 

A Bellows joint is input by typing “bel” in the Type column or selecting “Bellows” from the 
Element Types dialog. 

 

The Bellows dialog is shown. 

 

Expansion joints are mainly modeled using the above shown four types of stiffnesses – axial, 
bending, torsional and lateral. The required stiffness values, pressure thrust area and weight 
should be taken from the manufacturer’s catalog. 
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For a rigid stiffness (for example, torsional), enter “r” for Rigid; if highly flexible, enter 1 
(lb/in.) as a minimum, to avoid dividing by zero during internal computation. 

 

Axial: Refers to axial extension (as in cryogenic systems) or contraction (as in high-
temperature systems) axially along its centerline while in operation. 

Bending (angular): Refers to the bellows bending about its center point on the centerline. 
Bending can be in any plane that passes through the centerline. 

Lateral: Refers to the direction perpendicular to the centerline of the bellows. The two ends 
of the bellows remain parallel to each other while their centerlines are displaced causing an 
offset. This direction is also called transverse or parallel offset direction. 

Torsional: Usually very stiff, refers to a twisting moment at one bellows end while the other 
end either relatively is stationary or twists in the other direction, about the bellows centerline.  

The pressure thrust area will impose a thrust load of: (pressure × thrust area), on both nodes 
of the bellows. Even if the bellows is tied, it is recommended that the pressure thrust area be 
input. The weight is the empty weight. CAEPIPE adds the weight of the contents, insulation 
and additional weight to the empty weight. 

Weight of the bellows joint is input in lbf or kgf and NOT its mass. Whenever mass is 
required for a calculation as in the case of forming Mass matrix for dynamic analysis, or in 
calculating inertia force as (mass x acceleration) for static seismic analysis, CAEPIPE 
internally computes the mass  to be equal to (weight / g-value). 

Mean diameter is the “mean” between the outer and inner diameters of any Convolution of 
the bellows. Since outer and inner diameters of all convolutions of the bellows are the same, 
the Mean diameter is the same for all convolutions of that bellows. 

Pipe guides are needed adjacent to the bellows because of its inherent flexibility and the 
compressive loading on the adjacent pipes due to the pressure thrust of the joint. Moreover, 
proper guiding is necessary to direct thermal movement into the joint and prevent buckling 
of the line.  Depending on the bellows behavior, you should place the first guide no farther 
than four pipe diameters from the joint. Place additional ones appropriately after studying 
the nearby deflections and loads.  

Also, consider vessel and anchor movements, which may cause a misalignment at the 
joint.See the topic on Expansion Joints for examples. 
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In CAEPIPE, the term Bend refers to all elbows and bends (custom-bent pipes). An elbow 
comes prefabricated with a standard bend radius (short or long radius) whereas a bend is 
custom- made from bending a straight pipe with a specified bend radius. Geometrically, a 
bend is a curved pipe segment which turns at an angle (typically 90° or 45°) from the 
direction of the run of the pipe. Some of the items associated with a bend are shown below. 

 

Node 20 is the Bend node, also referred to as the Tangent Intersection Point (TIP). As you 
can see from the figure, it is not physically located on the bend. Its only purpose is to define 
the bend. CAEPIPE automatically generates the end nodes of the curved portion of the 
bend (nodes 20A and 20B), called the near and far ends of the bend. The bend end nodes 
(20A and 20B in the figure) may be used to specify data items such as flanges, hangers, 
forces, etc. 

A bend is input by typing “b” in the Type column or selecting “Bend” from the Element 
Types dialog. 
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If you need to modify an existing bend, double click on it or press Ctrl+T (Edit type) to 
bring up the Bend dialog. 

 

Bend Radius 

The radius of a bend (measured along the centerline of the bend) can be specified as Long, 
Short, or User (defined) by one of the radio buttons for Bend Radius. CAEPIPE has long 
and short radii built-in for standard ANSI, JIS, DIN and ISO pipe sizes. For nonstandard 
pipe sizes, Long radius is equal to 1.5 times the pipe OD and Short radius equal to the pipe 
OD. 

Bend Thickness 

Input the wall thickness of the bend if different from the preceding pipe’s thickness. If 
specified, the Bend Thickness applies only to the curved portion of the bend (node 20A to 
node 20B in the figure above). 

Bend Material 

If the material of the bend is different from that of the preceding pipe, select the Bend 
Material from the drop down combo box. The Bend Material, if specified, applies only to the 
curved portion of the bend (node 20A to node 20B in the figure above). 

Flexibility Factor 

This factor is automatically calculated for standard elbows according to the piping code 
chosen. If you have your own Flexibility Factor, enter it here instead of the piping code 
specified Flexibility Factor. A value of 2.0, for e.g., will mean that the bend is twice as flexible 
as a pipe of the same length. 
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SIFs 

These factors are automatically calculated for standard elbows according to the piping code 
chosen. If you have your own, specify them here (useful for FRP bends, for example), which 
will be used instead of the piping code specified SIFs. If User SIFs are also specified at bend 
nodes (A and/or B nodes), they will be used instead of the bend SIFs or code specified SIFs. 

Intermediate Nodes 

An intermediate node, located in between the ends of the bend, may be required in some 
situations to specify data items such as flanges, hangers, forces, etc. You can create an 
intermediate node by giving a (new) node number and an angle for it, which is measured 
from the near end of the bend (node 20A in figure). Up to two such nodes may be input. 
Note that the intermediate nodes 13 and 16 shown below are at angles of 30° and 60° 
respectively from node 20A (near end). The intermediate nodes can be used for specifying 
data items such as flanges, hangers, forces, etc. 

 

Note: 

CAEPIPE will issue a message "Angle is too short" when the User tries to add an 
intermediate node at an Angle less than 4.5 degree. Similarly, will issue a message "Angle is 
too large" when the user tries to add an intermediate node at an Angle less than 4.5 from the 
Far end. 

Bend Examples 

Some examples follow. They illustrate some common modeling requirements. 

Example 1: 90° Bend 

Example 2: 45° Bend and Pipe routing along a smooth curve 

Example 3: 180° Bend 

Example 4: Flanged Bend 

Example 5: Reducing Bend 

Example 6: Bend Supported by a Hanger 

Example 7: Base Supported Bend 

Example 8: Circular Piping 
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To simplify the discussion of bend modeling, it is assumed that the material, section (8” 
STD), load and the first node (10) are already defined. It is also assumed that the bend has 
long radius (12”) and the cursor is placed in row #3. 

 

 

Example 1: 90° Bend 

 

 Press Tab in row #3. Node 20 will be automatically assigned and the cursor will 
move to the Type column, type “B” (for Bend), Tab to DX, type 2. Enter material, 
section, load and press Enter. The cursor moves to the next row (#4).  

 Tab to the DY column. The next Node 30 is automatically assigned. In DY column, 
type -2 and press Enter. This completes the bend input.  
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Example 2: 45° Bend and Pipe routing along a smooth curve 

 

 Press Tab in row #3. Node 20 will be automatically assigned and the cursor will 
move to the Type column. type “B” (for Bend), Tab to DX, type 1’6”. Enter 
material, section, load and press Enter. The cursor moves to the next row (#4). 

 Tab to the DX column. The next Node 30 is automatically assigned. In the DX 
column, type 1, Tab to DY and type -1, then press Enter. This completes the bend 
input.  

 

To route a pipe along a smooth curve, you need to split that curve into a number of circular 
arc segments. Each circular arc segment is then defined as a bend element by giving the 
offsets (DX, DY and DZ) from the previous Point or Bend Tangent Intersection Point (TIP) 
to the next TIP, as done for the 450 bend above. You continue this process until the routing 
along the smooth curve is completed. 
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Example 3: 180° Bend 

A 180° bend or U-bend, is often used in an expansion loop to relieve thermal stresses in the 
piping system. It is modeled as two 90° bends back-to-back. 

 

 Press Tab in row #3. Node 20 will be automatically assigned and the cursor will 
move to the Type column. type “B” (for Bend), Tab to DY, type –1’6”. Enter 
material, section, load and press Enter. The cursor moves to the next row (#4).  

 Press Tab. Node 30 will be automatically assigned and the cursor will move to the 
Type column. type “B” (for Bend), Tab to DX, type 2. (DX is 2’ because 8” std long 
radius bend has 12” radius and since these two bends are back to back, DX = 2R). 
Press Enter and the cursor moves to the next row (#5).  

 Tab to the DY column. The next Node 40 is automatically assigned. In DY column, 
type 1’6”, then press Enter. This completes the bend input.  
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Example 4: Flanged Bend 

Bends are often connected to the adjacent pipe sections with flanges. A flange may exist on 
one or both sides of the bend. Flange weight may have a significant effect on the pipe 
stresses. Also, the stress intensification and flexibility factors for a bend will decrease if one 
or both of the ends are flanged. 

 

Model the bend as in Example 1. Then input flanges at nodes 20A and 20B. Since these are 
internally generated nodes, i.e., they do not normally appear in the Layout window, it is 
necessary to specify input at these nodes using the Location type. To input the flange at node 
20A, in row #5, type 20A for Node, Tab to Type column and type “L” for Location. This 
opens the Data Types dialog. 
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Select Flange as the data type and click on OK. This opens the Flange dialog. 

 

Select the Type of the flange from the drop-down combo box, e.g., Single welded slip-on 
flange. To get the weight of the flange, click on the Library button. 

 

Select the pressure rating for the flange (e.g., 600) and press Enter. The weight of the flange 
is automatically entered in the Flange dialog. Press Enter again to input the flange. 

Repeat the same procedure for the flange at node 20B. 
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The graphics is shown below: 

 

The rendered graphics is shown below: 
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Example 5: Reducing Bend 

CAEPIPE does not have a reducing bend element. A reducing bend may be modeled using 
an average OD (outside diameter) and average thickness of the large and small ends of the 
bend. The bend radius of the reducing bend should be input as user bend radius. The Stress 
Intensification Factor (SIF) of the reducing bend, if available, should be input as Bend SIF. 

 

 The 8” std pipe (OD = 8.625”, Thk = 0.322”) with Name = 8 is already defined. 
Now define a 4” std pipe (OD = 4.5”, Thk = 0.237”) with Name = 4.  

The average OD of the two sections is (8.625 + 4.5) / 2 = 6.5625” and the average 
Thickness is (0.322 + 0.237) / 2 = 0.2795”.  

Define a “Non Std” section with Name = AVG, OD = 6.5625” and Thickness = 0.2795”. 

The list of sections is shown below.  

 

 Note that the section specified on the Bend row in the Layout window applies to the 
curved portion of the Bend (between the A and B nodes) as well as to the straight 
portion from the preceding node to the A node. In this case, we want to assign the 
section “AVG” only to the curved portion and assign the section “8” to the straight 
portion. This can be done by defining an additional node that is coincident with the 
A node thus making the straight portion of the bend zero length.  

 In row #2, the first node (10) is already defined and the cursor is placed in row #3. 
Type 15 for Node, Tab to DY, type -8”. Enter material (1), section (8), load (1) and 
press Enter. The cursor moves to the next row (#4). 

 Press Tab. Node 20 is automatically assigned and the cursor will move to the Type 
column, type “B” (for Bend), Double click in the Type column to edit the Bend. 
Click on the User Bend Radius button and type 16 for bend radius. Press Enter to 
modify the Bend and return to the Layout window. Tab to DY, type -1’4”. Tab to the 
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section column and type “AVG”. Then press Enter. The material and load are copied 
from the previous row and the cursor moves to the next row(#5). 

 Tab to the DX column. The next Node 30 is automatically assigned. In DX column, 
type 2’. Tab to section column, type 4 and then press Enter. This completes the 
reducing bend input. 

The Layout window is shown below: 

 

The graphics is shown below: 

 

The rendered graphics is shown below: 
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Example 6: Bend Supported by a Hanger or Resting Support 

Bend supported in the middle by a hanger or resting support as shown in the figures below 
can be modeled by defining an intermediate node at Bend. 

   

Assuming that the Bend is supported in the middle of the hanger, Model the bend as in 
Example 1. The hanger is input at node 15, which is in the middle of the bend. Node 15 is 
created as an intermediate node on the bend as follows: 

Double click on the bend (in the type column of the Layout window) to edit it. The bend 
dialog is shown. 
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Under intermediate nodes, type 15 for node and 45 for its angle, then click on OK. This 
creates an intermediate node 15 at 45° from the node 20A (near end of the bend) as shown 
in the figure above. 

Since node 15 does not show in the Layout window, it is necessary to specify data input at 
this node using the Location type. To input the hanger at this node, in row #5, type 15 for 
Node, Tab to Type column and type “L” for Location. This opens the Data Types dialog. 

 

Click on Hanger, the hanger dialog is shown. 

 

Click on OK to accept the default hanger and a hanger is entered at node 15. 

 

The rendered graphics is shown next. 
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Follow a similar approach above to model a resting support at the middle of the Bend. 

Example 7: Base Supported Bend 

Two examples of base supported bends are shown below. In the figure on the left, the 
support is modeled using a rigid vertical restraint. In the figure on the right the support is 
modeled using a beam element. 

 

Vertical Restraint Support 

 Model the bend at node 20 as before.  

 To put a vertical restraint at node 20B, type 20B for node and “L” for Location. This 
will open the Data types dialog. 
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Double click on Restraint. This will open the Restraint dialog. 

 

 Click on the Vertical button to check the Y or Z restraint (depending on the vertical 
axis) and click on OK.  

The Layout window is shown below: 
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The graphics is shown below: 

 

Beam Support 

 Model the bend at node 20 as before.  

 Create a beam material, section and load as described earlier under the Beam section 
in the Technical Reference manual.  

 Input a beam element from node 20B to node 100.  

Type 20B in the Node column and “f” (for From) in the Type column to create a starting 
point. Press Enter to move to the next row.  

Type 100 in the Node column and “bea” (for Beam) in the Type column. In the DY 
column, type the beam length with a negative sign (since the beam is going downward 
from node 20B to node 100). Type the beam material, beam section and beam load names 
in the Matl, Sect and Load columns. In the Data column type “a” to input an Anchor.  

The Layout window is shown below: 

 

The rendered graphics is shown below: 
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Example 8: Circular Piping 

Circular piping around the Nuclear Containment or Tank can be modeled using a series of 
Bends. Depending upon the number of nodes required to represent the layout and its 
supports, one can decide the required bend angle.  

In this example, Bends with 22.5degrees are chosen to represent the layout. The center line 
diameter of the Circular pipe layout is 96” and the Section property is 3” Schedule 40. 

Origin of the Circular piping is at absolute coordinates Xo=150”, Yo=30” and Zo=0.0”. 

Vertical Axis is chosen as “Z”. 

With reference to the Origin, absolute coordinate for Node 10 is  

X' =150”+Radius (96”) = 246”; Y'=30” and Z' =0.0”. 

Bend Angle chosen (A) = 22.5 deg. 

Distance between Origin and Tangent Intersection Point (TIP) = R' = Radius / COS(A/2) = 
96/COS(11.25) = 97.88”. 

 

Using the above information, absolute coordinates and the offset distances for TIP nodes are 
computed and presented in the Table below. 

Two layouts are generated. 

The first layout is generated using absolute coordinates and hence under the Node column 
you will see a “*” after the Node number in CAEPIPE layout, meaning that DX, DY and 
DZ values are not offsets, instead they are absolute coordinates for the Node being input..  

The second layout is generated using the Offset Distances listed in the table below. 
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Ring Radius = Bend Radius (in) 96 Bend Angle 22.5 

  Xo (in) Yo (in) Zo (in) 

Absolute Coordinates of Circular Ring Center 150 30 0 

  X' (in) Y' (in) Z' (in) 

Absolute Coordinates for Node 10 246 30 0 

  

TIP 
Node 

Angle (B) @ 
Tangent 

Intersection 
Point (TIP) 

(Deg) 

R' = 
Distance 
between 

Origin and 
TIP  
(in) 

Absolute Coordinates Offset Distances 

X' = Xo + 
[COS(B) x R'] 

(in) 

Y' = Yo + 
[SIN(B) x R'] 

(in) 
DX 
(in) 

DY 
(in) 

20 11.25 97.88 246.00 49.10 0.00 19.10 

30 33.75 97.88 231.38 84.38 -14.62 35.28 

40 56.25 97.88 204.38 111.38 -27.01 27.01 

50 78.75 97.88 169.10 126.00 -35.28 14.62 

60 101.25 97.88 130.90 126.00 -38.19 0.00 

70 123.75 97.88 95.62 111.38 -35.28 -14.62 

80 146.25 97.88 68.62 84.38 -27.01 -27.01 

90 168.75 97.88 54.00 49.10 -14.62 -35.28 

100 191.25 97.88 54.00 10.90 0.00 -38.19 

110 213.75 97.88 68.62 -24.38 14.62 -35.28 

120 236.25 97.88 95.62 -51.38 27.01 -27.01 

130 258.75 97.88 130.90 -66.00 35.28 -14.62 

140 281.25 97.88 169.10 -66.00 38.19 0.00 

150 303.75 97.88 204.38 -51.38 35.28 14.62 

160 326.25 97.88 231.38 -24.38 27.01 27.01 

170 348.75 97.88 246.00 10.90 14.62 35.28 
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Layout using Absolute Coordinates 
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Layout using Offset Distances 
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As an example, shown below are the snap shots to split the Bend at Node 30 with an 
intermediate Node 35 and to place a Limit Stop at that intermediate Node 35. 
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A tee is modeled using three pipes that come together at a node, which should be designated 
as a “Tee” using the Branch SIF data type.  If not, then CAEPIPE cannot calculate a code-
specified SIF for the tee to use in stress calculations. 

A Stress Intensification Factor (SIF) type for a tee can be input by typing “br” in the Data 
column or selecting “Branch SIF“ from the Data types dialog. 

 

The Branch SIF dialog is shown. 

 

The type of the branch SIF can be selected from the Type drop-down combo box. 
Depending on the piping code selected, different types of branch SIFs may be available. 
Typical branch SIF types (for B31.1 piping code) are shown below. 

 

A few branch SIFs may need additional input; for example, in the case of a reinforced 
fabricated tee, a pad thickness is required. 
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The field “No. of Flanges or Rigids at Run Pipe ends…” shown above is available only when 
the Option “Use B31J for SIFs and Flexibility Factors” is turned ON through Layout 
window > Options > Analysis for B31.x codes. This field can be blank or entered as 1 or 2. 

When entered as either 1 or 2, CAEPIPE will multiply the flexibility factors for the Branch 
by a factor ‘c’ provided in “Table 1-3 – Flanged End Corrections” of ASME B31J-2017. For 
more details, see the section titled “ASME B31J-2017” from Code Compliance Manual. 

CAEPIPE differentiates between a header (run) and a branch line based on their ODs. So, 
when CAEPIPE finds two lines with ODs of 8 inches and 6 inches coming together at a 
node, it designates the 8 inch line as the header (or main) line with the 6 inch line designated 
as the branch line (this is also how you would model a reducing tee). 

When the header and the branch lines have the same ODs, reduce the branch OD slightly so 
that the header and the branch lines are properly designated (e.g., ODheader = 168.4 mm, 
ODbranch = 168.3 mm). 

Examples: 

Say you want to model a reducing tee as shown in the provided “Sample.mod”.  It’s an 8”x6” 
reducing tee.  First, we need to model the three pipes – two for the run (nodes 20 to 30 and 
30 to 40), one for the branch (nodes 30 to 60), which will be assigned the 6” section. Each 
pipe section can have its own OD/Thickness. Lastly, designate the common node as a (Butt) 
Welding Tee. 
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The Tee is as shown at node 30 in the graphics window below. 

 

A “latrolet” or a lateral tee (commonly, the branch is at a 45° angle from the header) or a Y-
joint is modeled like a regular tee (as above).  But, the SIF for this joint needs to be input by 
you after consultation with the tee/joint manufacturer.  Use a “User-SIF” data type at the 
common node to specify the SIF.  See topic on Tees for more information. 
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Soil in Buried piping analysis is modeled by using bilinear restraints with an initial stiffness 
and an ultimate load. After the ultimate load is reached, the displacement continues without 
any further increase in load, i.e., the yield stiffness is zero. The initial stiffness is calculated by 
dividing the ultimate load by the yield displacement which is assumed to be D/25 where D is 
the outside diameter of the pipe. 

Soil modeling is based on Winkler’s soil model of infinite, closely spaced elastic springs. Soil 
stiffness is calculated for all three directions at each node. The pressure value in the load is 
suitably modified to consider the effect of static overburden soil pressure. The model is 
analyzed for operating (W+P1+T1) condition and the displacements in the three directions 
are noted. A check is made for whether skin friction is mobilized and the soil has attained the 
yield state. If true, then the spring is released in that direction, indicating that soil no longer 
offers resistance in that direction. This modified model is again analyzed and checked for the 
yield stage. The iterative process is continued until the percentage difference between 
displacements at each node for two successive iterations is less than 1%. The final stiffness is 
the true resistance offered by the soil to the pipe. 

General Procedure to model buried piping 

1. First, define soils using the command Misc > Soils in the Layout or List window.  

2. Next, tie these defined soils with pipe sections (Ctrl+Shft+S to list Sections, double click 
on an empty row, you will see the field Soil in the bottom right corner. Pick the soil 
name from the drop-down combo box).  

3. Use this modified section for each element on the Layout window that is buried with this 
soil around it.  

4. Discretize long sections of buried piping (Refine Nodal Mesh) through Layout window 
> Edit > Refine Nodal Mesh > Buried Piping. 

It is at the bends, elbows, and branch connections that the highest stresses are found in 
buried piping subjected to thermal expansion. These stresses are due to the soil forces 
that bear against the transverse runs. The stresses are proportional to the amount of soil 
deformation at the elbows or branch connections. Hence, piping elements adjoining to 
bends, elbows and branch connections are to be discretized in the stress model. 

In addition, to best simulate Winkler’s soil model, it is recommended to discretize even 
the remaining long straight buried pipe sections in the stress layout 

The details of such discretization are explained below. 

Refinement of Nodal Mesh for Buried Piping 

Modulus of Subgrade Reaction (k) 

This factor k defines the resistance of the soil or backfill to pipe movement due to the 
bearing pressure at the pipe/soil interface. Several methods for calculating modulus of 
subgrade reaction (k) have been developed in recent years. As per Trautmann, C.H., and 
O’Rourke, T.D., “Lateral Force-Displacement Response of Buried Pipes,” Journal of 
Geotechnical Engineering, ASCE, Vol. 111, No. 9 Sep 1985, pp. 1077-1092, the modulus of 
subgrade reaction, k, can be calculated as per Eq. (2) in Appendix VII of ASME B31.1-2018 
code. 

wDNCk hk  
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where, 

Ck = a dimensionless factor for estimating horizontal stiffness of compacted backfill. Ck may 
be estimated at 20 for loose soil, 30 for medium soil, and 80 for dense or compacted soil. In 
the current version of CAEPIPE, the value of Ck is internally set as 80 for both cohesive and cohesionless 
soil. 

D = pipe outside diameter 

w = soil density 

Nh = a dimensionless horizontal force factor from Fig. 8 of above stated technical paper. For 
a typical value where the soil internal friction angle is 30 deg. the curve from Fig. 8 may be 
approximated by a straight line defined by 

Nh = 0.285H/D + 4.3 

where 

H = the depth of pipe below grade at the pipe centerline  

Influence Length (Lk) 

The influence length is defined as the portion of a transverse pipe run which is deflected or 
“influenced” by pipe thermal expansion along the axis of the longitudinal run. 

From Hetenyi’s theory, (Beams on Elastic Foundation, The University of Michigan Press, Ann Arbor, 
Michigan 1967) (also, see Section VII-3.3.2 of Appendix VII of ASME B31.1-2018 code) 





4

3
kL  

where, 

Pipe / Soil System Characteristics = 

4/1

4 









EI

k
  

E = modulus of elasticity of pipe at reference temperature 

I = moment of inertia of pipe cross section 

k = modulus of subgrade reaction of soil as detailed above. 

Implementation in CAEPIPE 

As stated earlier, it is at the bends, elbows, and branch connections that the highest stresses 
are found in buried piping subjected to thermal expansion of the pipe. These stresses are due 
to the soil forces that bear against the transverse runs. The stresses are proportional to the 
amount of soil deformation at the elbows or branch connections. Hence, piping elements 
adjoining to bends, elbows and branch connections are to be discretized in the stress model. 

In addition, to best simulate Winkler’s soil model, it is recommended to discretize even the 
remaining long straight buried pipe sections in the stress layout 

This can be performed through Layout window > Edit > Refine Nodal Mesh > Buried 
Piping.  
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When the command is selected, CAEPIPE will refine the piping layout as detailed below. 

1. Calculate modulus of subgrade reaction (k) as detailed above. While calculating k, the 
value of Ck is taken as 80 for both cohesive and cohesionless soil. 

2. Calculate influence length (Lk) for the element that is fully buried. 

3. If the length of the pipe element near bend / elbow / branch connection is greater 
than or equal to the influence length (Lk), then the pipe element will be split into a 
number of short elements with length of each short element being equal to 2 x OD 
of that pipe section until the Influence length (Lk).  

4. On the other hand, if the length of the pipe element near bend / elbow / branch 
connection is less than the influence length (Lk) and greater than 2 x OD of the pipe, 
then the pipe element will be split into a number of short elements with length of 
each short element being equal to 2 x OD of that pipe section. 

5. If any buried straight pipe element is longer than the influence length (Lk), then the 
straight pipe element will be split into a number of equal length elements, where the 
number of such equal length elements will be computed as [(int)(Original Straight 
Pipe length/Influence Length) + 1]. For example, if the total length of straight pipe 
element is equal to 1843” and influence length is 400”, then the straight pipe will be 
split into 5 equal length elements [= (int)(1843/400) + 1 = ((int)(4.61) + 1) = (4 + 
1)] with each element having a length of 368.6” [= 1843/5]. 

Note:  

While refining the layout, the new node number will be generated by adding the node 
increment specified (through Layout Window > Options > Node increment) to the available 
free node number. Hence, set the node increment value as required before refining the 
buried piping layout. 



Buried Piping 

 

53 

It is possible to specify different soil characteristics for different portions of the pipe model. 
Here is how. 

1. Define different soils using the command Misc > Soils.  

2. Associate each soil type with those sections that are buried in that soil. 

3. Model the buried layout using the different sections for different buried portions.  

Ground Level 

Ground level for soil is the height of the soil surface from the global origin (height could be 
positive or negative). It is NOT a measure of the depth of the pipe’s centerline. 

In the figure, the height of the soil surface is 3 feet above the global origin. Pipe node 10 
[model origin] is defined at (0,-5,0). So, the pipe is buried 8’ (3’ - [-5’]) deep into the soil. 
Define similarly for the other soil. 

The pipe centerline is calculated by CAEPIPE from the given data 

 

Depth of Soil above Pipe’s Centerline 

When the option “Value entered is Depth of Soil above pipe centerline” is turned ON in Soil 
input then CAEPIPE will compute maximum soil loads for the sections buried using the 
Depth entered. This option will be helpful for modeling pipes that are running up or down a 
hill with same depth of soil filled above pipe’s centerline as shown in the figure given below. 

 

Warning: 

Assign Soil only to those elements that are really buried in soil when the option “Value 
entered is Depth of Soil above pipe centerline” is turned ON. 
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Two Soil types 

Two types of soils can be defined - Cohesive and Cohesionless. Soil density and Ground 
level are input for both cohesive and cohesionless soils. The Ground level is used to calculate 
the depth of the buried section. For cohesive soil, Strength is the un-drained cohesive 

strength (Cs). For cohesionless soil, Delta () is the angle of friction between soil and pipe, 
and Ks is the Coefficient of horizontal soil stress. See the nomenclature below for more 
information. 

Highlight buried sections of the model in graphics 

If your model contains sections that are above ground and buried, then you can selectively 
see only the buried sections of piping in CAEPIPE graphics by highlighting the section that 
is tied to the soil. Use the Highlight feature under the Section List window and place 
highlight on the buried piping section (see Highlight under List window>View menu, or 
press Ctrl+H). The Graphics window should highlight only that portion of the model that is 
using that specific section/soil. 

Nomenclature 

When the option “Include Insulation Thickness” in “Soil” input is turned OFF, then  

D = Outside diameter of the pipe  

When the option “Include Insulation Thickness” in “Soil” input is turned ON, then  

D = Outside diameter of pipe + (2.0 x Insulation Thickness) 

Ks = Coefficient of horizontal soil stress, which depends on the relative density and state of 
consolidation of soil. Ks is empirical in nature and may be estimated from Nq/50. Ks 
can vary depending on the compaction of the soil from 0.25 (for loose soil) to 1.0 
(really compacted soil). 

Nq = Bearing capacity factor = 0.98414e
(0.107311) 

 =  + 5° 

  angle of friction between soil and pipe 
  Normal values for delta ranges between 25° – 45° (for sand). 
  Clean granular sand is 30° . With a mix of silt in it, the angle is 25° 

Sp = soil pressure = soil density × depth 

Cs = Undrained cohesive strength (input for cohesive soil), (Cs in kN/m2) ≥1.0 

Af = Adhesion factor = 1.7012775 e
(-0.00833699 Cs) 

kp = Coefficient of passive earth pressure 

 = (1 + sin ) / (1 – sin ) 

bottom depth = depth + D/2 
top depth = depth – D/2 

Nr = (Nq – 1.0) tan (1.4 ) 
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dq = dr = 1.0 + 0.1 tan (/4 + /2) × depth / D, for > 10° , otherwise dq = dr = 1.0 

Calculation of Ultimate Loads 

The ultimate loads (per unit length of pipe for axial and transverse directions and per unit 
projected length of pipe for vertical direction) are calculated as shown below. 

Different equations are used for cohesive (clayey) and cohesionless (sandy) soils. 

Axial direction 

Cohesive soil:   Axial load =  × D × Af × Cs 

Cohesionless soil: Axial load = × D × Ks × Sp × tan  

Transverse direction 

Cohesive soil:   Transverse load = D × (2 Cs + Sp + 1.5 Cs × depth / D) 
Cohesionless soil:  Transverse load = kp × kp × Sp × D 

Vertically downward direction 

Cohesive soil:   Downward load = D × (5.7182 Cs + Soil density × bottom depth) 
Cohesionless soil:  Downward load = D × (Soil density × bottom depth × Nq × dq 

 + 0.5 Soil density × D × Nr × dr) 

Vertically upward direction 

Cohesive soil:   Upward load = D × Soil density × top depth + 2 Cs × top depth 
Cohesionless soil:  Upward load = D × Soil density × top depth 

Buried Piping Example 

Ultimate Loads and Stiffnesses computed by CAEPIPE for this example are verified later in 
this section. 

Example data: 

A 12” Std pipe 6’ long is buried, 3’ in cohesionless and 3’ in cohesive soils with No 
Insulation properties 

Soil properties are as follows: 

Cohesionless (Name of soil: S1, associated with pipe section 12A): 

Density = 120 lbf / ft3 

Delta () = 20° 

Ks = 0.29 (calculated from Nq/50, where Nq = 14.394) 
Ground level = 3’ 

Cohesive (Name of soil: S2, associated with pipe section 12B): 

Density = 150 lbf / ft3 
Strength = 100 psi 
Ground level = -1’ 

1. Define soils using the command Misc > Soils. 
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A List window for soils will be displayed. Double click on an empty row to define a new soil. 

For our example, define two soils - one cohesionlessand the other cohesive with properties 
as shown in the following dialogs. 
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Dialog for cohesionless soil: 

  

Dialog for cohesive soil: 

  

After you have defined the soils, you should see the two soils listed in the List window. 
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2. Define pipe sections and then associate the soils with these sections. 

Define two pipe sections, both 12”/STD pipe sections (name them 12A and 12B), and select 
the correct soil in the pipe section dialog box using the Soil drop-down combo box. 

Soil S1 is associated with section 12A: 

 

Soil S2 is associated with section 12B: 
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3. Define the layout from 10 to 20 to 30; the first pipe element from 10 to 20 uses section 
12A (Cohesionless soil type S1), and the next pipe element 20 to 30 uses section 12B 
(Cohesive soil type S2). Check Operating load case under Loads menu > Load cases for 
analysis. 

 

Save the model and analyze. Choose yes to view the results. From the Results dialog, pick 
Soil Restraints. The soil loads and soil stiffnessesin different directions as computed by 
CAEPIPE are now shown, which are verified below in this section. 

 

Example Verification 

Verification of cohesionless restraints (for pipe element 10 to 20) 

Sp = soil pressure = soil density × depth 

depth = 3’ - (-5’) = 8’ (since the pipe centerline is at -5’ and ground level is at 3’).  
Sp = 120 lb/ft3 × 8 ft = 960 lb / ft2 = 6.6667 lb/in2 

Axial direction 

Axial load = × D × Ks × Sp × tan  

×12.75×0.29×6.6667×tan (20) 
= 28.1861 lb/in  
= 1014.7 lb (for 36”, length of pipe) (CAEPIPE: 1014.7)  

Assuming yield displacement = D/25, 
Axial stiffness  =  25 × 1014.7 / 12.75  =  1989.6 (lb /in) (CAEPIPE: 1989.6) 



Buried Piping 

 

60 

Transverse direction 

 = + 5° = 20° + 5° = 25° 
kp = Coefficient of passive earth pressure  

= (1+ sin ) / (1 - sin ) 
= 2.4639 

Transverse load = kp × kp × Sp × D 

= 2.4639 × 2.4639 × 6.6667 × 12.75  
= 516.0239 lb /in  
= 18576.88 lb (for 36”) (CAEPIPE: 18577)  

Transverse stiffness = 25 × 18576.88 / 12.75 
= 36425 lb / in (CAEPIPE: 36425) 

Vertically downward direction 

bottom depth  =  96” + 12.75”/2  =  102.375” 

Nq = Bearing capacity factor = 0.98414 e 
(0.107311 )

= 14.39366 

Nr = (Nq – 1.0) × tan (1.4 ) = 9.37834 

since > 10° 

dq  =  dr  =  1.0 + 0.1 × tan(/4 + /2) × depth / D  =  2.18188 

Downward load = D × (Soil density × bottom depth × Nq × dq + 0.5 × Soil density × D × 
Nr × dr) 
= 12.75 × ((120/1728) × 102.375” × 14.39366 × 2.18188 + 0.5 × (120/1728) × 12.75” 
×9.37834×2.18188) 
= 12.75 × 232.3305 lb / in  
= 106639.7 lb (for 36”) (CAEPIPE: 106640 lb)  

Downward stiffness = 25 × 106639.7 / 12.75 
= 209097 lb/in (CAEPIPE: 209098) 

Vertically Upward Direction 

top depth = 96” – 12.75”/2 = 89.625” 

Upward load  =  D × Soil density × top depth  
= 12.75” × (120/1728) × 89.625  
= 79.35547 lb / in  
= 2856.7968 lb (for 36”) (CAEPIPE: 2856.8) 
Upward stiffness  =  25 × 2856.7968 / 12.75  =  5601.56 lb/in (CAEPIPE: 5601.6) 

Verification of cohesive restraints (for pipe element 20 to 30) 

Sp = soil pressure = soil density × depth 

depth = –1’ – (–5’) = 4’ (since the pipe centerline is at -5’ and ground level is at -1’). 

Sp = 150 lbf/ft3 × 4 ft = 600 lb / ft2 = 4.16667 lb/in2 

D = 12.75” + (2 x 2.0) = 16.75” (as insulation thickness is defined as 2” andthe option 
“Include Insulation Thickness” is turned ON in Soil S2 input). 
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Axial direction 

Soil strength = Cs = 100 psi = 100 × 6.89476 KN/m2 = 689.476 KN/m2 

Af = Adhesion factor = 1.7012775 e
(-0.00833699 Cs)

[where Cs should be in KN/m2] 

= 5.424795E-3 

Axial load = × D × Af × Cs 
×16.75”×5.424795E-3×100 psi 
= 28.54 lb / in  
= 1027.66 lb (for 36”) (CAEPIPE: 1027.7)  

Axial stiffness = 25 × 1027.66 / 16.75 = 1533.82 lb /in (CAEPIPE: 1533.8 lb/in) 

Transverse direction 

Transverse load = D × (2 Cs + Sp + 1.5 Cs × depth / D) 

= 16.75” × [(2.0×100 + 4.166667 + (1.5×100×48/16.75)] 
= 10619.79 lb/in  
= 382312.5 lb for 36” (CAEPIPE: 382313)  

Transverse stiffness = 25 ×382312.5 / 16.75  
= 570615.67 lb /in (CAEPIPE: 570616) 

Vertically Downward direction 

bottom depth = 48” + 16.75”/2 = 56.375” 

Downward load = D × (5.7182 Cs + Soil density × bottom depth) 
= 16.75” × [(5.7182×100) + ((150/1728) × 56.375”)] 
= 9659.95 lb/in  
= 347758.34 lb for 36” (CAEPIPE: 347758) 

Downward stiffness = 25 ×347758.34 / 16.75  
= 519042.30 lb / in (CAEPIPE: 519042) 

Vertically Upward Direction 

top depth = 48” – 16.75”/2 = 39.625” 

Upward load  =  D × Soil density × top depth + 2 Cs × top depth 

= 16.75” × (150/1728) × 39.625” + (2×100×39.625”) 
= 7982.61 lb / in 
= 287374.12 lb for 36” (CAEPIPE: 287374)  

Upward stiffness = 25 ×287374.12 / 16.75  
= 428916.60 lb / in (CAEPIPE: 428917) 

References 

1. Tomlinson, M. J., Pile Design and Construction Practice. Fourth Edition. London: E & 
FN Spon, 1994. 

2. Fleming, W.G.K., et al. Piling Engineering. Second Edition. Blackie Academic and 
Professional. (Chapters 4 and 5).  
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Discretization Example 
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Soil characteristics 

Soil density, w = 130 lbf/ft3 = 0.075 lb/in3 

Pipe depth below grade, H = 12 ft (144 in) 

Type of backfill, dense sand (cohesionless soil) 

Ck = 80 

Calculation of Modulus of subgrade reaction (k) 

Nh = 0.285H/D + 4.3 

Nh = (0.285 x 144 / 12.75) + 4.3 = 7.518 

wDNCk hk
= 80 x 7.518 x 0.075 x 12.75 = 575.127 psi 

Calculation of Influence Length (Lk) 

Moment of inertia, I = 279.3 in4 

Modulus of elasticity, E = 27.9 x 106 psi 





4

3
kL  

Pipe / Soil System Characteristics = 

4/1

4 









EI

k


= [575.127 / (4 x 27.9 x 106 x 279.3)] 1/4 = 
0.01165 

Influence Length (Lk) = 3 x 3.14 / (4 x 0.01165) = 202.145 in 

As the lengths of pipe elements near the bends and branch connection are greater than the 
influence length (Lk = 202.145 in), the pipe elements near the bends and branch connection 
are split into a number of short elements with length of each short element being equal to 2 
x OD = 2 x 12.75 = 25.5 in until the influence length (Lk). See figures given below for 
details. 
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Cold spring (cut short or cut long) is used to reduce thermal forces on equipment connected 
to the piping system. When lengths of pipes are cut short or extended by design, they are 
pulled together or pushed apart to join them during installation, giving rise to a “cold-
sprung” system. 

Such an installation process (cold condition) obviously introduces stresses, which are relieved 
when the system starts up (hot condition).  Note however, that the piping codes do not allow 
credit for any reduction in stresses due to cold spring since the displacement range is 
unaffected (similar to self-springing. See B31.1 para. 119.2 fordetails).  But, codes allow 
reduction in support loads due to cold spring (which can be helpful at the equipment). 

This feature should be used only with a proper understanding of the implications. 

Cold spring for a straight pipe is input by typing “c” in the Type column or selecting “Cut 
pipe“ from the Element Types dialog. 

 

The Cut pipe dialog is shown. 

 

Select “Cut short” or “Cut long” using the radio buttons. The amount of cut (short or long) 
should be positive. 

Since the piping codes do not allow credit for cold spring in stress calculations, a cold spring 
is used in additional sustained and operating load cases (designated “Cold Spring (W+P), 
Cold Spring (W+P1+T1)” etc.) which are not used in stress calculations but are used for 
support loads and rotating equipment reports. 

Cold Spring load cases appear in the Loads menu (under Load cases) after a cold spring (Cut 
pipe element) is input into the model. The Load cases menu is shown next: 
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For analysis, select the desired Cold Spring load cases from those shown. The built-in 
Hanger selection procedure does not consider the cold spring since the selection is based on 
the first Operating (W+P1+T1) load case. However, if Cold Spring is used, the hanger loads 
for the Cold spring load cases [for example, Cold Spring (W+P1+T1)] will include the effect 
of the Cold spring.   

For an example on Cold Spring modeling and its use in reducing Anchor loads for operating 
load case(s), refer http://www.sstusa.com/caepipe-tutorials.php. 

http://www.sstusa.com/caepipe-tutorials.php
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Just as a computer programmer benefits immensely from clear documentation about the 
program, so too will an engineer benefit from clear notes, design decisions and comments 
about a piping system. Use the Comment feature to write as many notes and comments as 
required anywhere in the CAEPIPE Layout window. They can be printed along with the 
layout data. 

Two ways for putting in a comment:  

1. Simply type “c” first (in the Node column) on an empty row, or  
2. On an empty row, select “Comment” from the Element Types dialog (Ctrl+Shft+T).  

Use menu Edit > Insert (Ctrl+Ins) to insert an empty row between two existing rows of 
data. 

 

 

Rows 11, 12, 15 and 17 are the comment lines (highlighted with a light green background). 
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Pumps, compressors and turbines in CAEPIPE, referred to as rotating equipment, are each 
governed by an industry publication - API (American Petroleum Institute) publishes an API 
610 for pumps, ANSI (American National Standards Institute) publishes an ANSI/HI 9.6.2 
for Rotodynamic Pumps, API 617 for compressors and NEMA (National Electrical 
Manufacturers Association) publishes the NEMA SM-23 for turbines. These publications 
provide guidelines for evaluating nozzles connected to equipment among other technical 
information including the items relevant to piping stress analysis – criteria for piping design 
and a table of allowable loads. 

Modeling the equipment is straightforward since it is assumed rigid (relative to connected 
piping) and modeled only through its end points (connection nozzles). 

1. In your model, anchor all the nozzles (on the equipment) that need to be included in the 
analysis. 

2. Specify these anchored nodes during the respective equipment definition via Misc. menu 
> Pumps/Compressors/Turbines in the Layout window. 

CAEPIPE does not require you to model all the nozzles nor their connected piping. For 
example, you may model simply one inlet nozzle of a pump with its piping. Or, you may 
model one pump with both nozzles (with no connected piping) and impose external forces 
on them (if you have that data). Further, there is no need to connect the two anchors of the 
equipment with a rigid massless element like required in some archaic methods. 

A compressor (like a turbine or a pump) is input by selecting “Compressors” from the Misc 
menu in the Layout or List window. Upon analysis, an API 617 compressor compliance 
report is produced. See the section titled “Rotating Equipment Qualification” from Code 
Compliance Manual for related information. 



Compressor 
 

70 

 

Once you see the Compressor List window, double click on an empty row for the 
Compressor dialog and enter the required information. 

 

A short description to identify the compressor may be entered for Description. The nozzle 
nodes must be anchors and the shaft axis must be in the horizontal plane. Some of the 
nozzle nodes may be left blank if they are not considered as a part of the piping system being 
analyzed (e.g., extraction nodes). 
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If you have input multiple temperatures, corresponding reports for additional operating load 
cases are shown.
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A concentrated mass is input by typing “conc” in the Data column or selecting “Conc. 
Mass” from the Data Types dialog. 

 

The Concentrated Mass dialog is shown. 

 

The weight of the concentrated mass should be input for Weight. Weight is to be input in lbf 
or kgf and NOT in mass units. Whenever mass is required for a calculation as in the case of 
forming Mass matrix for dynamic analysis, or in calculating inertia force as (mass x 
acceleration) for static seismic analysis, CAEPIPE internally computes the mass  to be equal 
to (weight / g-value). 

The concentrated mass is located at the offset (DX, DY, DZ) from the node. Deadweight, 
seismic and dynamic loads due to concentrated masses are applied to the model. 
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A constant support hanger exerts a constant vertical supporting force on the piping, 
irrespective of whether the pipe is in hot or cold condition. It is equivalent to a weight 
pulling up the pipe through a pulley, where the same upward force is exerted on the pipe 
irrespective of the position of the pipe. The constant support load is automatically calculated 
by CAEPIPE. To analyze an existing constant support with a known load, input it as a user 
hanger with a zero spring rate. 

A constant support is input by typing “cons” in the Data column or selecting “Constant 
Support” from the Data Types dialog. 

 

The Constant Support dialog is shown. 

 

Tag 

Tag can be 14characters long. Tags are useful in identifying a support while modeling, 
reviewing of reports and in field erection. Tag Name entered in this field is shown in all 
reports. 

Number of Hangers 

The number of hangers is the number of separate hangers connected in parallel at this node. 

Connected to Node 

By default the hanger is connected to a fixed ground point which is not a part of the piping 
system. A hanger can be connected to another node in the piping system by entering the 
node number in the “Connected to node” field. This node must be above the hanger node. 
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Items such as anchors, hangers and external forces, which are defined at nodes, are input in 
the Data column as Data types; different from inline elements such as pipes, bends and 
valves that connect nodes, and are input in the Type column as Element types. 

The Data items can be selected from the Data Types dialog which is opened when you click 
on the Data header in the Layout window. 

 

You may also use the command: Misc > Data types, 

 

or press Ctrl+Shift+D to open the Data Types dialog. 

 

You can select the data type by clicking on the radio button or pressing the underlined letter 
of the item, e.g., press “f” for Flange, Force or Force spectrum load. Or, you may simply 
start typing the first few letters of the item in the Data column.  (For example, typing “fo” 
automatically opens a Force data type dialog). 



Direction 
 

75 

Direction is required for several items such as Pump, Compressor, Turbine, Nozzle (for 
vessel axis), Limit Stop, Skewed restraint, Elastic element and Hinge joint. 

The axis or the orientation of an item (listed above), is called the direction vector which is 
described in terms of the vector’s global X, Y and Z components. 

The angles the vector makes with the X, Y and Z axes are called Direction angles, whose 
cosines are called Direction cosines (or global X, Y and Z components used in CAEPIPE). 

There are two methods of computing the X, Y and Z components. 

First method: When you know the direction angles (see examples 1, 2 and 3). 

Second method: When you know the coordinates of the end points of the vector (see 
example 4). 

Example 1: Vertical Vessel 

Assume a vertical vessel with axis in the Y direction, and , ,  as the direction angles the 
axis of the vessel makes with global X, Y and Z axes. 

The angles are  = 90° ,  = 0° (since axis is parallel to Y axis) and  = 90° . 

So, the direction cosines or X, Y and Z components are 

X comp = cos ( = 90° ) = 0, 

Y comp = cos ( = 0° ) = 1, 

Z comp = cos ( = 90° ) = 0. 

For Z vertical: X comp = 0, Y comp = 0 and Z comp = 1. 

Example 2: Limit Stop at 45° from the X-axis in the X-Y plane 

For a limit stop whose axis is oriented at 45° from the X-axis in the X-Y plane, the angles are 

 = 45°,  = 45° and  = 90°. 

So, the direction cosines or X, Y and Z components are 

X comp = cos ( = 45° ) = 0.70711, 

Y comp = cos ( = 45° ) = 0.70711, 

Z comp = cos ( = 90° ) = 0.0 
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Example 3: Hinge axis at 30° from the Z-axis in the Y-Z plane 

 

From the above figure, we have the angles α = 90°, β = 60° and γ = 30°.  Assuming L = 1 
(or any length), the direction cosines or X, Y and Z components are 

X comp = cos (α = 90° ) = 0.0, 
Y comp = cos (β = 60° ) = 0.5, 
Z comp = cos (γ = 30° ) = 0.866 

Example 4: Skewed Support 

 

Assume that we have a skewed support along P1P2 (which is the direction vector) shown in 
the figure above, Assume that the coordinates of these two points are P1 = (12’,12’,12’) and 
P2 =(15’,16’,14’). 

Let us calculate this vector’s global X, Y and Z components. There are two methods here 
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Short method 

X comp = (X2 − X1) = (15 − 12) = 3  

Y comp = (Y2 − Y1) = (16 − 12) = 4 

Z comp = (Z2 − Z1) = (14 − 12) = 2 

Long method 

First, let us calculate the length of the vector, L. 

𝐿 = √(X2 − 𝑋1)
2 + (Y2 − 𝑌1)

2 + (Z2 − 𝑍1)
2 = 5.385′ 

The angles α, β and γ which the vector makes with the global X, Y and Z axes are called the 
Direction angles of the vector; The cosines of these angles are called Direction cosines. 

cos 𝛼 =  
X2 −  X1

𝐿
,  cos 𝛽 =  

Y2 −  𝑌1

𝐿
,  cos 𝛾 =  

Z2 −  𝑍1

𝐿
, 

The direction cosines are 

X comp = cos α = 0.55709, Y comp = cos β = 0.74278, Z comp = cos γ = 0.37139 

For information, the direction angles are α = 56°8’0”, β = 42°1’0” and γ = 68°11’0”. 

To verify the results, the sum of the squares of the direction cosines must be 1.0. Thus,  

cos2α + cos2β + cos2γ = 0.5570922 + 0.7427822 + 0.3713922 = 1.0 
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Modal Analysis 

The equations of motion for an undamped lumped mass system may be written as:   

[𝑀]{𝑢̈}  +  [𝐾]{𝑢} = {𝐹(𝑡)} 

Where [𝑀]= diagonal mass matrix 

 {𝑢} = displacement vector 

 {𝑢̈} = acceleration vector 

 [𝐾] = stiffness matrix 

 {𝐹(𝑡)} = applied dynamic force vector 

If the system is vibrating in a normal mode (i.e., free not forced vibration), we may make the 
substitutions 
 
 {𝑢} =  {𝑎𝑛} sin 𝜔𝑛𝑡 

 {𝑢̈} =  −𝜔𝑛
2{𝑎𝑛} sin 𝜔𝑛𝑡 

 {𝐹(𝑡)} = 0 

to obtain 

−𝜔𝑛
2[𝑀]{𝑎𝑛} +  [𝐾]{𝑎𝑛} = 0 

or 

[𝐾]{𝑎𝑛} = 𝜔𝑛
2[𝑀]{𝑎𝑛} 

where {𝑎𝑛} is the vector of modal displacements of the n𝑡ℎ mode (eigenvector). 

Thus we have an eigenvalue (characteristic value) problem, and the roots of equation (2) are 
the eigenvalues (characteristic numbers), which are equal to the squares of the natural 
frequencies of the modes. 

In CAEPIPE, the eigenvalue problem is solved using a determinant search technique. The 
solution algorithm combines triangular factorization and vector inverse iteration in an 
optimum manner to calculate the required eigenvalues and eigenvectors. These are obtained 

in sequence starting from the lowest eigen-pair [𝜔1
2,{𝑎1}]. An efficient accelerated secant 

procedure which operates on the characteristic polynomial 

𝑝(𝜔2) = 𝑑𝑒𝑡([𝐾] − 𝜔2[𝑀]) 

is used to obtain a shift near the next unknown eigenvalue. The eigenvalue separation 
theorem (Sturm sequence property) is used in this iteration. Each determinant evaluation 

requires a triangular factorization of the matrix([𝐾] − 𝜔2[𝑀]). Once a shift near the 
unknown eigenvalue has been obtained, inverse iteration is used to calculate the eigenvector. 
The eigenvalue is obtained by adding the Rayleigh quotient correction to the shift value. The 

eigenvector {𝑎𝑛}, has an arbitrary magnitude and represents the characteristic shape of that 
mode. 

Starting from Version 10.40, the determinant of the characteristic polynomial is stored in the 
power form with an exponent of the order of matrix size. With this improvement in Modal 
analysis algorithm, CAEPIPE can now extract much higher modes (Eigen vectors) up to the 
frequency of 9999 Hz.  

(1) 

(2) 
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Orthogonality 

For any two roots corresponding to the nthand mthmodes, we may write equation (2) as 

which is the orthogonality condition for eigenvectors. 

[𝐾]{𝑎𝑛} = 𝜔𝑛
2[𝑀]{𝑎𝑛} 

[𝐾]{𝑎𝑚} = 𝜔𝑚
2 [𝑀]{𝑎𝑚} 

If we postmultiply the transpose of (3) by {𝑎𝑚}, we obtain 

([𝐾]{𝑎𝑛})𝑇{𝑎𝑚} = (𝜔𝑛
2[𝑀]{𝑎𝑛})𝑇{𝑎𝑚} 

{𝑎𝑛}𝑇[𝐾]𝑇{𝑎𝑚} = 𝜔𝑛
2{𝑎𝑛}𝑇[𝑀]𝑇{𝑎𝑚} 

Premultiplying (4) by {an}T, {an}T[K]{am} = ωm
2 {an}T[M]{am} 

Since [M] is a diagonal matrix, [M] = [M]T.  Also, since [K] is a symmetric matrix, [K] = [K]T. 
The left sides of equations (5) and (6) are therefore equal. 

Subtracting (6) from (5), 
(𝜔𝑛

2 − 𝜔𝑚
2 ){𝑎𝑛}𝑇[𝑀]{𝑎𝑚} = 0 

Since ωn ≠ ωm, 
{𝑎𝑛}𝑇[𝑀]{𝑎𝑚} = 0 

which is the orthogonality condition for eigenvectors.  

Modal Equations 

Since the eigenvectors (modal displacements) may be given any amplitude, it is convenient to 

replace {𝑎𝑛} by {∅𝑛} such that 

{∅𝑛}𝑇[𝑀]{∅𝑛} = 1 

The eigenvectors are evaluated so as to satisfy equation (9) and at the same time keep the 

displacements in the same proportion as those in {𝑎𝑛}. The eigenvectors are then said to be 

normalized. Note that equation (7) is still satisfied since, if n = m,𝜔𝑛
2 − 𝜔𝑚

2 = 0, and the 
remaining terms may be given any desired value. 

Equation (2) now may be written for the nth mode as 

[𝐾]{∅𝑛} = 𝜔𝑛
2[𝑀]{∅𝑛} 

Let [Φ]be a square matrix containing all normalized eigenvectors such that the nth column is 
the normalized eigenvector for the nth mode. We can therefore write the matrix equation so 
as to include all modes as follows: 

[𝐾]{Φ} = [𝑀][Φ][𝜔𝑛
2] 

Where [𝜔𝑛
2] is a diagonal matrix of eigenvalues. We now premultiply both sides of (10) by 

[Φ]Tto obtain 

[𝛷]𝑇[𝐾][𝛷] = [𝛷]𝑇[𝑀][𝛷][𝜔𝑛
2] 

(4) 

(3) 

(5) or 

(6) 

(7) 

(8) 

(9) 

(10) 

(11) 
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It may be shown that 

[𝛷]𝑇[𝑀][𝛷] = [𝐼] 

where [𝐼] is the unit diagonal matrix. Equation (12) can easily be verified by expansion and 

follows from the orthogonality condition and the fact that [Φ] has been normalized. 
Equation (11) therefore can be written as 

[𝛷]𝑇[𝐾][𝛷] = [𝜔𝑛
2] 

Returning now to the equation of motion (1), 

let {u} = [Φ]{An} 

         and {ü} = [Φ]{Än} 

Where {𝐴𝑛} is the modal amplitude of the nth mode. This merely states that the true 

modal displacements equal the characteristic displacements (eigenvector displacements) 
times the modal amplitude determined by the response calculations and, further that the total 
displacements are linear combinations of the modal values. If we now pre-multiply equation 

(1) by [Φ]Tand substitute equations (14), we obtain 

[𝛷]𝑇[𝑀][𝛷]{𝐴̈𝑛} + [𝛷]𝑇[𝐾][𝛷]{𝐴𝑛} = [𝛷]𝑇{𝐹(𝑡)} 

Substituting from equations (12) and (13) in equation (15), 

{𝐴̈𝑛} + [𝜔𝑛
2]{𝐴𝑛} = [Φ]T{𝐹(𝑡)} 

which represents the modal equations of motion. 

Uniform Support Motion 

Solutions for uniform support motion (when all supports experience the same excitation)  

may be obtained if {𝐹(𝑡)} is replaced by−𝑢̈𝑠(𝑡){𝑀}where 𝑢̈𝑠(𝑡) is the prescribed support 
acceleration. Thus the modal equations of motion may be written as 

{𝐴̈𝑛} + [𝜔𝑛
2]{𝐴𝑛} = −𝑢̈𝑠(𝑡)[Φ]T{𝑀} 

where 𝐴𝑛is the relative modal displacement for the nth mode with respect to the support. 

The participation factors for the modes are given by 

{Γ𝑛} = [Φ]T{𝑀}{1} 

Then the modal amplitude contribution from  the nth mode is given by 

𝐴𝑛 = Γ𝑛𝑢𝑛
0 

Where un
0 is the response of a single degree of freedom system having circular frequencyωn. 

Using equations (14) and (19), the total displacements from M modes are given by 

{𝑢} = [Φ]{𝐴𝑛} = [Φ]{Γ𝑛𝑢𝑛
0} 

= ∑ 𝜙𝑛Γ𝑛𝑢𝑛
0

𝑀

𝑛=1

(12) 

(13) 

(14) 

(15) 

(16) 

(17) 

(18) 

(19) 

(20) 
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Effective Modal Mass 

Effective modal mass is defined as the part of the total mass responding to the dynamic 
loading in each mode. When the participation factor is calculated using normalized 

eigenvectors as in equation (18), the effective modal mass for the nth mode is simply the 

square of the normalized participation factor, 

𝑀𝑛 = Γn
2 

Effective modal mass is useful to verify if all the significant modes of vibration are 
included in the dynamic analysis by comparing the total effective modal mass with the 
total actual mass. 

Independent Support Motion (Multi-level Response Spectrum Analysis) 

When the piping is routed along the wall of a tall building, the piping supports at higher 
elevation floors of the building will experience higher seismic excitations, whereas the piping 
supports at the ground level will experience lesser seismic excitation. Likewise, a pipeline 
crossing over a bridge may experience different seismic excitations at the ends. Piping 
systems with such multiple seismic excitations can be analyzed in CAEPIPE using Multi-
level Response Spectrum Analysis. For any number of levels in a system, the participation 
factor for the nth mode with kth level excitation is given by 

{Γ𝑛,𝑘} = [Φ]T{𝑀}{𝑟𝑘} 

where, 𝑟𝑘 is the influence vector representing the simultaneous displacements of all the 
supports located at kth level.  

Then the modal amplitude contribution from the nth mode is given by 

𝐴𝑛 = ∑ Γ𝑛,𝑘𝑢𝑛,𝑘
0

𝐿

𝑘=1
 

where, L is the number of levels and un,k
0  is the response of a single degree of freedom 

system having a circular frequency ωn. The total displacements are given by 

{𝑢} = [Φ]{𝐴𝑛} = ∑ 𝜙𝑛 ∑ |Γ𝑛,𝑘𝑢𝑛,𝑘
0 |

𝐿

𝑘=1

𝑀

𝑛=1
 

Notes:  

1) Two (2) types of combinations “SRSS”and “ABS” can be performed for Level 
Summations in CAEPIPE The combination over level contributions will be 
performed first, followed by interspatial and then intermodal combination without 
the consideration of closely spaced modes. This is consistent with present NRC 
guidelines. 

2) Missing mass correction is not available for Multi-level Response Spectrum Analysis 
in CAEPIPE at this time. So, it is recommended to include a sufficient number of 
modes in the analysis and ensure that the “Modal mass / Total mass” is sufficiently 
high (thereby confirming that most of the mass of the system participates in the 
modes computed) in Global X, Y and Z directions through Results Window > 
Results > Results… > Frequencies.  

(21) 

 

(22) 

(23) 

(24) 
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Response Spectrum 

The concept of response spectrum, in recent years has gained wide acceptance in structural 
dynamics analysis, particularly in seismic design. Stated briefly, the response spectrum is a 
plot of the maximum response (maximum displacement, velocity, acceleration or any other 
quantity of interest), to a specified loading for all possible single degree-of-freedom systems. 
The abscissa of the spectrum is the natural frequency (or period) of the system, and the 
ordinate, the maximum response. 

In general, response spectra are prepared by calculating the response to a specified excitation 
of single degree-of-freedom systems with various amounts of damping. Numerical 
integration with short time steps is used to calculate the response of the system. The step-by-
step process is continued until the total earthquake record is completed and becomes the 
response of the system to that excitation. Changing the parameters of the system to change 
the natural frequency, the process is repeated and a new maximum response is recorded. 
This process is repeated until all frequencies of interest have been covered and the results 
plotted. CAEPIPE provides fourteen (14) response spectra for your convenience. Refer to 
Appendix B titled “Response Spectrum Libraries” in CAEPIPE User’s Manual for details. 

Since the response spectra give only maximum response, only the maximum values for each 
mode are calculated and then superimposed (modal combination) to give total response. A 
conservative upper bound for the total response may be obtained by adding the absolute 
values of the maximum modal components (absolute sum). However this is excessively 
conservative and a more probable value of the maximum response is the square root of the 
sum of squares (SRSS) of the modal maxima. 

To calculate response of the piping system, for each natural frequency of the piping system, 
the input spectrum is interpolated (linearly or logarithmically). The interpolated spectrum 
values are then combined for the X, Y and Z directions (direction sum) either as absolute 
sum or SRSS sum to give the maximum response of a single degree-of-freedom system:  

𝑢max
0 at that frequency. 

From equation (20) or (24) the maximum displacement vector for the nth mode can be 

calculated from the maximum response {𝑢𝑛}𝑚𝑎𝑥  of a single degree-of-freedom system. 

The maximum values of element and support load forces per mode are calculated from the 
maximum displacements calculated per mode as above using the stiffness properties of the 
structure. 
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The total response (displacements and forces) is calculated by superimposing the modal 
responses according to the specified mode sum method which can be absolute sum, square 
root of sum of squares (SRSS) or closely spaced (10%) modes method. 

Closely Spaced Modes 

Studies have shown that SRSS procedure for combining modes can significantly 
underestimate the true response in certain cases in which some of the natural frequencies of 
a structural system are closely spaced. The ten percent method is one of NRC approved 
methods (Based on NRC Guide 1.92) for addressing this problem. 

𝑅 = √∑ 𝑅𝑛
2

𝑁

𝑛=1

+ 2 ∑|𝑅𝑖𝑅𝑗| 

where 𝑅 = Total (combined) response 

 𝑅𝑛 = Peak value of the response due to the nth mode 

 𝑁 = Number of significant modes 

The second summation is to be done on all i and j modes whose frequencies are closely 

spaced to each other. Let 𝜔𝑖and 𝜔𝑗be the frequencies of the ith and jth modes. The modes are 

closely spaced if: 

𝜔𝑗 −  𝜔𝑖

𝜔𝑖
≤ 0.1  and 1 ≤ 𝑖 ≤ 𝑗 ≤ 𝑁 

Time History 

Time history analysis requires the solution to the equations 

[𝑀]{𝑢̈} + [𝐶]{𝑢̇} + [𝐾]{𝑢} = {𝐹(𝑡)} 

where [𝑀] = diagonal mass matrix 

 [𝐶] = damping matrix 

 [𝐾] = stiffness matrix 

 {𝑢} = displacement vector 

 {𝑢̇} = velocity vector 

 {𝑢̈} = acceleration vector 

 {𝐹(𝑡)} = applied dynamic force vector 

(25) 



Dynamic Analysis 
 

84 

The time history analysis is carried out using mode superposition method. It is assumed that 
the structural response can be described adequately by the p lowest vibration modes out of 

the total possible n vibration modes and p < n. Using the transformation𝑢 = Φ𝑋, where the 

columns in Φ are the p mass normalized eigenvectors, equation (25) can be written as 

𝑋̈ + ∆𝑋̇ + Ω2X = Φ𝑇𝐹 

where ∆ = diag (2𝜔𝑖𝜉𝑖) 

 Ω2 = diag (𝜔𝑖
2) 

In equation (26), it is assumed that the damping matrix [𝐶]satisfies the modal 
orthogonalitycondition 

{𝜙𝑖}𝑇[𝐶]{𝜙𝑗} = 0     (𝑖 ≠ 𝑗) 

Equation (26) therefore represents p uncoupled second order differential equations. These 

are solved using the Wilson 𝜃 method, which is an unconditionally stable step-by-step 
integration scheme. The same time step is used in the integration of all equations to simplify 
the calculations. 

Harmonic Analysis 

A harmonic analysis is performed to determine the response of a piping system to sinusoidal 
loads. Harmonic forces can arise from unbalanced rotating equipment, acoustic vibrations 
caused by reciprocating equipment, flow impedance, and other sources. These forces can be 
damaging to a piping system if their frequency is close to the piping system’s natural 
frequency, thereby introducing resonant conditions. The equation of dynamic equilibrium 
associated with the response of the structure subjected to harmonic forces is: 

[𝑀]{𝑢̈} + [𝐶]{𝑢̇} + [𝐾]{𝑢} = sin(𝜔𝑡)𝐹 

where [𝑀] = diagonal mass matrix 

 [𝐶] = damping matrix 

 [𝐾] = stiffness matrix 

 {𝑢} = displacement vector 

 {𝑢̇} = velocity vector 

 {𝑢̈} = acceleration vector 

 𝜔 = frequency of the applied force 

 𝑡 = time 

 𝐹 = maximum magnitude of the applied force 

It is feasible that multiple harmonic loads may be applied simultaneously at different 
locations of a piping system. More complex forms of vibration, such as those caused by the 
fluid flow, may be considered as superposition of several simple harmonics, each with its 
own frequency, magnitude, and phase. 

(26) 

(27) 



Dynamic Analysis 
 

85 

A harmonic analysis uses the results from the modal analysis to obtain a solution. A single 
damping factor is used for all modes. 

First, the maximum response for each harmonic load is obtained separately. Then, the total 
response for multiple simultaneous harmonic loads is determined by combining the 
individual responses. The combination method may be specified as the Root Mean Square 
(RMS) or Absolute Sum. Even in the case of a system with a single harmonic load, the said 
combination is always carried out, so that the resulting solution becomes an “unsigned” case. 
For an unsigned case, the actual values for displacements, element forces and moments, etc. 
computed internally by CAEPIPE prior to such combination can be +ve or -ve for the 
dynamic event. After the combination, the resulting values become “unsigned”. 

Dynamic Susceptibility 

Dynamic Susceptibility feature is a screening tool for potentially large alternating stresses. 
The dynamic stresses are the dynamic bending stresses associated with vibration in a natural 
mode. In other words, the modal analysis result has been generalized to include the 
alternating bending stresses associated with the vibration in a natural mode. The dynamic 
susceptibility for any mode is the ratio of the maximum alternating bending stress to the 
maximum vibration velocity. This “susceptibility ratio” provides an indicator of the 
susceptibility of the system to large dynamic stresses. Also, the associated animated mode 
shapes include color-spot-markers identifying the respective locations of maximum vibration 
velocity and maximum dynamic bending stress. The susceptibility ratio and the graphics 
feature provide incisive insights into the reasons for high susceptibility and how to make 
improvements. 

The “Modal Analysis” output load case in CAEPIPE has been enhanced. In addition to the 
modal frequencies and mode shapes, you will see two new results items called “dynamic 
stresses” and “dynamic susceptibility.” 

In case you do not see these two items in the results dialog, you need to activate this feature 
by defining an environment variable. See Annexure I for a detailed discussion. 

First method: 

An environment variable “HARTLEN” needs to be declared under My Computer > 
Properties > Environment > Variable (HARTLEN), and its Value set to (YES). Please check 
with your System Admin because different versions of Windows have slightly different 
methods of doing it. 
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Second method: 

Open the MS-DOS Command Prompt. Type “SET HARTLEN=YES” (enter), change 
directory (using CD command) to where CAEPIPE program files are located, start 
CAEPIPE.EXE. 

Upon (modal) analysis, the Results dialog will display the required results (dynamic stresses 
and dynamic susceptibility). 
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The elastic element is a general 6 × 6 stiffness matrix, with nonzero diagonal terms and zero 
off-diagonal terms. Use this element to model the stiffness of a component unavailable in 
CAEPIPE. 

An elastic element is input by typing “e” in the Type column or selecting “Elastic element” 
from the Element Types dialog. 

 

The Elastic element dialog is shown. 

 

The stiffnesses are in the local coordinate system defined by the directions of the local x-, y- 
and z-axes. As done for all other element types, the positive local x-axis for the elastic 
element is along the element from the “from” node to the “to” node. The local y-axis should 
be perpendicular to the local x-axis (i.e., their dot product should be zero). The local z-axis is 
internally calculated as cross product of the local x- and y-axes. 

The elastic element is not subjected to any sustained or thermal expansion loads. 
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CAEPIPE provides the following types of expansion joints: 

1. Ball joint, 

2. Bellows, 

3. Hinge joint and 

4. Slip joint  

Using these types, you can also model tied bellows, a gimbal, a dual gimbal, a pressure-
balanced elbow and a tee, a slotted hinge joint and a universal joint among other complex 
arrangements. 

Before selecting the types and locations for the expansion joints, you must study a piping 
system for the direction and magnitude of the thermal movements to be absorbed, 
availability of support structures for anchoring, and guiding of the piping. EJMA and 
manufacturer catalogs contain technical information that can guide you through this process. 
CAEPIPE becomes an ideal “what-if” tool for such rapid studies. 

This topic will show how to model the following types of joints: Tied bellows, hinged 
bellows, gimbal, universal hinged bellows and pressure balanced joints. Also see discussion 
on Bellows. 

Example 1: Tied Bellow (without gaps) 

Whenever a bellow is present in a piping system, the equipment nozzle/piping support 
adjacent to the bellow will experience a pressure thrust force (=pressure thrust area x 
pressure) generated by the bellow during normal operation.  Tie rods can be added to the 
bellow in order to fully absorb such pressure thrust force, while still allowing the bellow to 
laterally deflect (i.e., allowing lateral displacement and lateral rotation). 

In the example shown below, four tie rods are attached to the bellow without any “gaps” on 
tie rods on either side of the bellow. Because there are no “gaps”, the tie rods offer the same 
stiffness under both tension and compression (as long as the compression is not large 
enough to buckle the tie rods). In order to determine the axial force carried by each tie rod, 
pressure thrust area for the bellow must be input. One way of modeling the tie rods is to 
lump all four tie rods into a single tie rod along the bellow center line (with tension stiffness 
= compression stiffness = n x stiffness of each tie rod = n x EA/L, where ‘n’ is the number 
of tie rods, E is the Young’s Modulus of the tie rod material, A and L are the cross-sectional 
area and length of each tie rod). 

.  
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In the example shown above, the properties of the Tied Bellow are as follows. 

 

Note: 

Weight is to be input in lbf or kgf and NOT in mass units. Whenever mass is required for a 
calculation as in the case of forming Mass matrix for dynamic analysis, or in calculating 
inertia force as (mass x acceleration) for static seismic analysis, CAEPIPE internally 
computes the mass  to be equal to (weight / g-value). 

For Bending stiffness of the bellow, the following two options are provided. 

Option 1:  Input the Bending stiffness as specified by the manufacturer or as reasonably 
determined from industry standards such as EJMA. If a non-zero value for Bending stiffness 
is input, then leave the “Mean diameter” field blank or zero. 

Option 2:  If a non-zero value for Bending stiffness is not input as per Option 1 above and 
is left blank, then input the actual non-zero value for “Mean diameter”, in which case 
CAEPIPE will internally calculate the Bending stiffness for the bellow based on the Mean 
diameter and other inputs provided for that bellow.  In this case, the Mean diameter is the 
“mean” between the outer and inner diameters of any Convolution of the bellow. Since 
outer and inner diameters of all convolutions of the bellow are the same, the Mean diameter 
is the same for all convolutions of that bellow. 

Among the above two options, Option 1 is recommended if you are able to specify a realistic 
non-zero value for the Bending stiffness of the bellow. 

Tie Rods properties 

No. of Tie Rods (n) = 4 Nos. 

Diameter of Tie Rod (D) = 3/4” 

Length of Tie Rod (L) = 12” 

Young’s Modulus of Tie Rod (E) = 29.9E+6 psi 
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Stiffness of Tie Rods = n x AE/L = 4 x (π/4) x 0.752 x 29.9E+6 / (12”) = 4.403E+6 lb/in 

Accordingly, for Tie Rods, Tension Stiffness = Compression Stiffness = 4.403E+6 lb/in. 

 

Example 2: Tied bellow with free compression 

The model shown below has a tied bellow between Nodes 80 & 90.  Tie Rod is defined with 
the same tension stiffness and compression stiffness of 6.848E+06 lb/in (equals to 
combined axial stiffness of 4 Nos. of 1.25” dia. tie rods). However, gaps are set differently in 
the tension and compression directions, namely 0.0” in the tension direction and 2.0” in the 
compression direction (assuming 2.0” as the maximum compression permitted by the 
manufacturer). This allows the bellow to compress freely up to 2.0” and at the same time 
restricts the bellow from extension. Beyond 2.0” of compression, compression stiffness of 
tie rods will come into play. 
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From“Flex. Joint” displacements results of CAEPIPE, it is observed that the deflection for 
bellow between Nodes 80 and 90 is +0.003” for Sustained Case and -1.359” for Expansion 
load case (which is less than the compression gap of 2.0” provided). Please observe that the 
bellow compresses for the Expansion load in this model as the bellow is in between two 
anchors. This confirms that the modeling of Tied bellow with 0.0” gap for tension and 2.0” 
gap for compression directions produces the expected results. 
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Example 3: Hinged Bellow  

A hinged expansion joint contains one bellow and is designed to permite angular rotation in 
one plane only, by the use of a pair of pins through hinge plates attached to the expansion 
joint ends. The hinges and hinge pins must be designed to restrain the thrust of the 
expansion joint due to internal pressure and extraneous forces, where applicable. See Figure 
shown below. 

 
The sample model shown below has a Tied bellow between Nodes 30 and 40. The 
stiffnesses of the bellow in Axial = 2088 lb/in, Bending = 418 in-lb/deg, Torsion = 100000 
in-lb/deg (in case of unavailability of data, set the Torsional stiffness of the bellow to be the 
same as the torsional stiffness of equivalent pipe), and Lateral = 34655 lb/in. The stiffnesses 
of the hinge plates are assumed to be “Rigid” in this example.  Accordingly, to connect the 
Bellow Nodes 30 and 40 to Hinge plates, four (4) weightless “Rigid” elements are defined 
connecting the Nodes 30-70, 30-110, 40-90 and 40-140 with each one having its length as 9” 
(as the OD of the Flange is indicated as 18” in hinged bellow catalog referred).  In addition, 
four (4) more weightless “Rigid” elements were defined connecting the Nodes 70-80, 81-90, 
110-120 and 121-140 and two (2) hinges connecting nodes 80-81 and 120-121.   
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Now from the displacements results of CAEPIPE for Expansion load case, it is observed 
that the rotation at Node 40 is much larger than the rotation at Node 30 in YY direction. In 
other words, the hinges at Nodes 80 and 120 are allowing the two ends of the bellow to 
bend. This in effect confirms that the modeling of hinged bellow as shown in this model 
produces the expected results. 
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Example 4: Gimbal Bellow 

A gimbal expansion joint is designed to permit angular rotation in any plane by the use of 
two pairs of hinges affixed to a common floating gimbal ring. The gimbal ring, hinges and 
pins are designed to restrain the thrust of the expansion joint due to internal pressure and 
extraneous forces, where applicable. 

In this sample model, the Gimbal is simulated by connecting the Bellow Nodes 30 & 40 
using two “massless” Rigid Elements and one Ball Joint (i.e., a Rigid Element from Nodes 30 
to 70 followed by a Ball Joint connecting Nodes 70 & 80 and another Rigid Element from 
Nodes 80 to 40).  All the stiffnesses of the Ball Joint are made as “Rigid” excepting the 
Bending Stiffness.  The Bending Stiffness (the same applied in both “local y” and “local z” 
directions) is defined as “1” in-lb/deg.  In addition, weight of this ball joint is left blank (i.e., 
equal to 0.0).   
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As expected, the “Displacements” results for the bellow displayed in CAEPIPE have a 
sudden change in XX and ZZ rotations, confirming the fact that the Gimbal is getting 
rotated in the two orthogonal directions due to the deformation of the two orthogonal lines. 
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Example 5: Universal Hinged Expansion Joints 

Universal Hinged Expansion Joints have two bellows separated by a pipe spool with overall 
length restrained by hinge hardware designed to contain pressure thrust. A hinged universal 
expansion joint accepts large lateral movements in a single plane with very low spring forces. 

This sample model simulates the Universal Hinged Expansion Joints with two Tie Rods 
using the CAEPIPE's Tie Rod elements. The advantages of this model are (a) stiffness of the 
tie rods can be input explicitly (in this case, stiffness corresponding to 1" dia tie rod is input) 
and (b) gaps can be specified to simulate slotted holes.  

In this sample model, the Universal Hinged Expansion Joint is simulated by connecting the 
Bellow Nodes 30 & 60 using Tie Rods and “massless” Rigid Elements, namely four 
“massless” Rigid Elements connecting Nodes 30-100, 30-220, 60-180 and 60-270; two Tie 
Rods connecting Nodes 100-180 and 220-270 and four hinges connecting Nodes 140-150, 
160-170, 230-240 and 250-260. See snap shots shown below for details. 
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Example 6: Pressure Balanced Elbow Expansion Joint 

Pressure Balanced Elbow Expansion Joints can consist of a single or double bellows in the 
flow section, and a balancing bellow of equal area on the back side of the elbow. Tie rods 
attach the outboard end of the balancing bellow to the outboard end of the flow bellows. 
Under pressure, the tie rods are loaded with the pressure thrust force. If the flow bellows 
compresses in service, the balancing bellow extends by the same amount without exposing 
the adjacent anchors to pressure thrust forces. However, the spring forces associated with 
bellows movements are imposed on the adjacent equipment. A pressure balanced elbow type 
expansion joint can accept axial compression, axial extension, lateral movements and 
very limited angular motion. 

The sample model shown below simulates the Pressure Balanced Elbow Expansion Joint 
with Four Tie Rods using the CAEPIPE's Tie Rod elements. The stiffness of the tie rods can 
be input explicitly (in this case, stiffness corresponding to 1" dia tie rod is input). See snap 
shots below for details. 
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FRP piping has gained wide acceptance in many industries due to its lightweight nature, 
superior corrosion resistance, temperature capabilities and mechanical strength. Several 
manufacturers produce different types of FRP pipes and fittings and provide technical 
assistance to their customers on design matters through installation. You can model FRP 
materials in CAEPIPE and have it calculate deflections, forces, moments and stresses.  

To define the FRP material, click on “Matl” in the header row in the Layout window. 

 

In the Material List window that is shown, double click on an empty row to input a new 
material or on a material description to edit the material properties. 

 

The Material dialog will be shown. 
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The material name can be up to five alpha-numeric characters. Enter description and density. 
You need to select “FR: Fiber Reinf. Plastic (FRP)” from the Type drop-down combo box 
before you click on the Properties button. Poisson's ratio (Nu) is a measure of the Poisson 
effect, the phenomenon in which a material tends to expand in directions perpendicular to 
the direction of compression. Conversely, if the material is stretched rather than compressed, 
it usually tends to contract in the directions transverse to the direction of stretching. 

When you click on the Properties button, you are shown the table below where you enter 
temperature-dependent properties.  Additionally, you can define the Axial and Torsional 
allowable stresses so that CAEPIPE can use them to compare with calculated stresses under 
the FRP "Sorted Stresses” results. 

 

FRP Material Moduli 

CAEPIPE requires three moduli for a FRP material: 

 

Axial or Longitudinal (this is the most important one)  
Hoop (used in Bourdon effect calculations). If this modulus is not available, use axial 
modulus.  
Shear or Torsional. If this modulus is not available, use engineering judgment in specifying 
1/2 of axial modulus or a similar value. Note that a high modulus will result in high stresses, 
and a low modulus will result in high deflections. 

For FRP bends, a Flexibility factor of 1.0 is used unless you override it by specifying a 
Flexibility factor inside the bend dialog. Also for FRP bends, CAEPIPE uses a default SIF of 
2.3. You can override this too by specifying User-SIFs at the bend end nodes (A and B 
nodes). 

Stiffness matrix 

The stiffness matrix for an FRP material is formulated in the following manner: 

The stiffness matrix for a pipe is calculated using the following terms: 

Axial term = L / EA 
Shear term = shape factor x L / GA 
Bending term = L / EI 
Torsion term = L / 2GI 
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where L = length, A = area, I = moment of inertia 
E = Elastic modulus, G = shear modulus 
 
For an isotropic material, 

G = E / 2(1 + 𝜈) 

where 𝜈 = Poisson’s ratio, 

For a FRP material, however, 

E = axial modulus and G is independently specified (i.e., it is not calculated using E and 𝜈). 

The hoop modulus and FRP Poisson’s ratio are only used in Bourdon effect calculation 
where, 
Poisson’s ratio used = FRP Poisson’s ratio input x (axial modulus / hoop modulus) 

Results 

CAEPIPE calculates deflections, forces, moments and stresses. Each item can be seen under 
the respective title in Results. FRP element stresses can be seen, sorted or unsorted. These 
FRP stresses are computed as per the formulae given in Section titled “Piping Code 
Compliance” in the Code Compliance Manual. 
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Axial and Torsional allowables may be entered under material properties so that they can be 
used to compare against calculated stresses in “Sorted FRP Stresses.” Forces, Stresses and 
Sorted stresses for FRP piping may be printed to a .CSV file (spreadsheet-compatible). 

CAEPIPE renders FRP piping in golden color. 
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A flange is a method of connecting pipes, valves, pumps and other equipment to form a 
piping system. It also provides easy access for cleaning, inspection or modification. Flanges 
are usually welded or screwed. Flanged joints are made by bolting together two flanges with a 
gasket between them to provide a seal. The material of a flange, is basically set during the 
choice of the pipe, in most cases, a flange is of the same material as the pipe. There are many 
different flange standards being followed worldwide. To allow easy functionality and inter-
changeability, these are designed to have standardized dimensions. Common world standards 
include ASA/ANSI/ASME (USA), PN/DIN (European), BS10 (British/Australian), and 
JIS/KS (Japanese/Korean). 

 

A flange is input by typing “fl” in the Data column or selecting “Flange” from the Data 
Types dialog. If flanges are located at the bend end nodes (A, B nodes), or jacket bend nodes 
(C, D nodes), the bend flexibility and SIF are internally modified in CAEPIPE. 

 

The Flange dialog is shown. 

Gasket
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Several flange types are available – weld neck, socket welded, threaded, lap joint, etc. Use the 
Type drop-down combo box to select one. 

 

Weight 

The weight you provide should be the total weight of flanges, i.e., if there are two flanges the 
weight should be the weight of two flanges.Weight is to be input in lbf or kgf and NOT in 
mass units. Whenever mass is required for a calculation as in the case of forming Mass 
matrix for dynamic analysis, or in calculating inertia force as (mass x acceleration) for static 
seismic analysis, CAEPIPE internally computes the mass  to be equal to (weight / g-value). 

Gasket Diameter 

The gasket diameter is used in calculating equivalent flange pressure in the flange report. 

As stated in Section titled “Flange Report” below, Gasket Diameter (G) required is the 
“diameter at location of gasket load reaction”. This Gasket Diameter (G) can be calculated as 
detailed in “Flange Report” section. 

Allowable Pressure 

CAEPIPE provides an approximation for the tendency of a flange to leak by calculating an 
“equivalent flange pressure” and comparing it to the (user-input) allowable pressure for the 
flange in the flange report. Often, the allowable pressure may be conservatively set to the 
flange rating. The allowable pressure can be taken from B16.5 (or a similar standard) for the 
flange class, material, pressure and temperature.  

The temperature-pressure ratings provided in ASME/ANSI B16.5 are computed using the 
formula given in para. D2.1 of Annex D of ASME/ANSI B16.5 (given below). The values 
thus obtained are listed in a tabular form for all materials at different flange ratings.  

PT = (Pr x SI) / 8750 <= Pc 

where,  

Pc = Ceiling pressure as specified in D3 of Annex D at temperature. 

PT = Rated working pressure in psig for specified material at temperature. 

Pr = Pressure rating as per Class in Psig. 

SI = Selected stress in Psig for specified material at temperature. 
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For example, from the values shown in Table 2.-1.1 of ASME B16.5 (1998) (shown above), 
for a 300# carbon steel flange with Material A105, the allowable pressure is 740 psig at 
100°F. This is calculated as detailed below. 

Allowable Stress = Minimum (60% of Min. Yield, 1.25 x Allowable Stress at Temperature) as 
per para. D2.2 of Annex D of ASME B16.5 (1998). 

Accordingly, Allowable Stress (SI) from ASME Boiler and Pressure Vessel Code, Section II, 
Part D for A105 at Temperature 100 deg. F = Minimum(60% of Min. Yield, 1.25 x 
Allowable Stress at Temp) = Minimum(60% of 36000, 1.25 x 20000) = Minimum(21600, 
25000) = 21600 psi 

Pressure rating (Pr) = 300 # 

So, rated working pressure (PT) = (21600 x 300) / 8750 = 740 psi (same as the value shown 
in the snapshot). 
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Flange Library 

You may access the flange library by clicking on the Library button of the flange dialog. The 
default weight in the Flange Library is for two Flanges.  However, each library dialog has an 
option to include weight for a single flange.  See checkbox in the Flange library dialog below 
to include weight for a single flange. 

ANSI Library  

 

European Library 

 

The default weight in the library is the weight of two weld neck flanges (including bolts). 
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Flange Report 

CAEPIPE lists every flange in a model in the flange report. The “Flange Pressure” is an 
equivalent pressure calculated from the actual pressure in the piping element, the bending 
moment and the axial force on the flange from the operating case(s), as follows: 

For Piping codes such as BS 806, IGEM, Norwegian, RCC-M, CODETI, Stoomwezen, 
Swedish and EN 13480-3, equivalent pressure is calculated in accordance with Eq. 6.6.2-1 of 
EN 13480-3 (2020) as given below. 

𝐹𝑙𝑎𝑛𝑔𝑒 𝑃𝑟𝑒𝑠𝑠𝑢𝑟𝑒 = 𝑃𝑟𝑒𝑠𝑠𝑢𝑟𝑒 +
16 × 𝐵𝑒𝑛𝑑𝑖𝑛𝑔𝑀𝑜𝑚𝑒𝑛𝑡

𝜋 × 𝐺3
+

4 × 𝐴𝑥𝑖𝑎𝑙𝐹𝑜𝑟𝑐𝑒

𝜋 × 𝐺2
 

where, 

Bending Moment = resulting bending moment  

 

For all other Piping codes, equivalent pressure is calculated in accordance with NC.3658.3 of 
ASME Section III Class 2 (2017) as given below. 

𝐹𝑙𝑎𝑛𝑔𝑒 𝑃𝑟𝑒𝑠𝑠𝑢𝑟𝑒 = 𝑃𝑟𝑒𝑠𝑠𝑢𝑟𝑒 +
16 × 𝑀𝑓𝑠

𝜋 × 𝐺3
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The Gasket diameter is at the gasket loading location (if it is not input, it is conservatively 
assumed to be the internal diameter of the pipe).“Gasket loading location” is the location 
where the gasket load reaction is acting. As per ASME Sec. VIII Division 1, “G” is the 
diameter at location of gasket load reaction and can be calculated as follows. See snap shots 
shown below for details. 

G = mean diameter of gasket contact face, inches, when b0<= ¼ inches or G = outside 
diameter of gasket contact face - 2b, inches, when b0> ¼ inches. 

Mfs = Maximum(Resultant Bending Moment, Torsional Moment) 

where, 

b = effective gasket or joint-contact-surface seating width, inches.  

b0 = basic gasket seating width, inches. 
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In the absence of seating width data, G can be taken as the mean diameter[= (ID + OD) / 
2]. For example, as per the snap shot shown below, the mean diameter G for the "Ring 
Gaskets for 250/300# ANSI Pipe Flanges" for 8” is 10.375” [= (8.625” + 12.125”) / 2]. 

 

The computed equivalent flange pressure is compared with the flange allowable pressure. 

If you have input more than one temperature load, the flange equivalent pressure is 
calculated for all the applicable operating load cases, the worst of which is reported in the 
Flange report. 

A flange report is generated even when no piping code is chosen. The flange report is shown 
in the results. 
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Suggestions for dealing with high equivalent flange pressure to allowable ratios 

The Flange report in the CAEPIPE results window shows the loads at each flange location 
for the worst operating load case (W+P+T). 

The “equivalent” flange pressure is the sum of two terms from the flange equation as shown 
above. The last column in the Flange report shows a ratio of this equivalent flange pressure 
to a user-input allowable pressure. This ratio is flagged in red when greater than 1.0. 

Ensure that you input an allowable pressure for the flange by looking up B16.5 or a 
similar code (as a function of design temperature and pressure). 

Since a flange is unlikely to fail by collapse, the key idea of the flange report is to 
“quantify” the tendency of a flange to leak its contents. Engineering judgment will 
play an important role in interpreting this report.  

If the ratio of equivalent flange pressure to allowable pressure is flagged in red, then 
try to reduce the bending moment at that flange location. Be sure to examine all load 
cases, but frequently the excessive moments come from the expansion case. If so, 
consider introducing loops, bends and offsets as required to reduce the bending 
moments at flange locations for expansion load case(s).If it is practical, move those 
flanges with high (flange pressure-to-allowable) ratios to piping locations where the 
bending moments are less. 
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Flange joints are essential components in all pressurized systems; they are also one of the 
most complex. Many factors are involved in determining the successful design and operation 
of a bolted flange joint service, namely, the interaction between the bolting, flange, and 
gasket as well as important non-linear variables such as friction and gasket properties. The 
Pressure Vessel and Piping Codes were developed with safety in mind; they provide a 
method for sizing the flange and bolts to be structurally adequate for the specified design 
conditions. 

The Flange Qualification module implemented in CAEPIPE addresses the design rules 
contained in the ASME Section VIII, Division 1, Appendix 2 on bolted flange connections 
with gaskets. 

These design rules will help you to obtain better insight into a flange joint's tendency to leak, 
beyond that provided by the rudimentary (yet indicative) flange report produced by a piping 
analysis, as seen in the previous section.  You can examine the flange and bolt stresses arising 
from the bolt tightening loads required for a leakage-free joint. 

The Flange Qualification module assumes that you already have flanges and gaskets picked 
out for your system and performed a piping flexibility analysis of that system with 
CAEPIPE, which will have produced a flange report as given above in the previous section 
depending upon the piping code selected.  

Note that this Flange Qualification module to calculate flange and bolt stresses is separate 
from a piping stress model file and can be accessed from File Menu > Open/New command. 

The Flange Qualification module performs three (3) qualifications namely,  

1. Flange Allowable Moment as per NC3658.3 of ASME Section III Class 2, 

2. Flange Stresses for Operating Case as per Appendix 2 of ASME Section VIII Division 1, 
and 

3. Flange Stresses for Gasket Seating Case as per Appendix 2 of ASME Section VIII 
Division 1. 

Out of the three (3) qualifications listed above, Bending / Torsional Moment entered in 
“Flange Qualification” module is used ONLY in calculating the Allowable Flange Moment as 
per NC3658.3 of ASME Section III Class 2. The same results are also shown in “Flange 
report” under CAEPIPE Results. The equation involved in Flange Joint analysis is given 
below.  

Note: Flange Joint analysis as per NC 3658.3 is valid for ASME B16.5 flanges with 
Bolt Stress at 100 deg. F is greater than or equal to 20000 psi (138 MPa). So, please 
ensure that the Bolt Stresses at 100 deg.F is greater than or equal to 20000 psi. 
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Ab = total cross-sectional area of bolts at root of thread of  section of least diameter under 
stress, in2 or mm2 

C = bolt circle diameter, in or mm. 

Sy = Yield stress of flange material at Design temperature = 1.5 * Flange Allowable Stress at 
Design Temperature (assumed inside CAEPIPE, as Allowable Stress is generally 2/3 of Yield 
Stress at temperatures well below creep) 

Mfs = bending or torsional moment applied to the joint due to weight, thermal expansion of 
the piping, sustained anchor movement, relief valve steady-state thrust and other sustained 
mechanical loads applied to the flanged joint during the design or service condition, in-lb or 
N.mm. 

On the other hand, Flange Stresses and Flange Rigidity Factors computed as per ASME 
Section VIII Division 1 Appendix 2 are independent of Axial Force and Bending Moment as 
observed from the detailed write-up given in the Section titled “Flange Qualification” of 
CAEPIPE Code Compliance Manual. 

Because this module accepts bending / torsional moment at a flange as input among many 
others, you will need to first create in CAEPIPE your pipe stress model that includes flanges 
(which you need to validate) and generate a Flange Report as shown above. Such a report will 
contain the information you can now use in the Flange Qualification module to calculate 
flange and bolt stresses. 

When you first create a new Flange Qualification file, it comes populated with default values 
for a sample flange (see example 1 later on in this topic). 
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Double-clicking anywhere in the previous screen (or Edit menu > Edit (Ctrl+E)) opens a 
dialog with input fields (with default values) you can edit. You will need to enter all of your 
flange data in this dialog. The different parameters you see here are explained in detail in the 
Section titled “Flange Qualification” of the Code Compliance manual. 
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Required flange input information is organized into three Property tabs – Flange Details, 
Bolt and Gasket Details, and Load Data, the last of which accepts data from a piping model’s 
Flange Report. Once all the data is input, save the model (Flange Qualification filenames will 
have a .flg extension). Now, select File menu > Analyze to calculate flange stresses, which 
will be shown right below the input information. 
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There are three main sections in the shown results:  

 Flange Equivalent Pressure (same as the one shown in piping model results > Flange 
Report),  

 Flange stresses in the Operating condition, and 

 Flange stresses in the Gasket seating condition 
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Flange Qualification Module Menus 

Use these numbers in accordance with the ASME Section VIII publication and your 
engineering judgment to qualify these flanges for use in your piping systems. 

File Menu 

 

.Analyze. 

Analyze command calculates the flange and bolt stresses and compares them to the input 
allowable stresses. 

 Print. 

 

You can print a Flange Report by using the Print command.  You can also preview the report 
by clicking the Preview button on the print dialog. 
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Edit Menu 

.Edit. 

You can edit the Flange, Bolt, and Gasket Details, as well as Load Data by clicking the Edit 
command. 
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Flange Qualification Window 

You can edit the Flange, Bolt, and Gasket Details, as well as Load Data by clicking the Edit 
command. 

Flange Details Tab 

Modify the flange details using this window. 
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Bolt and Gasket Details Tab 

Modify the bolt and gasket details using this window. 
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Load Data Tab 

Modify the load data using this window. 

 

Options Menu 

 

.Units. 

See Units in the Layout Window Options Menu section of the CAEPIPE User’s Manual. 

.Font. 

See Font in the Layout Window Options Menu section of the CAEPIPE User’s Manual.
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Sample Problem 

Problem 1: 

(Example on page 19 in Chapter 40 “Bolted-Flange Joints and Connections” by William J. 
Koves on “Companion Guide to the ASME Boiler & Pressure Vessel Code” by K .R. Rao 
[2001], American Society of Mechanical Engineers, U.S.) 

Flange Details: 

Flange Type : Integral Flanges 
Flange Outside Diameter [A] = 39.125 (inch) 
Flange Inside Diameter [B]  = 32 (inch) 
Flange Thickness [t] = 2 (inch) 
Small End Hub Thickness [g0] = 0.5 (inch) 
Large End Hub Thickness [g1] = 1.125 (inch) 
Hub Length [h] = 2.75 (inch) 
All. Stress @ Design Temp [sf] = 19600 (psi) 
All. Stress @ Ref. Temp [sfa] = 20000 (psi) 
Modulus @ Design Temp [E] = 2.7E+7 (psi) 
Modulus @ Ref. Temp [Ea] = 2.92E+7 (psi) 

Bolting Information: 

Bolt Circle Diameter = 37 (inch) 
Number of Bolts = 36 
Bolt Diameter = 1 (inch) 
All. Stress @ Ref. Temp [sa] = 25000 (psi) 
All. Stress @ Design Temp [sb] = 25000 (psi) 

Gasket Information: 

Gasket Outside Diameter = 35.5 (inch) 
Gasket Inner Diameter = 33.5 (inch) 
Leak Pressure Ratio [m] = 3.00 
Gasket Seating Stress [y] = 10000 (psi) 
Facing Sketch = 1 
Facing Column = 1 

Load Data: 

Design Pressure = 414 (psi) 
Design Temperature = 500 (F) 
Bending Moment = 200 (ft-lb) 
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Comparison of Results 

Flange Stresses Text Book Results 
(psi) 

CAEPIPE 
(psi) 

CAESAR II 
(psi) 

Operating condition    

Longitudinal Hub (SH) 24150 24152 24227 

Radial Flange (SR)              11590 11590 11636 

Tangential Flange (ST) 7230 7232 7205 

0.5(SH + SR) 17870 17871 17932 

0.5(SH + ST) 15690 15692 15716 

Gasket Seating Condition    

Longitudinal Hub (SH) 15270 15269 15292 

Radial Flange (SR)              7330 7327 7345 

Tangential Flange (ST) 4570 4572 4547 

0.5(SH + SR) 11300 11298 11318 

0.5(SH + ST) 9900 9921 9920 

Legend for the different parameters and more examples are given in Section titled “Flange 
Qualification” in the Code Compliance Manual. 
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External forces and moments on the piping system in the global X, Y and Z directions may 
be input at any location. Type “fo” in the Data column or select “Force” from the Data 
Types dialog. 

 

The Force dialog is shown. 

  

If you select “Add to W+P”, the specified forces and moments are applied to the sustained 
and operating load cases. 

If you select “Add to SEISMIC”, the specified forces are applied to the Static Seismic Load 
case. Moments cannot be defined for the Static Seismic Load case and hence moment input 
fields are disabled. 

Force defined in Global X direction (FX) will be included only with x’g solution when x’g 
acceleration input is non-zero. Similarly, forces defined in Global Y (FY) and Global Z (FZ) 
directions will be included in y’g and z’g solutions respectively, when y’g and z’g accelerations 
are input as non-zero values. 

See Section titled “Static Seismic Load” from CAEPIPE User’s Manual for further details on 
how CAEPIPE performs Static Seismic Load analysis. 

If you select any of the thermal cases (“Add to T1”, “Add to T2”, “Add to T3”, all the way 
up to “Add to T10”), the specified forces and moments are applied to the selected thermal 
load case (T1/T2/T3/…/T10) and its operating load case counterpart (i.e.,T1 and 
W+P1+T1, or T2 and W+P2+T2, or T3 and W+P3+T3 or T4 and W+P4+T4 or T5 and 
W+P5+T5 or T6 and W+P6+T6 or T7 and W+P7+T7 or T8 and W+P8+T8 or T9 and 
W+P9+T9 or T10 and W+P10+T10). 
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Force spectrum analyses (different from harmonic analyses) are generally performed to 
determine the response of the piping system to short-duration impulsive loads such as fluid 
hammer, safety relief valve (SRV) and slug flow loads. For an actual short-duration impulsive 
dynamic load exerted on a piping system, a fluid transient analysis is first carried out in order 
to arrive at the “time-history loads” (i.e., force vs. time) acting in the three global directions 
(namely global X, Y and Z) at all affected points in the piping system. The time-history load 
sets so computed are then applied, one time-history load set at a time, on a single degree-of-
freedomspring-mass system with a pre-set natural frequency, to determine the maximum 
dynamic response of this single degree-of-freedomsystem with that natural frequency. Such 
dynamic analysis for that time-history load is repeated on the same single degree-of-freedom 
system with different pre-set natural frequencies. The force spectrum for that time-history 
load would then be a table of maximum dynamic response computed for the single degree-
of-freedom system with different natural frequencies. In other words, the force spectrum is a 
table of force spectral values vs frequencies that captures the maximum intensity and 
frequency content of that time-history load. Similarly, force spectrum tables are determined 
for all other time-history load sets. The above force spectrum tables (i.e., maximum dynamic 
force vs frequency) are then applied as inputs at the respective piping nodes of the 
CAEPIPE stress model to compute displacements, forces and stresses. 

For any piping system, there are as many natural modes of vibrations as the number of 
dynamic degrees of freedom for that system. The force spectral value corresponding to a 
natural frequency of the piping system is arrived at by interpolating the force spectrum vs 
frequency table as determined above. For better understanding, as an example, refer to the 
graph shown next as well as the natural frequencies computed for a piping system at 10 Hz, 
14 Hz, 21 Hz, 29 Hz and 33.8 Hz.  
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From the above graph, to arrive at a force value corresponding to a natural frequency of 14 
Hz, CAEPIPE interpolates the force spectral values between 13 and 15 Hz. Similarly, to 
arrive at a force value corresponding to a natural frequency of 21 Hz, CAEPIPE interpolates 
the force spectral values between 20 Hz & 25 Hz. Since force spectral values above 25 Hz are 
not defined in the graph shown above, CAEPIPE arrives at a force value of 1650 lb. (i.e., the 
spectral value corresponding to the maximum frequency of 25 Hz in the above plot) even for 
natural frequencies of 29 and 33.8 Hz. Similarly, CAEPIPE arrives at a force value of 900 lb. 
for a natural frequency of 10 Hz (i.e., the spectral value corresponding to the minimum 
frequency of 13 Hz in the above plot). 

If only one set of force versus frequency is input (for example, 1000 lb. at 14 Hz) in the force 
spectrum table for your model, CAEPIPE applies the same force (1000 lb.) for all natural 
frequencies computed for that piping system. Note that the displacement produced at a node 
will remain unchanged even when the sole frequency in the force spectrum table is changed 
from 14 Hz to any other frequency. 

Here, the results of the modal analysis are used with force spectrum loads to calculate the 
response (displacements, support loads and stresses) of the piping system. It is often used in 
place of a time-history analysis to determine the response of the piping system to sudden 
impulsive loads such as water hammer, relief valve and slug flow. The force spectrum is a 
table of spectral values versus frequencies that captures the intensity and frequency content 
of the time-history loads. It is a table of Dynamic Load Factors (DLF) versus natural 
frequencies. DLF is the ratio of the maximum dynamic displacement divided by the 
maximum static displacement. Note that Force spectrum is a non-dimensional function 
(since it is a ratio) defining a curve representing force versus frequency. The actual force 
spectrum load at a node is defined using this force spectrum in addition to the direction (FX, 
FY, FZ, MX, MY, MZ), units (lb, N, kg, ft-lb, in-lb, Nm, kg-m) and a scale factor.  

The Force spectrums are input from the Layout or List menu: Misc > Force spectrums. 
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The Force spectrum list appears. 

 

Enter a name for the force spectrum and spectrum values versus frequencies table. In 
addition to inputting the force spectrum directly, it can also be read from a text file or 
converted from a previously defined time function. 
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To read a force spectrum from a text file: 

use the List menu: File > Read force spectrum. 

 

The text file should be in the following format: 

Name (up to 31 characters) 
Frequency (Hz)   Spectrum value 
Frequency (Hz)   Spectrum value 
Frequency (Hz)   Spectrum value 

. . 

. . 

. . 

The frequencies can be in any order. They will be sorted in ascending order after reading 
from the file. 

To convert a previously defined time function to force spectrum: 

use the List menu: File > Convert time function. 

 

The Convert Time Function dialog appears. 
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Select the time function to convert from the Time function name drop down combo box. 
Then input the Force spectrum name (defaults to the Time function name), Maximum 
frequency, Number of frequencies and the Damping. When you press Enter or click on OK, 
the time function will be converted to a force spectrum and entered into the force spectrum 
list. 

The time function is converted to a force spectrum by solving the dynamic equation of 
motion for a damped single spring mass system with the time function as a forcing function 
at each frequency using Duhamel’s integral and dividing the absolute maximum dynamic 
displacement by the static displacement. 

Force Spectrum Load 

The force spectrum loads are applied at nodes (in Data column in Layout window). At least 
one force spectrum must be defined before a force spectrum load at a node can be input. 

To apply the force spectrum load at a node click on the Data heading or press Ctrl+Shift+D 
for Data Types dialog. 

 

Select “Force Sp. Load” as the data type and click on OK. This opens the Force Spectrum 
Load dialog. 

 

Select the direction, units and force spectrum using the drop down combo boxes and input 
appropriate scale factor. The scale factor can be a scalar value, which, when multiplied by the 
non-dimensional force spectrum, will give the actual magnitudes of the force versus 
frequency in the global direction and unit selected in the above dialog.  Then click on OK to 
enter the force spectrum load at that node. 
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Input force spectrum loads at other nodes similarly. Then select the force spectrum load case 
for analysis using the Layout menu: Loads > Load cases. 

 

Note that Modal analysis and Sustained (W+P) load cases are automatically selected when 
you select Force spectrum load case. The force spectrum load case is analyzed as an 
Occasional load. 

A Relief Valve Analysis may be performed by first obtaining the data about valve opening 
and subsequent behavior, as a force versus time history profile.  Enter the profile as a time 
function. See under Time History Load for how to. 

 

Then under Force Spectrum, use “Convert time function” to convert the force-time history 
profile into a Force-Spectrum.  Input loads and analyze. See the topic Relief Valve Load 
Analysis for more details. 

(a) (b)

Time

F
o
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e

Valve opening time Valve closing time
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“From” is a special Element Type used to start a new (branch) line. For a new node number, 
any values you type in under the DX, DY and DZ columns are taken to be coordinates (and 
not offsets). If you use “From” for an existing node number, then you do not have to specify 
values for the DX, DY and DZ fields.  

If you specify a new node number other than the global origin [that has coordinates (0, 0, 0)], 
then you must specify the coordinates for the new node using “From” and DX, DY and DZ 
fields. If you do not, then the new node number will have the same location as the node that 
is the global origin. 

“From” is input by typing “f” in the Type column or selecting “From” from the Element 
Types dialog. 

 

The first node of a model is always a fixed “From” node since you have to start the model 
from a point. The DX, DY, DZ fields for this node may be left blank to mean the global 
origin (0,0,0) or global coordinates may be specified in the DX, DY and DZ fields to have a 
nonzero reference point for the model. 

Values specified for DX, DY and DZ for any other node other than a “From” node are 
interpreted as offsets (not as coordinates) unless the node is suffixed with an asterisk “*”. See 
the topic “Node” for more information. 

It is helpful to create a model starting from a reference node located using its global 
coordinates and continue in an orderly manner from there, especially when you plan to 
merge (see File menu) two models later. 
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Example: 

 

Assume you had two separate models you wanted to combine later.  

First model: In this first model, you would start modeling from node 10 up to node 95.  
Since Node 100 in above is a Tangent-Intersection-Point (TIP), it is not a good idea to create 
a model upto TIP. That means, the bend at Node 100 would not know which way it should 
turn!! 

Second model: You would model from node 95 up to node 130, which is a better way to 
model rather than modeling from node 130 to node 95, which would complicate the 
“Merge” process. 
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A generic data type called “Generic support” is available to define a complex support fitting 
for which the support stiffnesses are obtained from an external source, using a reduced 6x6 
stiffness matrix. An example would be a support assembly as shown below. 

 

 

A reduced 6x6 stiffness matrix representative of this support at a single interface node (as 
shown in figure above) will first need to be arrived at using any general purpose FEA 
software package (such as ANSYS, NASTRAN, etc.) Then, those stiffness values 
representing the support assembly can then be input into CAEPIPE model for further 
analysis. 

“Generic Support” is input by typing “ge” in the Data column or selecting “Generic 
Support” from the Data Types dialog. 

 

Since the reduced 6x6 stiffness matrix representing the generic support is always a symmetric 
matrix, only the upper triangular stiffness values need to be input, with the diagonal terms 
having positive non-zero values. Diagonal terms are never zero or left blank. Off-diagonal 
terms can be zero, positive or negative values. 

Interface Nodes (at 
center of circular 

clamps) 



Generic Support 
 

138 

 

Units for Groups A and C are controlled centrally through the Units command (Ctrl+U in 
Layout window). Units for Group B need to be set in this dialog. 

The Stiffnesses in the Groups A, B and C are to be computed in Global Coordinate System 
and entered.  

The fields in Group A are translational stiffnesses. The fields in Group C are rotational 
stiffnesses. 

The fields in Group B are the coupling stiffnesses. For example, a lateral force at the end of a 
Cantilever beam produces not only the displacement in the direction of that force, but also a 
rotation. Similarly, a moment at the end of a Cantilever beam produces not only the rotation 
in the direction of that moment, but also a lateral displacement. 

Each stiffness field in the dialog is editable. The default “rigid” stiffness is shown for all the 
diagonal terms. If you have a stiffness value for any of these including the off-diagonals, enter 
them here (ensure units integrity). Graphically, the support is shown as a solid block (at node 
330 in the next figure). 
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Displacements, support loads and support load summaries are shown for this support type. 
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A guide is used in the field to control or direct pipe movement. Likewise, its CAEPIPE 
equivalent allows axial movement while restraining the pipe against lateral translations (but 
not rotations). A guide restricts the translational movement normal to its axis, i.e., 
displacements are restrained in the local y and z directions of the element to which the guide 
is attached. The Local Coordinate System (LCS) of the guide can be viewed through View > 
List > Guide and right-click mouse and select the option “Show LCS”. 

A guide is input by typing “g” in the Data column or selecting “Guide” from the Data Types 
dialog. 

 

The Guide dialog is shown. 

 

Tag 

Tag can be 12 characters long. Tags are useful in identifying a support while modeling, 
reviewing of reports and in field erection. Tag Name entered in this field is shown in all 
reports. 

Friction Coefficient 

When a friction coefficient is entered, a nonlinear analysis is performed. In each iteration, the 
friction force is calculated which is friction coefficient times the normal force (the vector 
sum of local y and local z reaction forces). This friction force is applied in the local x 
direction opposing the axial motion of pipe. The solution converges when the displacement 
changes by less than 1% between successive iterations. 
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Stiffness 

The default stiffness is rigid which is input by typing “r” or “Rigid” in the Stiffness field. A 
non-rigid stiffness may be entered by typing the value of the stiffness in the Stiffness field. 

Gap 

A clearance between the pipe and the guide, if present, may be entered as a Gap. The gap is 
assumed to be symmetric about the guide axis. This gap must be closed before any restraint 
forces can develop. If there is no gap, leave this field blank or enter it as 0.0. 

Connected to Node 

By default the guide is assumed to be connected to a fixed ground point which is not a part of 
the piping system. A guide can be connected to another node in the piping system by 
entering the node number in the “Connected to Node” field. 

Local Coordinate System (LCS) 

A guide’s local x-axis is based on the preceding element. If a preceding element is 
unavailable, the following element is used to determine the guide’s local x-axis. The local 
coordinate system (LCS) may be viewed graphically from the Guide List window using the 
menu: View > Show LCS. 

 

 

Guide forces in global coordinate system are “Print(ed) to file” (in addition to forces in local 
coordinate system), accessible from the Print command dialog.
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Variable spring hangers support the dead-weight of piping while allowing vertical and lateral 
thermal movement from the installed to the operating condition. CAEPIPE assumes a 
spring hanger to always act in the vertical direction.  

Also called a “To be designed” hanger, it is input by typing “h (Enter)” in the Data column 
(or typing “Han”) or selecting “Hanger” from the Data Types dialog. The Hanger dialog is 
shown. 

 

 

Tag 

Tag can be 12 characters long. Tags are useful in identifying a support while modeling, 
reviewing of reports and in field erection. Tag Name entered in this field is shown in all 
reports. 
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Type 

The type (i.e., manufacturer) of the hanger can be selected from the drop-down combo box 
“Type.” The following hanger types are currently available: 

 Hanger Types  

ABB-PBS Fee & Mason Nordon 

Basic Engineers Flexider (30-60-120) NPS Industries 

Bergen-Paterson Flexider (50-100-200) Piping Services 

Bergen-Paterson (L) Fronek Piping Tech & Products 

BHEL Hyderabad Grinnell Power Piping 

BHEL Trichy Hydra Sanwa Tekki(30-60-120) 

Borrello Lisega Sanwa Tekki(85-170) 

Carpenter & Paterson* Mitsubishi (30-60-120) Sarathi 

Comet Mitsubishi (80-160) Spring Supports 

Corner & Lada Myricks SSG 

Dynax NHK (30-60-120) Gradior 
Elcen NHK (80-160)  

   

*CAEPIPE includes catalog from Carpenter Paterson Ltd. based in England. 
 
Number of Hangers 

The number of hangers is the number of separate hangers connected in parallel at this node. 
The stiffness and load capacity of each hanger are multiplied by the number of hangers to 
find the effective stiffness and load capacity of all the hanger supports at this node. 

Load Variation 

The load variation (in percent) is the maximum variation between the cold and hot loads. 
Typical value is 25%. 

Hanger Below 

Changesthe graphical depiction only. 

This should be used to specify whether the Hanger is placed below the pipe. Graphical 
symbol changes accordingly. This selection is valid only for Hanger and User Hanger and not 
for Constant Support Hanger nor Rod Hanger. 

Short Range 

Short range hangers are used if the available space is not enough for installing mid-range 
hangers. They are considered, however, as a specialty item and generally not used. If a short 
range hanger is to be designed, check the Short Range check box. 

Connected to Node 

By default the hanger is connected to a fixed ground point which is not a part of the piping 
system. A hanger can be connected to another node in the piping system by entering the 
node number in the “Connected to node” field. This node must be directly above or below the 
hanger node. 
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Hanger Design Procedure 

1. Calculate Hot Load 

Hot load for a variable spring hanger is the actual weight of the pipe (including the 
weights of content, lining and insulation) being carried by that hanger. To calculate hot 
load, a preliminary sustained load analysis is performed in which all hanger locations are 
restrained vertically. If any anchor is to be released (so that the hanger rather than the 
nearby equipment takes the sustained load), it is released. The reactions at the hanger 
locations from this preliminary sustained load analysis are the hanger hot loads.  

2. Calculate Hanger Travel 

Vertical restraints (applied in step 1) at hanger locations are removed. Released anchors 
(if any) are restored. A preliminary operating load case analysis is performed. If multiple 
thermal load cases are specified, only the first thermal load is used for this operating load 
case. The hot loads (calculated in step 1) are applied as upward forces at the hanger 
locations. Vertical displacements at the hanger locations obtained from this operating 
load case analysis are the hanger travels. If limit stops are present, the hot loads are 
recalculated with the status of the limit stops at the end of the preliminary operating load 
case. Then the hanger travels are recalculated using the recalculated hot loads. 

3. Select Hanger  

The hanger is selected from the manufacturer’s catalog based on the hot load and hanger 
travel. The cold load is calculated as: cold load = hot load + spring rate x hanger travel. 
The hanger load variation is calculated as: Load Variation = 100 x Spring rate x travel / 
Hot load. The calculated load variation is checked against specified maximum load 
variation. The hanger for which both the hot and cold loads are within the hanger’s 
allowable working range and the load variation is less than the allowed load variation is 
selected. The hanger is selected such that the hot load is closest to the average of the 
minimum and maximum loads. 

4. Install Hangers 

If “Include hanger stiffness” is chosen in the Analysis options: The hanger spring rates 
are added to the overall stiffness matrix. The hanger cold loads are used in the sustained 
and operating load cases. If “Do not include hanger stiffness” is chosen in the Analysis 
options: The hanger spring rates are not added to the overall stiffness matrix. The hanger 
hot loads are used in the sustained and operating load cases. 

For Lisega hangers, size column will report as Hanger Number, Type and Range instead of 
Hanger Number, Range and Type. For example, hanger having a spring rate of 2.1 N/mm, 
vertical travel of 30mm with load 440N will be reported as 21D.193 instead of 21D319. 

Sustained Displacement during Hanger Selection 

An Example Application 

Sometimes, rotating equipment vendors (e.g. turbine vendors) require that there be no 
weight load imposed on the turbine connections after welding/bolting the pipe to the nozzle 
but prior to plant start-up. This can be accomplished only if the pipe is hung by variable 
spring hangers like a swing at the nozzle and if the pipe end of such “hung” pipe is almost 
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perfectly aligned with the turbine nozzle prior to welding or bolting that pipe end to the 
turbine nozzle. In other words, the spring hangers that carry the weight of the “hung” pipe 
near the nozzle are to be sized and placed such that the resulting displacements (i.e., 3 
translations and 3 rotations) at the pipe end are nearly zero, so that the pipe end need not be 
forcibly deformed in order to weld/bolt it to the turbine nozzle. This, in turn, makes sure 
that the weight load of the pipe is not imposed on the turbine nozzle prior to plant start-up.  

CAEPIPE can be used to perform the above study by carrying out the following steps. 

a) During Step 1 of the Hanger Design procedure given above, release all 6 degrees 
of freedom of the anchor corresponding to that turbine nozzle, so that piping 
weight load will not be transferred to the nozzle during the initial Sustained load 
analysis (in which all hangers are pinned, thereby restraining the pipe vertically at 
the hanger locations). 

b) Review the preliminary Sustained Load Displacements computed during Hanger 
Selection via Results > Displacements > Mouse right click > Show sust. disp. 
during hanger selection. If the Sustained Load translations and rotations at the 
concerned pipe end are NOT nearly zero, try out different hanger locations till 
the preliminary Sustained Load displacements at that pipe end are nearly zero. 

c) When the Preliminary Sustained Load displacements at the concerned pipe end 
are nearly zero, the Support Loads at that Nozzle reported by CAEPIPE for 
Sustained Load case would be close to zero. 

In results, the sustained displacements during hanger selection when hangers are pinned can 
be shown via Results >Displacements>Mouse right click>Show sust. disp. during hanger 
selection. 
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And here is the Results Window for sustained displacements during hanger selection after 
selecting this feature. 
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Hinge joint is an expansion joint designed to permit angular rotation in a single plane by use 
of a pair of pins that pass through plates attached to the expansion joint ends. Hinge joints 
are used in sets of two or three to absorb pipe movement in one or more directions in a 
single-plane piping system. A pair of hinge joints, separated by a section of piping, will act 
together to absorb lateral deflection. Hinge joints are designed to take the full pressure thrust. 

The two sides of the hinge joint shown are joined 
by hinge pins which are along the hinge axis shown 
in the figure. A hinge is modeled by two nodes, 
one on each side of the hinge joint. The two nodes 
of the hinge joint are coincident. So, it is a zero 
length element, i.e., the “From” and “To” nodes 
are coincident. Hence, the DX, DY and DZ fields 
in the Layout window should be left blank. 

 

 

 

 

A hinge joint is input by typing “h” in the Type column or selecting “Hinge joint” from the 
Element Types dialog. 
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The Hinge joint dialog is shown. 

 

Rotational Stiffness 

Also called Angular stiffness. Input the stiffness around the rotational (hinge) axis. The 
stiffness value may be available from the manufacturer of the hinge joint or from test results. 
Otherwise engineering judgment may be used. The stiffness values may be left blank. In that 
case a very small value (1 in-lb/rad.) is used internally to avoid dividing by zero. 

Rotation Limit 

Rotation limit is an upper limit on the rotation of hinge joint in the plus or minus directions. 
Rotation limit of 0.0 (zero) means it is unable to rotate (i.e., it is rigid). Rotation limit of 
“None” or Blank means that there is no limit on its rotation. 

Friction Torque 

The hinge joint will rotate only if the external torque exceeds the friction torque. Beyond 
that, the rotation is proportional to the rotational stiffness of the hinge joint. The friction 
torque value may be available from the manufacturer of the hinge joint or from test results. 
Otherwise engineering judgment may be used. If you do not want friction in the hinge joint, 
the friction torque value may be left blank. 
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When the applied torque is less than friction torque, there is no rotation. When the applied 
torque exceeds friction torque, the rotation is calculated as shown above. When rotation limit 
is reached, there is no further rotation irrespective of the applied torque. See discussion for 
Kbe under Ball joint for additional information. 

Weight 

This is the total weight of the Hinge joint assembly.Weight is to be input in lbf or kgf and 
NOT in mass units. Whenever mass is required for a calculation as in the case of forming 
Mass matrix for dynamic analysis, or in calculating inertia force as (mass x acceleration) for 
static seismic analysis, CAEPIPE internally computes the mass  to be equal to (weight / g-
value). 

Axis direction 

The hinge axis is specified by the “Axis direction.” See “Direction,” for more information on 
specifying a direction using X comp, Y comp and Z comp. 
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Example 

Assume that we had the model shown below (with an exaggerated deflection) containing 6” 
piping with a pair of Hinge joints. Each Hinge joint has the following data: rotational 
stiffness of 66 in.-lb./degree, and weight of 35 lb. 

 

The following steps describe the modeling procedure (with auto node incrementing, you do 
not have to type in the node numbers below): 

 The first node 10 is already defined as an anchor. Press Enter to move to the next 
row.  

 Type 20 for Node, 3’6” for DX, enter material, section and load names, Guide for 
Data. Press Enter to move to the next row.  

 Input bend at node 30: Type 30 for Node, press Tab to move to the Type field. Type 
“b” and Tab to next column to enter a bend, 2’ for DX, press Enter to move to the 
next row.  

 Type 40 for Node, enter –1’6” for DY (as the offset from node 30 to node 40), press 
Enter to complete the bend and move to next row.  

 Type 50 for Node. Type “h” in the Type column. This shows the hinge dialog.  



Hinge Joint 
 

151 

 

Enter 66 (in.-lb/deg.) for Rotational stiffness, 35 (lbf) for Weight, 1.0 for Z comp (axis 
direction), press Enter or click on OK to close the dialog. This completes the hinge input. 
Since there cannot be any offsets (DX, DY, DZ) for the hinge node from the previous node, 
the cursor automatically moves to the next row. 

 Type 60 for Node, enter –1’6” for DY (as the offset from node 50 to node 60), press 
Enter to move to next row.  

 Type 70 for Node. Type “h” in the Type column. This shows the hinge dialog. Enter 
the hinge data as before and click on OK to move to the next row.  

 Input bend at node 80: type 80 for Node, press Tab to move to Type field, type “b” 
for Type and Tab to next column to enter a bend. Type –1’6” for DY (offset from 
node 70 to bend node 80), press Enter.  

 Complete the model through nodes 90 and 100 similar to steps 1 and 2 above.  

The Layout window is shown below: 
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The rendered graphics is shown below: 

 

See under Expansion Joints for more examples. 
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Use this load to analyze loading from a hydrostatic test which is performed by filling the 
piping system with a pressurized fluid (typically water) to check for leaks, etc., before putting 
the system into service.  

During hydrotest, all hangers are assumed pinned (i.e., they act as rigid vertical supports). 
The hydrotest load is defined by the specific gravity of the test fluid (1.0 for water), test 
pressure and whether to include or exclude the insulation weight (because many times the 
hydrotest is performed before applying the insulation).  

The hydrotest load is input by pressing “h” on an empty row in the Layout window (similar 
to pressing “c” for a comment) or on an empty row, selecting “Hydrotest load” from the 
Element Types dialog (Ctrl+Shft+T). 

 

The “Hydrotest Load” dialog appears. 

 

After the hydrotest load is input by pressing Enter or clicking on OK, the hydrotest load 
appears in the Layout window. 
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If you need to modify an existing hydrotest load, double click on the row that defines the 
hydrotest load to bring up the Hydrotest Load dialog. The hydrotest load is applied to the 
rows that follow until changed by another hydrotest load. The hydrotest load can be constant 
over the whole model or can be changed in parts of the model. 

To analyze the hydrotest load case, the Hydrotest load case must be selected using the 
command Loads > Load cases from the Layout window. 

 

The hydrotest load case is analyzed as a sustained load (with no temperature effect 
considered) and the resulting stresses are computed using the Sustained Stress (SL) equation 
corresponding to the piping code selected for analysis. 
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Use a jacket end cap to rigidly connect all six degrees of freedom of the coincident nodes of 
a jacketed pipe (i.e., the node on the core pipe and the corresponding node on the jacket pipe 
(“J” node) are tied together so that both nodes have the same displacements and rotations). 

A jacket end cap is input at a jacketed pipe node by typing “j” in the Data column or 
selecting “Jacket End Cap” from the Data Types dialog. 

 

 

You will need this to secure the jacket pipe to the core pipe rigidly.  Sometimes (depending 
on the combination of restraints), you may get a “Stiffness Matrix not positive definite” 
error, which may be corrected by inserting a jacket end cap. 
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Jacketed piping is used when the primary state of the pipe contents (fuel, chemicals such as 
resins, etc.) needs to be maintained at a specific temperature during transport. An outer 
(jacket) pipe surrounds the inner (core) pipe that contains the operating fluid or the chemical. 
The jacket provides external heating or cooling as required along the length of the core pipe. 

The terminology used here is as follows: 

 Jacketed piping refers to the entire assembly, i.e., a core pipe with a jacket on the 
outside. 

 Jacket pipe refers only to the outside pipe. 

 Core pipe refers only to the inside pipe that contains the operating fluid. 

In CAEPIPE, jacketed piping need only be modeled once, not twice (as in some other pipe 
stress software programs). CAEPIPE models the outer jacket pipe along with the inner core 
pipe once on the Layout window. Each row defines a jacketed piping element. The jacket 
and the core pipes may have different materials, sections and (P, T) loads. 

Jacketed Pipe 

A Jacketed pipe is input by typing “JP” under Type or selecting “Jacketed pipe” from the 
Element Types dialog. The material, section and load specified in the Jacketed Pipe dialog 
apply to the jacket pipe while the ones mentioned on the layout row (next to offsets) apply to 
the core pipe. 

 

The Jacketed Pipe dialog is shown. 
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The jacket’s material, section, and load names are input here (1, 6 and 1 as shown). 
CAEPIPE retains the properties of a jacket pipe until changed so there is no need to retype 
the names of the jacket properties every time you input a jacketed pipe. 

The ends of the jacket and core pipes need to be rigidly connected using the “Jacket End 
cap” data type (see previous topic). Also, “Spiders” need to be input at locations found in the 
physical assembly. You may have to break up the piping into smaller elements to insert 
spiders at appropriate locations. See example given later in this section. 

In case you are analyzing for wind, it may be more accurate to specify a different load for the 
core pipe alone that does not specify the Wind load since the core pipe is not exposed to 
wind. Same applies to the core pipe insulation if the core pipe does not have insulation. 

Internal nodes 

CAEPIPE generates a “J” node for jacket pipes. For example, if you had a jacketed pipe 
from node 10 to 20, CAEPIPE generates 10J and a 20J as (internal) jacket nodes (that may 
be referenced on the layout screen). 

These internally generated nodes may be used to specify data items such as a spider, jacket 
end cap, support (hanger, restraint), forces on the jacket. See example later in this topic. 

Jacketed Bend 

A Jacketed bend consists of a core bend (with a straight portion) surrounded by a jacket 
bend (with a straight portion of jacket pipe). 

A Jacketed bend is input by typing “JB” in the Type column or by selecting “Jacketed bend” 
from the Element types dialog. 
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The Jacketed Bend dialog is shown. 

 

Jacket (properties) 

The jacket’s material, section, and load names are input here. The properties of a jacketed 
pipe are retained until changed. So, there is no need to retype the names of the jacket 
properties every time you input a jacketed pipe. 

Core (properties) 

Presently these properties are disabled. You need to enter them on the layout row under 
Material, Section and Load. 

Bend radius 

Separate bend radii may be specified for the core and the jacket pipes. 

Note that CAEPIPE does not check for interference between the core and the jacket arising 
out of differently specified bend radii. 

The bend radius for the core pipe is normally the same as that of the jacket pipe, since the 
two bends are generally concentric. Use the Render feature in the Graphics window to check 
visually for interference, however. 

Bend thickness 

Separate bend thicknesses may be specified for the core and the jacket bends, if they are not 
default jacket and core section thicknesses. 
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Intermediate nodes 

You can define additional nodes on the outside jacket of a jacketed bend for locating 
supports. You may also use internal nodes generated by CAEPIPE. See Internal nodes 
below. 

Internal nodes 

CAEPIPE generates “C” and “D” nodes for the Jacketed bend on the jacket at the near and 
far ends of the bend. The core pipe (bend) has its own “A” and “B” nodes. Example: When 
you define a Jacketed bend from node 20 to node 30, 30A, 30B (nodes on core bend), 30C 
and 30D (nodes on jacket) are generated. Nodes (30A, 30C) and (30B and 30D) are 
coincident only if the core and the jacket pipes have the same bend radii. See figure. 

These internal nodes may be used to specify data items such as a spider, jacket end cap, 
supports, forces, etc. 

Split a Bend/Pipe 

A jacketed pipe/bend may be split by using the Split option in the Edit menu in the Layout 
window. 

Contents Weight 

The weight of the contents between the jacket and the core pipes is calculated in the 
following manner: 

(a) Twice the insulation thickness on the core pipe is added to the outer diameter of the core 
pipe. (b) The external area of the core pipe is calculated by using the above diameter (a). (c) 
The internal area of the jacket pipe is calculated. (d) The external area of the core pipe (b) is 
subtracted from the internal area of the jacket pipe (c) and this result is further used to 
compute the weight of contents between the jacket and core pipes. 

Jacketed Reducer 

See modeling procedure in topic on the Reducer. 

Example: Jacketed Pipe/Bend 

The figure below shows a Jacketed pipe with a Jacketed bend (at node 20-TIP). Observe the 
spider at the far end of the bend (node 20B). 
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The nodes 10J, 20C, 20D, 30J, 20A and 20B are internally generated nodes. You may use 
them for specifying data items such as spiders, supports (hanger, restraint), forces, etc. 

The pairs of nodes (10, 10J)and (30, 30J) are coincident. The nodes 20A and 20B are 
coincident with the nodes 20C and 20D respectively only if the core and the jacket pipes 
have the same bend radii. 

Note that the core and jacket nodes are not connected even though they are coincident. The 
core and jacket pipes have to be supported and connected using supportsand jacket 
connections (namely, spiders and jacket end caps). An anchor each at nodes 10 and 10J is 
specified. The hanger is at node 30J since it is attached to the jacket. 

A jacket connection of the type spider at node 20B acts as an internal guide between the core 
pipe and the jacket pipe, that is, it prevents any radial movement but allows sliding, rotating 
and bending movement between core and jacket pipes. 
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In case forces transmitted from core pipe to jacket through spiders are required, then spiders 
specified on core pipe can be replaced by guides with “connected to” nodes specified as the 
corresponding nodes on the jacket pipe. 

The end cap at node 30 connects the core and jacket pipes rigidly. 

Jacketed Piping Stresses/Ratios 

CAEPIPE provides an option for you to display the color-coded stress/ratio contour for 
jacketed piping in the graphics window context menu. The default stress contour is for 
thecore piping. Upon selecting the command for Jacket stresses as shown below, stress 
contour plot for the jacket piping is displayed: 
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In CAEPIPE, a limit stop is capable of modeling several types of physical supports including 
a guide, an anchor, a resting support, a two-way rigid restraint and a rod hanger. Using a 
combination of upper and lower gaps (limits), friction coefficient, support stiffness and a 
direction for its axis, you can model the above mentioned physical support types. 

A limit stop prevents a node from moving beyond a certain distance (called a gap or a limit) 
in a certain direction. The node can move freely within the gap. After the gap closes, a limit 
stop acts as a rigid or flexible restraint (depending on your input for stiffness) resisting 
further movement of the node in the specified direction. If friction is specified, after the limit 
is reached, the friction force will oppose movement in the plane normal to the limit stop 
direction. 

 

A limit stop is input by typing “l(L)” in the Data column or selecting “Limit Stop” from the 
Data Types dialog. 
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The Limit Stop dialog is shown. 

 

Limits 

Also called gaps, these limits, upper and lower, are the gaps present on either side of the 
node. The gap in front of the node in the direction of the vector is called the upper limit, and 
the gap to the rear of the node is called the lower limit. The gap is measured from the 
undeflected position of the node. 

Typically, the upper limit is positive and the lower limit negative. In some situations, it is 
possible to have a positive lower limit or a negative upper limit, which is the same as 
forcefully displacing the node in that direction by the gap specified. 

The algebraic value of the upper limit must be greater than the lower limit. For example, 
upper limit = –0.125”, lower limit= –0.25”, or upper limit = 0.25”, lower limit = –0.25”. 

If a particular limit does not exist (that is, a node can move freely on that side of the node), 
then that limit should be left blank (as in the case of a resting support, the upper limit should 
be blank assuming Y-vertical and Y comp = 1, as in the figure shown). 

If there is no gap at all, then the corresponding limit should be explicitly input as zero. When 
zero is entered, the limit stop acts as a one-way restraint in that direction. 

Direction 

The direction in which the limit stop is oriented must be specified in terms of its global X, Y 
and Z components. Or use one of the preset buttons to orient the limit stop axis (see above 
image):  

1. Vertical: To set the limit stop axis in the(global) vertical direction 

2. Axial: To set the limit stop axis along the local-x direction (pipe axis) 

3. Shear y: To set the limit stop axis in the local-y directionof pipe 

4. Shear z: To set the limit stop axis in the local-z directionof pipe 
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If you have connected the limit stop node to another node in the same piping model, then 
unless the connected node is coincident with the limit stop node, the limit stop direction 
must not be input. It is calculated from the locations of the connected node and the limit 
stop node, and its direction is oriented from the connected node to the limit stop node. 

Friction coefficient 

If friction coefficient is specified, a friction force will oppose the movement in the plane 
normal to the limit stop direction when the gap is closed. This friction force is displayed in 
results under Limit stop support loads. 

If you had several limit stops with friction coefficients specified, and you wanted to change 
all of those friction coefficients to the same value, use the Change command under the Edit 
menu. 

Stiffness 

The default is set to Rigid stiffness. Other values may be input by estimating the stiffness of 
the support.  (e.g., for a rod, stiffness = AE/L). 

where 

𝐴 = Cross-sectional area of rod 

𝐸 = Young’s modulus of rod material 

𝐿 = Length of rod 

Connected to Node 

You can connect a limit stop node to another node in the same piping model. During gap 
and friction calculations, the relative displacements of the limit stop node are calculated with 
respect to the connected node. If you connect the limit stop node to an external fixed point 
(Ground point), leave the “Connected to Node” blank. See “Direction” above for 
information about how the direction is calculated depending on whether the connected node 
is coincident or not with the limit stop node. 
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Solution procedure 

Limit stops require a nonlinear iterative solution. If you specify a friction coefficient, the 
following procedure is used for convergence: If the lower or upper limit is reached, the 
corresponding reaction force is calculated. The maximum friction force is the product of 
friction coefficient and the reaction force. The solution converges when the displacement 
varies by less than 1% between successive iterations. 

Limit stops are included in dynamic analysis. The status of the limit stops arrived at upon 
completion of all iterative calculations for the first operating case (W+P1+T1) is used during 
dynamic analysis. If either the lower limit or the upper limit is reached at the end of iterations 
for the first operating case, then that limit stop is treated as a rigid two-way restraint in the 
direction of the limit stop during dynamic analysis. If both limitsare not reached, then that 
limit stop is ignored during dynamic analysis. 

Example 1: Vertical 1-way restraint 

Assume that you have a vertical 1-way support with the following data: Upper limit = None, 
Lower limit = 0, Friction coefficient = 0.3, Direction vector of the limit stop is vertical along 
+Y axis. 

Model the pipe up to the Limit stop node 30. At node 30, type “l(L)” in the Data column. 
The limit stop dialog will be shown. 
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In the limit stop dialog, press “Vertical” button. The data is automatically entered [0.000 for 
Lower limit, None for Upper limit (blank), 1.000 for Y comp (vertical)]. Enter 0.3 for friction 
coefficient (this acts in the X-Z plane which is perpendicular to the direction of the limit 
stop). 
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Example 2: Pipe Slide/Shoe Assembly 

 

The assembly is modeled using three limit stops, one in each direction. 

 When you start a new model file, node 10 and an Anchor are automatically input, 
press Enter to move cursor to next empty row. 

 Press Tab in the Node column which puts the node number 20 automatically. Type 
5’ for DX, enter material, section and load names, press Enter. 

 Press Tab in the Node column which puts the node number 30 automatically. Type 
5’ for DX, Tab to Data column and type “l(L)” to open limit stop dialog. Input line 
stop with gap (0.5”) along X axis (Notice that this is a one-way restraint; there is only 
one stop block along +X). Type Upper limit 0.5”, leave lower limit blank, Direction 
as (X comp = 1, Y comp = 0, Z comp = 0), Friction coefficient=0.3, press Enter. 

 

 Create a limit stop in the Y direction. Type 30 for Node, press Tab to move to Type 
field, type “L” for Location, choose Limit stop from the Data Types dialog, in the 
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Limit stop dialog, type Upper limit = 0.5”, Lower limit = 0.0, Direction (X comp =0, 
Y comp = 1, Z comp = 0), Friction coefficient=0.3, press Enter. 

 

 Create a limit stop in the Z direction. Type 30 for Node, press Tab to move to Type 
field, type “L” for Location, choose Limit stop from the Data Types dialog, in the 
Limit stop dialog, type Upper limit = 0.25”, Lower limit = –0.25”, Direction (X 
comp =0, Y comp = 0, Z comp = 1), Friction coefficient =0.3, press Enter. 

 

The Layout window is shown below. 
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The Graphics window is shown below. 

 

 

Example 3: Limit Stop Connected to Another Node 

As shown in the figure below, two 300” long cantilever pipes are connected with an 8” 
separation between center lines. 

 

The gap between the bottom of the top pipe and the top of the bottom pipe is 

8” – (6.625” + 8.625”) / 2 = 0.375”. 
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If pipes were free to deflect downward due to deadweight, the top pipe will deflect 1.908” 
and the bottom pipe will deflect 1.116” at the free ends. The relative deflection between 
them will be 1.908” – 1.116” = 0.792”. This however is not possible because when the 
relative deflection exceeds 0.375” the pipes will touch. This situation can be modeled using a 
limit stop connecting the free ends of the pipes. In this case the top pipe deflects 1.608”, i.e., 
less than the 1.908” free deflection because it is resisted by the bottom pipe. The bottom 
pipe deflects 1.233”, i.e., more than the 1.116” free deflection because additional load is 
imposed on it by the top pipe when they touch. The difference between the deflections is 
1.608 – 1.233 = 0.375” as expected. 

 When you start a new model file, node 10 and an Anchor are automatically input, 
press Enter to move cursor to next empty row.  

 Press Tab in the Node column which puts the node number 20 automatically. Type 
300” for DX, enter material, 6” section and load names, press Enter.  

 For the bottom pipe, start with node 30 of Type “From” at DY = –8” and make it 
an anchor. On the next row enter node 40 with DX = 300” and 8” section. Press 
Enter to go to the next row.  

 Enter the limit stop at node 20. Type 20 for Node, press Tab to move to Type field, 
type “L” for Location, choose Limit stop from the Data Types dialog, in the Limit 
stop dialog, leave the Upper limit blank and input Lower limit = -0.375”. Input the 
Connecting Node as 40. Since this limit stop connects two nodes, the direction 
should be left blank. The direction is implicitly from node 40 to node 20. 

 

Alternatively the limit stop could be specified at node 40 connected to node 20. The 
direction now would be from node 20 to 40. The limits would then be Lower limit = 
None and Upper limit = 0.375” since the direction is now reversed compared to the 
previous case. Both these cases will give identical results. 

The Layout window is shown below. 
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The Graphics is shown below. 
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Loads on a piping system can be many and varied along its routing. Different piping 
segments may experience different pressures and temperatures depending on process 
requirements, different loads (snow, wind, etc.) depending on their physical locations and 
carry different states of a fluid between different points in a piping system. CAEPIPE offers 
a flexible method to input as many loads as required for as many segments or elements as 
needed with the least effort.  

So, Load allows you to apply a temperature and pressure, specify weight of the operating 
fluid and add additional weight (e.g., due to snow load) on each element (if required) or for a 
range of elements in the model. Also the wind load can be turned “on” or “off” for each 
element (if required) or for a range of elements in the model. 

After specifying the requested information here, including a name, use it under the Load 
column on the Layout window to associate the load information with an element. 

Each load allows up to 10 operating conditions for Temperature and Pressure depending on 
the “Number of Thermal Loads” specified under Options > Analysis > Temperature. This 
Load is not to be confused with Load cases [which are combinations of load(s)] found under 
the Loads menu in the Layout window. Load cases are analysis cases (Sustained case, 
Thermal case, Operating case, Static Seismic case, etc.) for which CAEPIPE computes a set 
of results. 

To define a new load, click on Load in the Header row in the Layout window (or select 
Loads under the Misc menu, hotkey: Ctrl+Shift+L). This opens a List window that displays 
currently defined loads. 

 

 

Either you can start typing the load data directly here into the fields or double click on an 
empty row to enter data through a dialog. 

Depending on the number of thermal loads specified (under Options > Analysis > 
Temperature), up to 10 temperature/pressure load sets (T1/P1, T2/P2, T3/P3,…,T10/P10) 
can be input for each element or for a range of elements. 
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Up to 10 specified thermal displacements can be entered for Anchor and Nozzle data types. 
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Load Name 

Type an alphanumeric name (up to five characters) in this field. The name can be changed 
later. 

Temperatures 

Type up to 10 operating temperatures. The maximum of the 10 temperatures is used to look 
up the corresponding allowable stress  for the material used in code evaluation. 

The other quantities looked up using these temperatures are the thermal expansion 
coefficients (alpha) and the temperature-dependent moduli. 

Make sure to select number of thermal loads equal to two, three or 10 under Options > 
Analysis > Temperature, when you have more than one set of temperature and pressure. 

Pressures 

Type up to 10 operating pressures that correspond to the 10 operating temperatures above. 
The maximum of the 10 pressures is  used to calculate the pressure stress term 

[𝑃𝐷/4𝑡 𝑜𝑟 𝑃𝑑2/(𝐷2 − 𝑑2)], specified under Options > Analysis > Pressure. 

Specify gauge pressures for Pressures input. Negative (external) pressures may be specified, 
too. But, the longitudinal pressure stress term (pD/4t) will still be positive according to the 
piping codes. Internal pressure will expand the pipe cross-section radially outward while 
external (negative) pressure will contract the pipe cross-section radially inward. 
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Design Pressure and Temperature  

CAEPIPE requires that the Design Temperature to be entered should be equal to or greater 
than the algebraic maximum of all operatingtemperatures (T1 through T10). Similarly, 
Design Pressure to be entered should be equal to or greater than thealgebraic maximum of 
all operating pressures (P1 through P10). 

Design Temperature so entered will be used to determinethe allowable stress for material, 
which is in turn used to compute the Allowable Pressure as per the piping code selected. 
Since Allowable Pressure reduces with decreasing allowable stress, to be conservative,the 
least allowable stress would then be obtained when the Design Temperatureis no less than 
the algebraic maximum of all operating temperatures (T1 through T10). 

The Allowable Pressure so computed as per the piping code selected is then compared 
against the Design Pressure entered above and reported in the Code Compliance results. 

Except as stated above, Design Temperature and Design Pressure are not used anywhere else 
during CAEPIPE analysis. 

Specific Gravity 

Specific gravity is the ratio of the density of a fluid to the density of a reference substance (in 
this case, water). Enter the specific gravity of the operating fluid inside the pipe. This input is 
used to calculate the weight of the operating fluid, which is added to the weight of the pipe. 
Specific gravity is with respect to water.    

Additional weight 

The value you enter here is taken as weight per unit length of the element and this total 
additional weight is added to the weight of the pipe. (Total additional weight = Length of 
element x Additional weight per unit length). Additional Weight is to be input in lbf/ft or 
kgf/m.  

Whenever mass is required for a calculation as in the case of forming Mass matrix for 
dynamic analysis, or in calculating inertia force as (mass x acceleration) for static seismic 
analysis, CAEPIPE internally computes the mass  to be equal to (weight / g-value). 

For example, Additional weight could be used to apply the weight of  snow on the pipe. 

Wind load 1/2/3/4 

Type Y(es) or N(o) to apply or not apply the wind loads for this element. When you press 
Y(es), the wind load (entered as a separate load under Loads menu) is applied to this element.  

For example, this is useful when you have a part of a piping system exposed to wind with the 
remaining part inside a building. In such a case, you should define two Loads, all data the 
same except that one has Wind load and the other does not. The Load with the wind load is 
applied to those elements that are affected by wind. 
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CAEPIPE allows you to create your physical piping system in a mathematically equivalent 
3D Cartesian coordinate space with a global origin, which is the point of intersection of three 
planes orthogonal to each other, with three axes commonly denoted X, Y and Z (with either 
of the latter two vertical). 

        

  Y Vertical         Z Vertical 

Once you begin creating your system from a given point (usually the global origin), you route 
your piping system one element at a time until you get to the end of the line(s). An element’s 
orientation could be different from another element’s, thereby necessitating an element’s 
own “elemental coordinate system,” which is commonly referred to as the Local Coordinate 
System (LCS), provided for the purpose of understanding the local forces and moments on 
each element. This system can be turned on (graphically) through the View menu > Show 
LCS command while you are viewing “Element Forces in Local Coordinates” in the Results 
window. 

For a straight element (such as a pipe or a beam), the “local x” axis is along the element, 
from the “From” node to the “To” node. For a node location such as a guide, the local axes 
are based on the previous connected element. If the preceding element does not exist, the 
following element is used. The local y-axis and local z-axis are calculated differently 
depending on whether the vertical direction is Y or Z and also depending on whether the 
element is in the vertical direction. 

The local coordinate system may be displayed graphically (for beams and guides in the input 
processor and for all the elements in the output processor) by selecting the “Show LCS 
(Local coordinate system)” command from the View menu. 

In CAEPIPE, the local coordinate system is indicated by the lower case x, y and z letters, 
whereas the global coordinate system is indicated by the upper case X, Y and Z letters. 

Global vertical axis is Y 

Element is not Vertical 

 

The local y-axis of the element lies in the local x - global Y plane (i.e., vertical plane) and 
is in the same positive direction as the global Y axis. The local z-axis is the cross product 
of the local x-axis and local y-axis. 
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Element is Vertical 

 

The local z-axis of the element is in the global Z direction. The local y-axis is in the 
global –X direction. 

Global vertical axis is Z 

Element is not Vertical 

 

The local z-axis of the element lies in the local x - global Z plane (i.e., vertical plane) and 
is in the same positive direction as the global Z-axis. The local y-axis is the cross product 
of the local z-axis and local x-axis. 

Element is Vertical 

 

The local y-axis of the element is in the global Y direction. The local z-axis is in the 
global–X direction. 
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Local Coordinate System for a Bend 

For a bend, at the “From” node, the local x axis is along the tangent from the “From” node 
to the tangent intersection point. The local y-axis is along the radius and points to the center 
of curvature. The local z-axis is the cross product of the local x-axis and local y-axis. 

Similarly, at the “To” node, the local x-axis is along the tangent line from the tangent 
intersection point to the “To” node. The local y-axis is along the radius and points to the 
center of curvature. The local z-axis is the cross product of the local x-axis and local y-axis. 

 

Sign Convention for Element Forces and Moments 

The sign conventions for the element forces and moments in the local coordinate system 
follow strength of materials conventions, i.e., forces and moments at the “To” node of an 
element are positive if they are in the positive local axes directions of the element. On the 
other hand, forces and moments at the “From” node of the element are negativeif they are in 
the positive local axes directions of the element. 

 

Positive sign conventions for local forces and moments are shown above at the “From” and 
“To” nodes of an element. Note that positive directions at the “From” node are reversed 
compared to the positive directions at the “To” node. 
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In-plane and Out-of-plane Moments 

CAEPIPE outputs local moments in the form of Torsion, In-plane and Out-of-plane for a 
few piping analysis codes such as ASME B31.1 (2020) or later, ASME B31.3, etc. 

To have graphical illustrations of the In-plane and Out-of-plane moments, shown below are 
the two sample CAEPIPE models created by keeping Global vertical axis as Z and Y 
respectively along with the following outputs. 

1. Local Coordinate System (LCS) captured for different elements by turning on the 
option Results Window > View menu > Show LCS command while in “Element 
Forces in Local Coordinates”. 

2. Local forces and moments output by CAEPIPE with piping analysis code selected as 
ASME B31.9, and  

3. Local forces and moments output by CAEPIPE with piping analysis code as ASME 
B31.1. 

From the graphical representation of LCS and the local forces and moments output by 
CAEPIPE using ASME B31.9 and ASME B31.1 codes, you may observe that the In-plane 
moment is about local z-axis and its corresponding rotation is in local x-y plane, and whereas 
the Out-of-plane moment is about local y-axis and its corresponding rotation is in local x-z 
plane for all element types such as Pipe, Bend, Mitre, Reducer, Valve, Rigid, etc. (excepting 
TEEs) available in CAEPIPE. 

Similarly, from the LCS and the local forces and moments output by CAEPIPE using ASME 
B31.9 and ASME B31.1 codes, you may observe that the In-plane moment (Mi) of a Tee 
element is about the vector normal to the plane formed by connecting the two nodes on the 
Run side (Leg 1 and Leg 2) as well as a node on the Branch side (Leg 3) as shown in the 
figure below. Similarly, Out-of-plane moments (Mo) for the three legs of Tee are as shown 
below.  
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When Global Z Axis Vertical 

 
 

   
Fig. A.1  Fig. A.2 Fig. A.3  Fig. A.4 Fig. A.5 
 

    
Fig. B.1  Fig. B.2  Fig. B.3  Fig. B.4 
 

Fig. A.1 - Bend in Horizontal Plane 
Fig. A.2 - Bend in Vertical Plane 
Fig. A.3 - Pipe in Horizontal Plane 
Fig. A.4 - Pipe Vertical Plane 
Fig. A.5 - Pipe Skewed in 3D 
 

Fig. B.1 - Tee in Horizontal Plane – Run Element 
Fig. B.2 - Tee in Horizontal Plane – Branch Element 
Fig. B.3 - Tee in Vertical Plane – Run Element 
Fig. B.4 - Tee in Vertical Plane – Branch Element 
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ASME B31.9 Code Selected  ASME B31.1 Code selected 

 
 
Element Type In-plane 

Moment 
Bending 
in what 
plane? 

Direction of 
+ve In-
plane 
Moment 
Vector 

Out-of-
plane 
Moment 

Bending in 
what 
plane? 

Direction of 
+ve Out-of-
plane 
Moment 
Vector 

Bend (20A-20B) & 
(90A-90B) 

(mz) x-y plane (z axis) (my) x-z plane (y axis) 

Pipe Horizontal (20B-
25), Pipe Vertical (86-
88), Pipe Skewed 
(100-110), Reducer, 
etc. 

(mz) x-y plane (z axis) (my) x-z plane (y axis) 

Pipe (20B-25), Pipe 
(86-88), Pipe Skewed 
(100-110), Reducer, 
etc. 

(mz) x-y plane (z axis) (my) x-z plane (y axis) 

Pipe (20B-25), 
Reducer, etc. 

(mz) x-y plane (z axis) (my) x-z plane (y axis) 

TEE - Run (30-40A) (mz) x-y plane (z axis) (my) x-z plane (y axis) 

TEE - Branch (30-60) (mz) x-y plane (z axis) (my) x-z plane (y axis) 

TEE - Run (75-80A) (my) x-z plane (y axis) (mz) x-y plane (z axis) 

TEE - Branch (75-
90A) 

(mz) x-y plane (z axis) (my) x-z plane (y axis) 

The definition summarized in the above table can be verified by comparing the local moment values 
output in the form of In-plane and Out-of-plane by CAEPIPE for ASME B31.1 code against the local 
moments output in the form of mx, my and mz by CAEPIPE for ASME B31.9 code. 
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When Global Y Axis Vertical 

 
 

    
Fig. C.1  Fig. C.2  Fig. C.3 Fig. C.4 Fig. C.5 

 

    
Fig. D.1  Fig. D.2  Fig. D.3  Fig. D.4 
 

 
Fig. C.1 - Bend in Horizontal Plane 
Fig. C.2 - Bend in Vertical Plane 
Fig. C.3 - Pipe in Horizontal Plane 
Fig. C.4 - Pipe Vertical Plane 
Fig. C.5 - Pipe Skewed in 3D 

Fig. D.1 - Tee in Horizontal Plane – Run Element 
Fig. D.2 - Tee in Horizontal Plane – Branch Element 
Fig. D.3 - Tee in Vertical Plane – Run Element 
Fig. D.4 - Tee in Vertical Plane – Branch Element 
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ASME B31.9 Code Selected  ASME B31.1 Code selected 

 
 
Element Type In-plane 

Moment 
Bending in 
what 
plane? 

Direction of 
+ve In-plane 
Moment 
Vector 

Out-of-
plane 
Moment 

Bending 
in what 
plane? 

Direction of 
+ve Out-of-
plane 
Moment 
Vector 

Bend (20A-20B) & 
(90A-90B) 

(mz) x-y plane (z axis) (my) x-z plane (y axis) 

Pipe Horizontal 
(20B-25), Pipe (86-
88), Pipe Vertical 
(86-88), Pipe 
Skewed (100-110), 
Reducer, etc. 

(mz) x-y plane (z axis) (my) x-z plane (y axis) 

TEE - Run (30-40A) (my) x-z plane (y axis) (mz) x-y plane (z axis) 

TEE - Branch (30-
60) 

(my) x-z plane (y axis) (mz) x-y plane (z axis) 

TEE - Run (75-80A) (mz) x-y plane (z axis) (my) x-z plane (y axis) 

TEE - Branch (75-
90A) 

(mz) x-y plane (z axis) (my) x-z plane (y axis) 

The definition summarized in the above table can be verified by comparing the local moment values 
output in the form of In-plane and Out-of-plane by CAEPIPE for ASME B31.1 code against the local 
moments output in the form of mx, my and mz by CAEPIPE for ASME B31.9 code. 
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Summary: 

From the above illustrations, you may note the following. 

1. For an element, the “local x” axis is always along the element, from the “From” node 
to the “To” node. The local y-axis and local z-axis are calculated differently 
depending on whether the vertical direction is Y or Z and also depending on whether 
the element is in the vertical direction. Refer to the Section titled “Local Coordinate 
System” given above for details on how CAEPIPE computes local y-axis and z-axis 
for an element. 

2. Local Coordinate System (LCS) of an element can be seen (turned on) graphically 
through the View menu > Show LCS command while you are viewing “Element 
Forces in Local Coordinates” in the Results window. 

3. For all elements excepting Tees, irrespective of whether the element is horizontal / 
vertical / inclined (skewed in 3D) or whether the Global vertical axis is Y or Z, the 
In-plane moment is always about the local z-axis with its +ve direction along local +z 
axis and its corresponding rotation is in the local x-y plane; whereas, the Out-of-
plane moment is always about local y-axis with its +ve direction along local +y axis 
and its corresponding rotation is in the local x-z plane.  

4. For TEEs, the vectors for the In-plane moments (Mi) for the three legs of Tee are 
normal to the plane formed by connecting two nodes on the Run side (Leg 1 and Leg 
2) as well as a node on the Branch side (Leg 3) as shown in the figure above. 
Similarly, the vectors for the Out-of-plane moments (Mo) for the three legs of Tee 
are as shown above. 

5. Local x, y and z axes computed internally by CAEPIPE for an element (as defined in 
the Section titled “Local Coordinates System” given above) can be observed by 
inputting the “From” and “To” coordinates of that element in the excel macro that is 
available in the link www.sstusa.com/downloads/GCS_LCS.xlsx. This macro is used 
for computing Local forces and moments from Global forces and moments. 

http://www.sstusa.com/downloads/GCS_LCS.xlsx
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Several times, you may need to input more than one data item at a node, e.g., a hanger and a 
Branch SIF to designate the type of tee. At those times, use Location (press “L” in the Type 
field or pick Location from the Element Types dialog) to input more than one data item at a 
node. For example, you may want to input a lateral restraint at an existing hanger. 

Another use for Location is when you want to input a data item at an internally generated 
node. Nodes are internally generated by CAEPIPE for bends (A, B nodes, e.g., 20A) and 
Jacketed pipes/bends (J, C, D nodes, e.g., 10J). 

By design, each row in the Layout window allows only one data item to be entered under the 
Data field. Additional data items can be input only through Location (see Examples below). 

Ensure that the node you use for Location has already been defined on an earlier row, 
ordefined earlier as an intermediate node for a bend or is an internally generated node. In 
other words, you cannot use Location on an undefined node. 

Example 1: Multiple Limit Stops at a node to modelPipe Slide and Shoe assembly 

See Example 2 under the Limit Stoptopicinthis manual. 

Example 2: Data at internally generated nodes 

Refer to the example given underthe JacketedPiping in this manual. CAEPIPE internally 
generates J node on the jacket for a Jacketed pipe and the C and D nodes on the jacket for a 
Jacketed Bend.  The following 4 data items present in that example are input using the 
Location type as shown in the Layout window below. 

1. Node 10J is the starting Jacket node which is anchored (node 10 is separately anchored, 
since it is the node on the core pipe).  

2. There is a hanger at node 30J since the hanger is connected to the Jacket.  

3. There is a spacer (spider) at the far end of the bend, node 20B (which is on the core 
pipe). Remember that the bend has a jacket on the outside.  

4. Node 30 has a jacket end cap  

 

Example 3: Hanger at a Bend Intermediate Node 

See Example 6 in the Bend section of this manual to locate a hanger at an intermediate node.
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Lugs (integral attachments) are forged attachments or attachments welded on the pressure-
loaded wall of a straight pipe which transfer piping loadings to the steel framework or 
concrete. 

Loads on attachments cause local stresses in the pipe wall. Equations to determine these 
pipestresses at lug attachments are given in different codes. These local stresses are then 
added to the piping system stresses at the attachments. The combined stresses thus obtained 
are checked for compliance with the appropriate equations given in those codes. 

The Lug Evaluation module implemented in CAEPIPE computes local pipe stresses as per 
the following codes for Rectangular and Hollow Circular cross sectional attachments.  

1. ASME Section III, Division 1 (2010) – Appendix Y (NC Piping – Class 2) 

2. ASME Section III, Division 1 (2010) – Appendix Y (ND Piping – Class 3) 

3. EN 13480-3 (2017), Section 11 

The details on the implementation of this module are provided in the Section titled “Lug 
Evaluation” of the CAEPIPE Code Compliance Manual. 

The Lug Evaluation module assumes that the flexibility analysis of that piping system with 
CAEPIPE has already been performed, which will have produced a stress report as well as 
the forces and moments at the location where the lug is attached to the piping. 

Note that this module is separate from a piping stress model file and can be accessed from 
File Menu > Open/New command. 
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Double-clicking anywhere in the previous screen (or Edit menu > Edit (Ctrl+E)) opens a 
dialog with input fields you can edit. You will need to enter the data in this dialog. The 
different parameters required to be input are explained in detail in the Section titled “Lug 
Evaluation” of the Code Compliance manual. 



Lug EvaluationModule 
 

188 

 

Once the required data are input, save the file (Lug evaluation will have a .lug extension). 
Now, select File menu > Analyze to calculate stresses and perform code evaluation, which 
will be shown right below the input information. 
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Lug Evaluation Module Menus 

File Menu 

 

.Analyze. 

Analyze command calculates pipestressesat the attachment and compares them to stress 
allowable specified by the selected code. 

 Print. 

 

You can print a Report by using the Print command.  You can also preview the report by 
clicking the Preview button on the print dialog. 
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Edit Menu 

.Edit. 

You can edit the data by clicking the Edit command. 
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Options Menu 

 

.Units. 

See Units in the Layout Window Options Menu section of the CAEPIPE User’s Manual. 

.Font. 

See Font in the Layout Window Options Menu section of the CAEPIPE User’s Manual. 
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Sample Problem 

   Caepipe                     LUG_XEE03_ASME_RA.lug                 Page 1 

   Version 8.10                                                      Aug 10,2018 

   ----------------------------------------------------------------------------------- 

       Evaluation of Piping at Lug Attachment as per ASME Sec III, Div 1 - NC (2010) 

   ----------------------------------------------------------------------------------- 

 

   Input Data: 

   Lug Evaluation Code: ASME Sec III, Div 1 - NC (2010) 

   Level: C 

   Lug Type: Rectangular 

   Weld Type (Penetration):Full Penetration 

   Outside Diameter of Run Pipe (OD):                               10    (inch) 

   Nominal Wall Thickness of Run Pipe (Thk):                     0.165    (inch) 

   Half Length of Attachment in Circumferential Direction (L1):   0.25    (inch) 

   Half Length of Attachment in Longitudinal Direction (L2):       1.5    (inch) 

   Sustained Stress at Run Pipe (Eq.8):                            217    (psi) 

   Expansion Stress at Run Pipe (Eq.10):                            39    (psi) 

   Sustained + Occasional Stress at Run Pipe (Eq.9):               509    (psi) 

   Settlement Stress (Eq.10a):                                       0    (psi) 

   Thermal + Sustained Stress (Eq.11):                              39    (psi) 

   Allowable Stress at Maximum Metal Temperature (sh):           17100    (psi) 

   Allowable Stress Range (sa):                                  42533    (psi) 

   Yield Stress (sy):                                            25650    (psi) 

   ----------------------------------------------------------------------------------- 

                       Forces and Moments at Pipe surface: Sustained 

   ----------------------------------------------------------------------------------- 

   Thrust Load applied to the Attachment (W):                        0    (lb) 

   Circumferential Shear Load applied to the Attachment (Q1):        0    (lb) 

   Longitudinal Shear Load applied to the Attachment (Q2):           2    (lb) 

   Torsional Moment applied to the Attachment (MT):                  0    (ft-lb) 

   Circumferential Moment applied to the Attachment (MN):            0    (ft-lb) 

   Longitudinal Moment applied to the Attachment (ML):               0    (ft-lb) 

   ----------------------------------------------------------------------------------- 

                      Forces and Moments at Pipe surface: Occasional 

   ----------------------------------------------------------------------------------- 

   Thrust Load applied to the Attachment (W):                        0    (lb) 

   Circumferential Shear Load applied to the Attachment (Q1):        0    (lb) 

   Longitudinal Shear Load applied to the Attachment (Q2):        1343    (lb) 

   Torsional Moment applied to the Attachment (MT):                  0    (ft-lb) 

   Circumferential Moment applied to the Attachment (MN):            0    (ft-lb) 

   Longitudinal Moment applied to the Attachment (ML):               0    (ft-lb) 

   ----------------------------------------------------------------------------------- 

                        Forces and Moments at Pipe surface: Thermal 

   ----------------------------------------------------------------------------------- 

   Thrust Load applied to the Attachment (W):                        0    (lb) 

   Circumferential Shear Load applied to the Attachment (Q1):        0    (lb) 

   Longitudinal Shear Load applied to the Attachment (Q2):           2    (lb) 

   Torsional Moment applied to the Attachment (MT):                  0    (ft-lb) 

   Circumferential Moment applied to the Attachment (MN):            0    (ft-lb) 

   Longitudinal Moment applied to the Attachment (ML):               0    (ft-lb) 

   ----------------------------------------------------------------------------------- 

                      Forces and Moments at Pipe surface: Settlement 

   ----------------------------------------------------------------------------------- 

   Thrust Load applied to the Attachment (W):                        0    (lb) 

   Circumferential Shear Load applied to the Attachment (Q1):        0    (lb) 

   Longitudinal Shear Load applied to the Attachment (Q2):           0    (lb) 

   Torsional Moment applied to the Attachment (MT):                  0    (ft-lb) 

   Circumferential Moment applied to the Attachment (MN):            0    (ft-lb) 

   Longitudinal Moment applied to the Attachment (ML):               0    (ft-lb) 



Lug EvaluationModule 
 

194 

   Caepipe                     LUG_XEE03_ASME_RA.lug                 Page 2 

   Version 8.10                                                      Aug 10,2018 

   ----------------------------------------------------------------------------------- 

           Abs. Max. Forces and Moments occurring simultaneously at Pipe surface 

   ----------------------------------------------------------------------------------- 

   Thrust Load applied to the Attachment (W**):                      0    (lb) 

   Circumferential Shear Load applied to the Attachment (Q1**):      0    (lb) 

   Longitudinal Shear Load applied to the Attachment (Q2**):      1343    (lb) 

   Torsional Moment applied to the Attachment (MT**):                0    (ft-lb) 

   Circumferential Moment applied to the Attachment (MN**):          0    (ft-lb) 

   Longitudinal Moment applied to the Attachment (ML**):             0    (ft-lb) 

 

   ----------------------------------------------------------------------------------- 

                    ASME Sec III, Div 1(2010) Appendix Y (NC - Class 2) 

   ----------------------------------------------------------------------------------- 

                      Evaluation of Piping at Rectangular Attachments 

   ----------------------------------------------------------------------------------- 

                        Section Y-3410: Pipe Stresses at Attachment 

   ----------------------------------------------------------------------------------- 

                                                           Calculated   Allowed   Ratio 

                                                                (psi)     (psi) 

     Sustained Stress (Ssl) [Eq. 8]: (psi)                        221     25650   0.009 

     Sustained + Occasional (Sol) [Eq. 9]: (psi)                 3226     46170   0.070 

     Thermal Exp. Stress (Se) [Eq. 10]: (psi)                      43     42533   0.001 

     Settlement Stress (Sd) [Eq. 10a]: (psi)                        0     51300   0.000 

     Sustained + Thermal Exp. Stress (Ste) [Eq. 11]: (psi)         47     59633   0.001 

   ----------------------------------------------------------------------------------- 

                        Additional check for Full Penetration Weld 

   ----------------------------------------------------------------------------------- 

                                                           Calculated   Allowed   Ratio 

                                                                (psi)     (psi) 

     Stress (SNT**) as per Y-3410 Eq. 5: (psi)                   2713     51300   0.053 

     Shear Stress as per Y-3410 Eq. 6: (psi)                     2713     25650   0.106 

 



Material 
 
 

195 

For a project, a piping material engineer usually produces different material lists for different 
process and utility systems based on process design conditions, list of components, fluid type 
(corrosivity, viscosity), end conditions and temperature, pressure and size ranges. 

As a result, a piping system will have its materials list, which will specify the materials a stress 
analyst will have to define inside CAEPIPE before analysis. CAEPIPE is so flexible that it 
allows each element (such as a pipe, beam, elbow, valve, jacket, bellows, etc.) to have its own 
material definition.  

Once you define and name a material type, you type in that name on the Layout window 
under the column “Matl” to specify the material for an element. A material may be metallic 
or FRP.  You need to obtain properties (density, Poisson’s ratio, Young’s modulus, mean 
coefficient of thermal expansion and allowable stress as a function of temperature) for a new 
material not found in the supplied libraries. You will need properties for at least two 
temperatures (reference and design) for each material you define. Subsequently, the 
temperatures you specify for an element that uses this material must fall within this 
temperature range. 

The material name you specify on the layout applies to the piping element on that row. For 
jacketed piping, you must specify two materials - one for the core pipe (on the Layout 
window), and the other for the jacket pipe in its own dialog. The material you specify for a 
bend, a jacketed bend, and for a miter bend applies only to that specific element on that 
input row. 

There are two ways in which you can define materials: 

1. By defining a material inside the CAEPIPE model, or  

2. By picking a material from an existing material library.  

For the sake of convenience, we suggest that you create a separate material library for your 
pipe stress project so that you can share it with your team members. 

Below, you will see how to create a material inside a model and how to create a new or 
modify an existing material library. 

Define a Material inside a CAEPIPE model 

From the Layout window, click on “Matl” on the header row (or select Materials from the 
Misc menu, Ctrl+Shift+M). 
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The List window for materials is shown. 

 

In the Material List window, you can edit inside both panes - the left pane contains Name, 
Description, Type of material, Density, Poisson’s ratio (nu), Joint factor etc. and the right 
pane contains material properties (usually Modulus of Elasticity E, mean Coefficient of 
Linear thermal expansion [Alpha], not instantaneous coefficient nor thermal expansion per 
unit length, and the code-specific Allowable stress) as a function of Temperature. CAEPIPE 
requires “Weight Density” to be input in lbf/in3 or kgf/m3 and NOT its mass density. 
While entering the temperature-dependent material properties, you need not enter 
temperatures in an ascending order, although recommended. CAEPIPE will sort the entries 
later. 

After you are done entering properties for one material, be sure to press Enter when the 
cursor is in the left pane, to move it to the next row so you can start entering the next 
material. You can insert, copy & paste, delete and edit any material (see under Edit menu). 

These panes may change depending on the piping code chosen. For example, for the 
Swedish and Norwegian codes, the following window is displayed. This window contains 
additional columns for Tensile strength and instead of one Joint factor, it has Longitudinal 
and Circumferential joint factors. 
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The European (EN 13480) code has a column for Tensile strength and temperature-
dependent properties have an additional column for fCR (allowable creep stress). 
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To Input a New Material 

You can input a new material in three ways: 

1. Start typing directly into the fields in the Materials List window.  

2. Input through dialogs (shown below for some but not all piping codes). 

 

 

For the Swedish and Norwegian piping codes, the Material dialog has Longitudinal and 
Circumferential joint factors and a Tensile strength field. 
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For the European (EN 13480) code, the Material dialog has a single Joint factor and a 
Tensile strength field, while the properties window has fCR (creep stress allowable). 
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3. Pick a material from an existing material library (supplied with CAEPIPE or your own). 
Click on the Library button on the toolbar to open the library:  

 

(or select Library command under the File menu):  

 

You will have to open a library file first if it was not previously opened. Select the one of 
interest. Note that the libraries with filenames starting with B311 and B313 with year 
later than 2010 (e.g., B313-2012.mat) have approx. 200 materials each (from the 
respective piping code). 

 

You can select a material from the opened library by double clicking on it or highlighting 
it and clicking on OK. 
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Name 

Type a Material name, up to five(5) alpha-numeric characters. 

Description 

Type a description for the material, up to 31 characters. 

Type 

AL for Aluminum 

AS for Austenitic Stainless Steel 

CA for Copper alloys annealed 

CC for Copper alloys cold worked 

CS for Carbon Steel 

FR for Fiber Reinforced Plastic piping 

FS for Ferritic steel 

NA for   Nickel alloys 800, 800H, 825 

SS for Stainless Steel 

TI for Titanium 

These material types are used in calculation of the Y factor for allowable pressure at high 
temperatures for certain piping codes. Swedish and Norwegian piping codes also use it for 
calculating allowable expansion stress range. These codes also need tensile strength. 

For Fiber Reinforced Plastic piping, you need to select the material type “FR” to enter FRP 
material properties. More information can be found under the section Fiber Reinforced 
Plastic Piping in this manual. 
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Density 

Density of the material is used to calculate weight load and also mass for dynamic analysis. 
CAEPIPE requires “Weight Density” to be input in lbf/in3 or lbf/ft3 or kgf/m3 or gf/cm3 
and NOT its mass density. Whenever mass is required for a calculation as in the case of 
forming Mass matrix for dynamic analysis, or in calculating inertia force as (mass x 
acceleration) for static seismic analysis, CAEPIPE internally computes the mass  to be equal 
to (weight / g-value). 

Nu 

The Poisson’s ratio (Nu) defaults to 0.3 if not input. 

Joint factor 

The joint factor is the longitudinal weld joint factor used to calculate allowable pressure. For 
Swedish and Norwegian piping codes, a circumferential joint factor is also input to calculate 
longitudinal pressure stress. 

Tensile strength / Yield 

For Swedish, Norwegian and European (EN13480) piping codes, tensile strength is used in 
the calculation of the allowable expansion stress range. For Stoomwezen piping code, tensile 
strength is used in the calculation of hot allowable stress. 

For B31.3 or B31.12 piping codes, yield is used in the calculation of sustained plus occasional 
allowable stress when the temperature is > 4800 C or 8000 F.  

Note: Leaving the yield field blank will cause CAEPIPE to issue Assertion failure during 
analysis for stress system having the temperature of piping >4800 C or 8000 F. 

To create or modify a material library 

CAEPIPE offers you flexibility in creating your own material libraries (user-defined 
libraries). That way, you do not feel restricted by the offered choices in materials and can 
continually keep updating the material libraries with your own materials. To create a library: 
From the Main window, select File > New and click on Material Library. 

 

A List window for materials is shown. 
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You must select a piping code first, using the menu command Options > Piping code, 
before you start entering properties. 

You can, as before, start typing directly into the fields, or enter properties through a dialog. 
The only difference is that materials in the library do not have names whereas those in a 
model have names. 

After you are done entering materials, you must save to a material library file by using the 
File > Save command. 

 

Give the file a suitable name. The file will be saved with a .mat extension. 
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Note: It is also possible to Import/Export the material library through a Ascii Material Batch 
Library (.mlb) file. See the section titled Import/Export Material Library in Appendix A of 
CAEPIPE User’s Manual for more details. 

Should you need to change the piping code, then you will need to update all materials’ 
properties (in this library) according to the new code, or load a new file. Better yet, if you do 
not see the library among the supplied files, create a new library for the new code. 

 

Therefore, first make sure that you have selected the correct piping code (under Options > 
Analysis > Piping code) in the Layout window. Then, ensure that you use the correct 
properties from that code. 

CAEPIPE comes with many libraries from several piping codes. When inside a CAEPIPE 
model, you can open any library and pick a material from it. Make sure to pick the proper 
library (with the proper year), especially between B31.1 and B31.3 libraries because they have 
significantly different allowable stresses for the same materials. Also verify the material 
properties in these libraries before you use them. 

 

 
In summary, CAEPIPE is supplied with many built-in material libraries applicable 
for different piping codes. Users should ensure that the correct piping code and 
the corresponding material library are selected for each CAEPIPE model created 
and the built-in material properties have been checked for correctness prior to 

their use. 
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In dynamic analysis using modal superposition, usually an approximate solution is obtained 
because only a limited number of modes is considered. (For seismic analysis, typically all 
modes up to 33 Hz). The errors in pipe displacements and stresses are usually small because 
they are affected relatively little by high modes. The error in support loads may be substantial 
because the influence of higher modes on support loads can be important. In stiff piping 
systems with few low frequency modes, stresses may also be affected significantly. 

Using limited number of modes results in some mass of the system being ignored. The 
distribution of this “missing mass” is such that the inertia forces associated with it will 
usually produce small displacements and stresses. However these forces will often produce 
significant support loads, and in stiff systems can produce significant stresses. 

A correction can be made by determining the modal contributions to the mass of the system 
and obtaining the “missing mass” as the difference between these contributions and the 
actual mass. 

The inertial force vector for the nth mode is given by 

{𝐹𝑛} = −[𝑀]{𝑢̈𝑛} = 𝜔𝑛
2[𝑀]{∅𝑛}𝐴𝑛 

Where  [𝑀] = diagonal mass matrix 

 {𝑢̈𝑛} = acceleration vector 

 𝜔𝑛 = circular frequency 

 {∅𝑛} = mass normalized eigenvector 

 𝐴𝑛 = modal displacement for mode n 

For X seismic excitation 

𝐴𝑛 = {∅𝑛}𝑇[𝑀]{𝑟𝑥}
𝑆𝑛𝑥

𝑎

𝜔𝑛
2 = 𝛤𝑛𝑥

𝑆𝑛𝑥
𝑎

𝜔𝑛
2  

Where  {𝑟𝑥} = displacement vector due to a unit displacement in the X direction 

 𝑆𝑛𝑥
𝑎  = spectral acceleration for the nth mode for excitation in the X direction 

 Γnx = mass participation factor in the X direction for mode n 

Let 𝑚 = number of modes used in analysis 

 𝑁 = total number of modes 

If it is assumed that the higher modes: m+1 through N are in phase and have a common 

spectral acceleration𝑆𝑜𝑥
𝑎  (conservatively taken as the maximum spectral acceleration after the 

mth mode), the total inertial force contribution of these higher modes (also known as “Rigid 

body force” or “Left out force”) is 

{𝐹𝑥
𝑅} = 𝑆𝑜𝑥

𝑎 [𝑀] ∑ {𝜙𝑛}

𝑁

𝑛=𝑚+1

𝛤𝑛𝑥  

(1) 

(2) 

(3) 
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It can be shown that 

{𝑟𝑥} = ∑{𝜙𝑛}

𝑁

𝑛=1

𝛤𝑛𝑥 = ∑{𝜙𝑛}

𝑚

𝑛=1

𝛤𝑛𝑥 + ∑ {𝜙𝑛}

𝑁

𝑛=𝑚+1

𝛤𝑛𝑥  

Substituting from (4) for the summation in (3) 

{𝐹𝑥
𝑅} = 𝑆𝑜𝑥

𝑎 [𝑀] [{𝑟𝑥} − ∑{𝜙𝑛}

𝑚

𝑛=1

𝛤𝑛𝑥] 

Note that there will be missing mass inertia forces in the Y and Z directions, in addition to 
the X direction, for X excitation. 

The missing mass force vectors for the Y and Z directions are similarly calculated. The 
response to each of these three force vectors is calculated and these additional response 
vectors are combined with the responses of the first “m” modes. 

This feature is currently not available for Time History, Multi-Level Response Spectrum and 
Harmonic analyses. 

The above described method is based on the technical paper by Powell.  See below for 
details. 

Powell, G.H. “Missing Mass Correction in Modal Analysis of Piping Systems.” Transactions 
of the 5th International Conference on Structural Mechanics in Reactor Technology. August 
1979: Berlin, Germany. 

(4) 

(5) 
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Miter bends are typically used when space limitations do not allow the use of regular bends 
(elbows), or when a miter is more economical to use than a regular bend. Miters are not 
fittings. They are fabricated from pipe, to requirements. “The use of miters to make changes 
in direction is practically restricted to low-pressure lines, 10-inch and larger if the pressure 
drop is unimportant...” (Sherwood 1980). 

See figure below for Miter bend parameters. 

 

In this figure, r = mean radius of pipe 
 S = miter spacing at center line 

 θ = one-half angle between adjacent miter axes (≤ 22.5°) 

Before modeling a miter bend, you should determine whether it is closely or widely spaced. 

Closely Spaced Miter 

A miter bend is closely spaced when S < r(1 + tan θ). 

 

A closely spaced miter bend is input as a single miter bend element. 

The Bend Radius (R) is calculated as: R = 0.5 S cot . 
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Widely Spaced Miter 

A miter bend is widely spaced when 𝑆 ≥ 𝑟(1 +  𝑡𝑎𝑛 θ). 

 

A widely spaced miter bend is modeled with as many miter bend elements as there are miter 
cuts. 

The Bend Radius (R) is calculated as: 𝑅 = 0.5 𝑟 (1 + 𝑐𝑜𝑡 𝜃). 

A miter bend is input by typing “m” in the Type column or selecting “Miter bend” from the 
Element types dialog. 

 

The Miter bend dialog is shown. 
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Bend Radius 

The bend radius (R) depends on the type of miter (Closely or Widely spaced). It is calculated 
as explained previously and input in this field. 

Bend Thickness 

Input the wall thickness of the miter bend if it is different from that of the adjoining pipe 
thicknesses. The Bend Thickness, if specified, applies only to the curved portion(s) of the 
equivalent bend(s) of the miter bend. 

Bend Material 

If the material of the miter bend is different from that of the adjoining pipe, select the Bend 
Material from the drop down combo box. The Bend Material, if specified, applies only to the 
curved portion(s) of the equivalent bend(s) of the miter bend. 

Flexibility Factor 

Specify a flexibility factor for the miter bend if different from the piping code’s factor. If you 
specify one, CAEPIPE uses it instead of the piping code specified Flexibility Factor. A value 
of 2.0, for e.g., will mean that the miter bend is twice as flexible as a pipe of the same length. 

Closely spaced 

To specify the miter bend as closely spaced, click on the “Closely spaced” radio button. 

Widely spaced 

To specify the miter bend as widely spaced, click on the “Widely spaced” radio button. 

Parameters for 90° Miter Bends 

The parameters (dimensions) for 90° miter bends (with 2, 3, 4 miter cuts) in terms of 
dimension (A), mean pipe radius (r) and number of miter cuts (N) are shown in the following 
table. 

Use the table to determine whether the miter bend is Closely spaced or Widely spaced, and if 
it is Widely spaced and has 2, 3 or 4 miter cuts, to calculate the dimensions B, C, D, E and R 
(equivalent miter bend radius) before modeling it. 

A closely spaced miter requires only the miter bend radius (same as dimension A shown in 
the figures). 

   Dimensions for Widely spaced miters only 

N S Closely spaced if B C D E R 

2 0.828427 A A < 1.707107 r 0.414214 A 0.585786 A - - 1.707107 r 

3 0.535898 A A < 2.366025 r 0.267949 A 0.464102 A - - 2.366025 r 

4 0.397825 A A < 3.013670 r 0.198912 A 0.367542 A 0.281305 A 0.152241 A 3.013670 r 

N = Number of miter cuts 

Half angle  = 90° /(2N) 

 The following pages show the details of how dimensions B, C, D and E were calculated, and 
are provided only for your information. The above table is important for your modeling 
requirements. For miters with more than 4 cuts, you have to calculate the required 
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dimensions similar to those shown on the following pages. The next table outlines the 
modeling procedure for either miter type. 

Miter Modeling Procedure 

 Determine Miter Type   

Closely Spaced Miter  Widely Spaced Miter   
Any number of cuts  2 cuts  3 cuts  4 cuts  

Model miter as a single 
Closely spaced miter 
with Bend radius as 
dimension A.  

Calculate R, B and C from above table. 
Calculate offsets of nodes using B and C. See 
Example 2 Widely spaced miter.  

Calculate R, B, C, D 
and E from above ta-
ble. Calculate offsets 
of nodes using B, C, 
D and E.  

Model this miter as 2  Model this miter as 3  Model this miter as 4  

See Example 1, Closely  widely spaced miters  widely spaced miters  widely spaced miters  

spaced miter.  with R as the bend  with R as the bend  with R as the bend  

 radius.  radius.  radius.  
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Two Miter Cuts (N=2) 

 = 90° / ( 2 x 2 ) = 22.5° 

S = 2 A tan =0.828427 A 

B = A tan = 0.414214 A 

C = 2 A tan cos 2= 0.585786 A 

Closely Spaced 
The miter is Closely spaced if, 

S r ( 1 tan  ) 
Substituting for S, 

2A tan  r ( 1 tan  ) 

A  1.707107 r 

Bend radius, R = 0.5 S cot A 

Widely Spaced 

R = 0.5 r ( 1 cot  ) = 1.707107 r 
 

Three Miter Cuts (N=3) 

 = 90° / ( 2 x 3 ) = 15° 

S = 2 A tan =0.535898 A 

B = A tan = 0.267949 A 

C = 2 A tan cos 2= 0.464102 A 

Closely Spaced 
The miter is Closely spaced if, 

S r ( 1 tan  ) 
Substituting for S, 

2A tan  r ( 1 tan  ) 

A  2.366025 r 

Bend radius, R = 0.5 S cot A 

Widely Spaced 

R = 0.5 r ( 1 cot  ) = 2.366025 r 
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Four Miter Cuts (N=4) 

 = 90° / ( 2 x 4 ) = 11.25° 

S = 2 A tan =0.397825 A 

B = A tan = 0.198912 A 

C = 2 A tan cos 2= 0.367542 A 

D = 2 A tan sin 4= 0.281305 A 

E = 2 A tan sin 2= 0.152241 A 

Closely Spaced 
The miter is Closely spaced if, 

S r ( 1 tan  ) 
Substituting for S, 

2A tan  r ( 1 tan  ) 

A  3.013670 r 

Bend radius, R = 0.5 S cot A 

Widely Spaced 

R = 0.5 r ( 1 cot  ) = 3.013670 r 
 

Example 1: Closely Spaced Miter 

Example Data 

Pipe OD = 8.625”, thickness, t = 0.322” 

Mean pipe radius, r = (8.625 - 0.322) / 2 = 4.1515”, 
Number of miter cuts = 3, 
Dimension A = 8”, See 3-cut miter figure. 

Look up table (Miter modeling procedure), for an outline of the modeling procedure. 

First, determine the type of miter (Closely or Widely spaced) before modeling it. 

Look up Summary of Miter parameters, for N = 3. A miter is Closely spaced if A < 
2.366025r. This condition is true for r = 4.1515”. Hence, this is a Closely spaced miter. 

Steps for Example 1 

 Create From node: When you start a new model file, node 10 and an Anchor are 
automatically input, press Enter to move cursor to next empty row.  

 Construct miter bend: type 20 for Node (simply pressing Tab puts this node number 
automatically for you), type “m” under the Type column, type 8” for bend radius, 
select Closely spaced, click on Ok. Type 10” for DX, enter material, section and load 
names, press Enter.  

 Finish the miter bend: type 30 for Node and -10” for DY, press Enter. 

 



Miter Bend 
 

213 

 

Example 2: Widely Spaced Miter 

Let us assume the same data as in Example 1 (Closely spaced miter) with only one change, 
namely, dimension A (see next figure). 

Pipe OD = 8.625”, thickness, t = 0.322” 

Mean pipe radius, r = (8.625 - 0.322) / 2 = 4.1515”, 
Number of miter cuts = 3, 
Dimension A = 12”. 

Look up table (for Miter modeling procedure) for an outline of the modeling procedure. 

 

It is essential to determine the type of miter (Closely or Widely spaced) before modeling it. 
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Determine miter type 

Look up table, Summary of Miter parameters, for N = 3. A miter is Closely spaced if A < 
2.366025r. This condition is false for r = 4.1515”. Hence, this is a Widely spaced miter. This 
miter bend has to be modeled as a series of 3 miters. Next, observe in this table that 
dimensions B, C and R (Equivalent miter bend radius) can be calculated for N = 3 cuts. 

Calculate required dimensions 

With r = 4.1515”, 

Equivalent miter bend radius, R = 2.366025 × r = 9.8225”, 

Dimension B = 0.267949 × A = 3.2154”, 

Dimension C = 0.464102 × A = 5.5692” 

See previous figure. After calculating B, C and R, let us now calculate the offsets of nodes 20, 
30 and 40 (the 3 nodes correspond with the 3 miter cuts). 

Calculate Offsets 

Offsets of node 20 from 10: (First miter cut) 
DX = B = 3.2154” 
DY = 0” (because node 20 is on the horizontal axis). 

Offsets of node 30 from 20: (Second miter cut) 
DX = C = 5.5692” 
DY = -B = -3.2154” 

Offsets of node 40 from 30: (Third miter cut) 
DX = B = 3.2154” 
DY = -C = -5.5692” 

Offsets of node 50 from 40: 
DX = 0” (because node 50 is on the vertical axis). 
DY = -B = -3.2154” 

Now, start to build the model in CAEPIPE as shown in Example 1 but with different data 
(bend radius = 9.8225”, select Widely Spaced miter, and offsets as shown above). 

Steps for Example 2 

 Create From node: When you start a new model file, node 10 and an Anchor are 
automatically input, press Enter to move cursor to next empty row.  

 Construct first miter bend: type 20 for Node (simply pressing Tab puts this node 
number automatically for you), type “m” under the Type column, type 9.8225” for 
bend radius, select Widely spaced, click on Ok. Type 3.2154” for DX, enter material, 
section and load names, press Enter.  

 Construct second miter bend: type 30 for Node (simply pressing Tab puts this node 
number automatically for you), type “m” under the Type column, type 9.8225” for 
bend radius, select Widely spaced, click on Ok. Type 5.5692” for DX, -3.2154” for 
DY, press Enter. 
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 Construct third miter bend: type 40 for Node (simply pressing Tab puts this node 
number automatically for you), type “m” under the Type column, type 9.8225” for 
bend radius, select Widely spaced, click on Ok. Type 3.2154” for DX, -5.5692” for 
DY, press Enter.  

 Finish the miter bend: type 50 for Node and -3.2154” for DY, press Enter. 

 

 

 

Sherwood, David. R., and Dennis J. Whistance. THE “PIPING GUIDE” A Compact 
Reference for the Design and Drafting of Industrial Piping Systems. First Edition (revised). 
San Francisco: Syentek Books Co., 1980. 
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A Node refers to a connecting point between two elements such as pipes, reducers, valves or 
expansion joints. The maximum # of nodes in a model cannot exceed 9,999; while the 
maximum node number itself cannot be greater than 99,999.Usually, a node has a numeric 
designation. In CAEPIPE, occasionally, you may have a need to reference a node followed 
by a letter such as A/B/C/D/J. These are automatically generated internal nodes. A and B 
nodes (e.g., 20A, 20B) designate the near and far ends of a Bend node (see section on Bend). 
J, C and D (e.g., 10J, 10C, 10D) designate a Jacketed pipe and a Jacketed bend (see section 
on Jacketed Piping).  

In the Layout window, node numbers are typed under the column titled Node. A node 
number may be typed as an integer or an integer followed by one of the letters A/B/C/D/J. 
Use “Location” type to specify more than one data item at a node (See section on Location). 

The starting node in a piping system is always a node of type “From,” which is usually 
anchored. 

Nodes not only act as connect points for elements but also act as locations for providing 
supports or applying restraints/external forces and moments to the piping system. Each 
node has six static degrees of freedom (three dynamic), three translational (in x, y and z 
directions) and three rotational (about x, y and z axes). Any or all of them may be restrained 
using supports. 

Specifying Coordinates 

The values typed in the DX, DY and DZ fields on the Layout window are interpreted as 
offsets from the previous node. If required to specify absolute coordinates for a node (i.e., 
fix the location of a point in space), the node has to be of type “From” or should have an 
asterisk (*) at the end of it (e.g., 20*). In these cases, the numbers entered in the DX, DY and 
DZ fields are interpreted as absolute coordinates of the node rather than offsets from the 
previous node. If the coordinates for a particular node are duplicated the second set of 
values is ignored. An asterisk (*) for a “From” node is ignored too. 

You can list all coordinates by selecting Coordinates under Misc menu (or click on the Node 
header or right click on any node number). This feature can be helpful for verifying 
correctness of the input. 

In the Layout window, you can search for a node by using the “Find node” command (under 
the View menu, or use Ctrl+F), specify a “Node increment” for automatic node numbering 
(under Options menu), and renumber nodes for a range of rows (under Edit menu) 

Automatic Renumbering 

When you delete a row with a node number in the Layout window, CAEPIPE automatically 
renumbers nodes from the top starting with the number you have specified under the main 
window > File > Preferences > Automatic Renumbering. Note that this is different from the 
user-performed selective renumbering of a range of rows from the Edit menu.  

When turned on, deleting a row triggers an automatic renumbering operation inside the 
Layout window.  So if you do not want such to happen, turn the feature off from the main 
window.
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There are several types of nonlinearities in CAEPIPE: 

1. Gaps in limit stops and guides.  

2. Rotational limits in ball and hinge joints.  

3. Rod hangers as one-way restraints.  

4. Tie rods with different stiffnesses and gaps in tension and compression.  

5. Friction in limit stops, guides, slip joints, hinge joints and ball joints.  

6. Buried piping.  

An iterative solution is performed when nonlinearities are present. At the start of each 
iteration, the overall global stiffness matrix and the load vector are reformulated based on the 
solution (displacements) obtained from the previous iteration. 

Limit stop 

Limit stops are input by specifying direction, the upper and lower limits (i.e., gaps) and 
optionally a friction coefficient and a support stiffness that comes into play when either gap 
is closed. The upper and lower limits are along the direction of the limit stop and measured 
from the undeflected position of the node. Typically the upper limit is positive and the lower 
limit negative. The upper limit should be algebraically always greater than or equal to the 
lower limit. In some situations it is possible to have a positive lower limit or a negative upper 
limit. If a particular limit does not exist (i.e., a node can move unrestrained in that direction), 
that limit should be left blank. If a gap does not exist, then the corresponding limit should be 
explicitly input as zero. 

Solution Procedure 

At the end of each iteration, the displacements computed at the limit stop node are resolved 
along the limit stop direction. The resolved displacement (in the limit stop direction) is 
compared with the upper and lower limits. If the resolved displacement exceeds the upper 
limit or is less than the lower limit, the gap is closed; otherwise it is open. The solution is 
converged when the displacements computed are within 1% of the corresponding 
displacementsobtained at the end of the previous iteration. 

If both upper and lower limits (gaps) of a limit stop are open, no stiffness is applied at 
thatlimit stop node, and friction does not arise there.  

If either one of the two gaps is closed,the support load along the limit stop direction is 
calculated as(resolved displacement - gap distance) x user-specified support stiffness.  In this 
case, if friction is specified at the limit stop, the following iterative procedure is carried out. 

1. The resultant displacement (d) in local yz plane is computed at this limit stop node. 

2. The support load at the limit stop is calculated as (resolved displacement - gap 
distance) x user-specified support stiffness.  

3. Using this calculated support load, the friction force (ff) is calculated as ff = friction 
coefficient (mu) x support load.  

4. Using the friction force (ff) and the resultant in-plane displacement (d), the friction 
stiffness (kf) is computed as kf = ff / d. 

5. The global stiffness matrix is then updated to include the friction stiffness computed.
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6. Analysis iteration is continued with the updated global stiffness matrix. The solution 
is converged when the displacementscomputed are within 1% of the corresponding 
displacements obtained at the end of the previous iteration. 

7. After the solution has converged and if the gap is closed, the support load and the 
friction force at the limit stop are calculated as: 

Support load at limit stop = (resolved displacement - gap distance) x user-specified 
support stiffness. 

y shear = fy = local y displacement x friction stiffness (kf) 

z shear = fz = local z displacement x friction stiffness (kf) 

Resultant friction force (ff) = sqrt(fy^2 + fz^2) 

During hanger design, the hot loads are recalculated with the status of the limit stops at the 
end of the preliminary operating load case. Then the hanger travels are recalculated using the 
recalculated hot loads. 

In dynamic analysis, the status of the limit stops at the end of the first operating load case 
(W+P1+T1) is used. If either the upper or lower limit is reached for the first operatingload 
case, the limit stop is treated as a rigid two-way restraint in the direction of the limit stop. If 
both limitsare not reached, then that limit stop is treated as having no restraint. 

Friction 

Friction is specified by entering coefficient of friction for limit stop and guide, entering 
friction force and/or friction torque for slip joint, entering friction torque for hinge joint and 
entering bending and/or torsional friction torque for ball joint. 

Friction is modeled using variable equivalent friction stiffnesses (fictitious restraints) in 
CAEPIPE as described in the above Solution Procedure. The stiffnesses of these fictitious 
restraints are estimated from the results of previous iteration. If friction is included in 
dynamic analysis, these equivalent friction stiffnesses computed from the last iteration of the 
first operating load case are included in modal and dynamic analyses. 

Friction in Limit Stop 

If the gap is not closed, there is no normal force and hence no friction. If the gap is closed, 
the normal force (limit stop support load) is calculated as explained above. The maximum 
friction force is friction coefficient * normal force. The displacement of the limit stop node 
is resolved into a plane normal to the limit stop direction (let us call this resolved 
displacement: y). Also let ky = equivalent friction stiffness which is assumed to be zero for 
the first iteration. 

If y is non-zero or y * ky> maximum friction force, 

then ky = maximum friction force / y 

otherwise ky = high stiffness ( 1×10
12

 lb/inch) [This is the case of no sliding] 

In the next iteration the equivalent friction stiffness is added to the global stiffness matrix. 
The iterations are continued till the displacement y is within 1% of y displacement from the 
previous iteration. The friction force is y * ky. 
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Friction in Guide 

A guide is modeled by adding high stiffnesses perpendicular to the direction of the pipe. The 
normal force in the guide is calculated by the vector sum of the local y and z support loads. 
Maximum friction force is friction coefficient * normal force. The displacements at the guide 
node are resolved in the direction of the guide axis. Let us call this displacement: x. Also let 
kx = equivalent friction stiffness which is assumed to be zero for the first iteration. 

If x is non-zero or x * kx> maximum friction force, 

then kx = maximum friction force / x 

otherwise kx = high stiffness (1×10
12

 lb/inch) [This is the case of no sliding] 

In the next iteration the equivalent friction stiffness is added to the global stiffness matrix. 
The iterations are continued till the displacement x is within 1% of x displacement from the 
previous iteration. The friction force is x * kx. 

Friction in Slip Joint 

The relative displacements (between From node and To node) for the slip joint are resolved 
in the direction of the slip joint. Let us call this relative displacement: x. Also let kx = 
equivalent friction stiffness which is assumed to be zero for the first iteration. 

If x is non-zero or x * kx> friction force input, 

then kx = friction force input / x 

otherwise kx = high stiffness (1×10
12

 lb/inch) [This is the case of no sliding] 

In the next iteration the equivalent friction stiffness is added to the global stiffness matrix. 
The iterations are continued till the displacement x is within 1% of x displacement from the 
previous iteration. The friction force is x * kx. 

Similar technique is used for friction torque (using rotations instead of translations). 

Friction in Hinge Joint 

The relative rotations (between From node and To node) for the hinge joint are resolved in 
the direction of the hinge axis. Let us call this relative rotation: x. Also let kx = equivalent 
friction stiffness which is assumed to be zero for the first iteration. Maximum friction torque 
= friction torque input + hinge stiffness input * x. 

If x is non-zero or x * kx> maximum friction torque, 

then kx = maximum friction torque / x 

otherwise kx = high stiffness [This is the case of no sliding] 

In the next iteration the equivalent friction stiffness is added to the global stiffness matrix. 
The iterations are continued till the relative rotation x is within 1% of x rotation from the 
previous iteration.  The friction torque is x * kx. 
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Friction in Ball Joint 

For a ball joint friction in bending (transverse) and torsional (axial) directions is treated 
independently. For the bending case, the resultant of the local y and z directions is used. 
Otherwise a procedure similar to the one used for hinge joint is used. 

Friction in Dynamic Analysis 

Friction is optional in dynamic analysis. Friction is mathematically modeled by using 
equivalent stiffnesses. If friction is included in dynamic analysis, these equivalent friction 
stiffnesses computed from the last iteration of the first operating load case are included in 
modal and dynamic analyses. 

Misconvergence 

During the iterative solution procedure for nonlinearities, a misconvergence is reported in 
the following manner: 

 

You have three options: 

Continue the iterative procedure for 500 more iterations to see whether the solution 
converges, or 
Accept the misconvergence (maximum misconvergence is reported, 100% in the above 
dialog), or  
Exit the analysis processor completely.  

An environment variable “CPITER” may be defined to change number of iterations from 
the default 500. For example, when “CPITER=1000”, iterations will continue up to 1000 
before showing the dialog: Continue, Accept or Exit if there is misconvergence. 

The shown misconvergence in the solution is really a quantification of how much off the 
results will be, IF you accept it. The maximum misconvergence (100% in the above case) is 
shown along with its location where such is happening.  

In case of a solution with large misconvergence, you have two options: 1. Change parameters 
(mainly gaps and friction values, or removal of unneeded supports) inside the model to 
influence the convergence routine, or, 2. Increase the # of iterations. In case neither works, 
then use engineering judgment to accept or reject the merit of such a solution. 
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Nozzles are integral attachments of vessels (such as pressure vessels, storage tanks etc.) 
which connect with external piping. Nozzles transmit the shell (vessel) flexibility to the 
piping system and hence are generally included in piping stress analysis. 

Three types of nozzles can be modeled in CAEPIPE, namely (i) a nozzle attached to a 
cylindrical vessel relatively far from the ends of the cylinder, (ii) a nozzle attached to a 
spherical vessel or torispherical head and (iii) a nozzle attached to a cylindrical shell with a 
flat bottom and close to the flat-bottom. CAEPIPE calculates the nozzle stiffnesses (local 
flexibility components) according to WRC 297, PD 5500 and API 650 guidelines. See 
Annexure II for the procedures according to WRC 297 and API 650. 

Note: 

Pressure Thrust (End-cap Force) of Pressure P x Inner Area (A) of pipe is not included in 
the Support Loads for Nozzles displayed by CAEPIPE at this time.  Since CAEPIPE’s 
results for numerous problems compare well with the results from other third-party 
software, it confirms that the other stress programs are also not including the Pressure 
Thrust (End-cap Force) of pipe in the Nozzle Loads at this time. Refer to the Verification 
Manual supplied with CAEPIPE for comparison of results with other stress programs. 

If you wish to include the effect of Pressure Thrust (End-cap force) due to internal pressure 
in your piping on the Nozzle loads, then you will have to compute the same manually (= P x 
A) and input it as an external force at the Nozzle Nodes using the Force data type available 
with CAEPIPE. Please choose the option “Add to W+P” in the Force data type dialog. By 
doing so, the End-cap force (= P x A) will be included in all relevant load cases and 
combinations of CAEPIPE. Of course, when the “None” code is selected under Optionss > 
Analysis > Code, this End-cap force is included in the only case of “Static”. 

Nozzle attached to a cylindrical vessel 
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The coordinate system is as shown in the figure. The six components of the forces and 
moments at the nozzle-vessel interface are: 

P = Radial load MC = Circumferential moment 
VC = Circumferential load MT = Torsional moment 
VL = Longitudinal load ML = Longitudinal moment 

Of the six components of shell stiffnesses, only three stiffnesses, axial (Kx), circumferential 
(Kyy), and longitudinal (Kzz), are computed. The remaining three are assumed to be rigid. 

A nozzle is input by typing “n” in the Data column or selecting “Nozzle” from the Data 
Types dialog. 

 

The Nozzle dialog is shown. Note that the Displacements button is disabled. It is only 
enabled after the nozzle is input (i.e., existing nozzle). 
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Nozzle 

OD:  Outside diameter of the nozzle. 
Thk: Thickness of the nozzle. 

Vessel 

OD: Outside diameter of the vessel. 
Thk: Thickness of the vessel. 
L1, L2: Distances from the nozzle to the nearest stiffening ring, tubesheet or the vessel end. 

Vessel axis direction 

The orientation of the vessel axis in terms of its global X, Y and Z components are entered 
here. See example under “Specifying a Direction.” 

Nozzle to Spherical / Torispherical Shell 

For a nozzle attached to a spherical shell or a torispherical head, check the Spherical Vessel 
checkbox and enter the required details. 
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Nozzle attached to Flat-Bottom Tanks 

For a nozzle on a flat-bottom tank and close to the flat-bottom, check the Flat-bottom tank 
checkbox. 

 

A slightly modified Nozzle dialog is displayed. 
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All the input fields are the same as before except: 

L 

L is the distance from the flat-bottom to the nozzle centerline. 

Reinforcing pad 

If the nozzle is reinforced, check this box. 

Stiffness Calculation 

Here again, only three shell stiffnesses, axialtranslational (i.e., axial to the pipe, the same as 
radial to the shell), circumferential bending and longitudinal bending are computed according 
to API 650 guidelines. See Annexure II for the procedure. The remaining three shell 
stiffnesses are assumed to be rigid. 

The flat-bottom tank nozzles are subject to the following limitations (API 650): 

Limitations 

 Nozzle OD/Vessel OD ratio must be between 0.005 and 0.04.  

 L/Nozzle OD ratio must be between 1.0 and 1.5. See graphs in Annexure II, Figures 
D-3 through D-14.  

Displacements 

After a nozzle is input in a stress model, Displacements (translations and/or rotations) in the 
global X, Y and Z directions may be specified for that nozzle (for thermal, settlement and 
seismic cases). Click on the Displacements button. You will see a dialog similar to one shown 
below. Type in specified displacements and press Enter. 
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There are three types of displacements which can be specified: 

1. Thermal (up to 10 displacements can be specified, one for each of the thermal loads T1 
through T10). Applied only to the Expansion and Operating load cases.  

2. Seismic (available for B31.1, ASME Section III Class 2, RCC-M and EN 13480 codes 
only). Solved as a separate internal load case and the results so obtained for this case are 
added absolutelyto the corresponding results from static seismic and response spectrum 
load cases.  

3. Settlement (available under ASME B31.1, ASME Section III Class 2, RCC-M and EN 
13480 codes only). Applied as a separate load case called Settlement as described below. 

Settlement 

For certain piping codes (ASME B31.1, ASME Section III Class 2, RCC-M and EN 13480), 
a settlement, which is a single non-repeated movement (e.g., due to settlement of 
foundation), may be specified. This is applied to the Settlement load case. For those codes 
which do not have a separate provision for settlement (like B31.3), specify the settlement as a 
thermal displacement (a conservative approach) for one of the temperature load and define 
that temperature as equal to reference temperature. 

Example 1: Nozzle on a cylindrical vessel 

Assume the following data: 
Vessel Radius = 900 in. 
Vessel Thickness = 1.0 in. 
Nozzle OD = 26 in. 
Nozzle Thickness = 0.5 in. 
L1 = L2 = 1200 in. 
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Elastic modulus for vessel material = 28×10
6
psi. 

The first node (10) is already defined as an anchor. To replace the anchor by a nozzle, right 
click on the Anchor in the Data column, then select Delete Anchor. Then type “n” in the 
Data column to input the nozzle. The Nozzle dialog will be shown. Input the nozzle data in 
the dialog. The Layout window looks like the following: 

 

The graphics is shown next. 

 

Nozzle Stiffnesses 

The three local shell stiffnesses computed can be viewed using the List command (Ctrl+L in 
the Layout window) and selecting Nozzle Stiffnesses. The following window is displayed. 

 

The nozzle/vessel data may be edited here (double click to edit). 

Example 2: Nozzle on a spherical vessel 

Assume the following data: 
Vessel OD = 1800 in. 
Vessel Thickness = 1.0 in. 
Nozzle OD = 26 in. 
Nozzle Thickness = 0.5 in. 

Elastic modulus for vessel material = 28×10
6
psi. 
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The first node (10) is already defined as an anchor. To replace the anchor by a nozzle, right 
click on the Anchor in the Data column, then select Delete Anchor. Then type “n” in the 
Data column to input the nozzle. The Nozzle dialog will be shown. Input the nozzle data in 
the dialog. The Layout window looks like the following: 

 

The graphics is shown next. 

 

Nozzle Stiffnesses 

The three local shell stiffnesses computed can be viewed using the List command (Ctrl+L in 
the Layout window) and selecting Nozzle Stiffnesses. The following window is displayed. 

 

The nozzle/vessel data may be edited here (double click to edit). 

Example 3: Nozzle on a flat-bottom storage tank 

Assume the following data: 

Vessel OD = 1800 in. 
Vessel Thickness = 1.0 in. 
Nozzle OD = 26 in. 
Nozzle Thickness = 0.5 in.  
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L = 36 in. 

Elastic modulus of the vessel material = 28×10
6
psi. 

No reinforcing pad on the vessel. 

Create the piping till the nozzle node. At the nozzle node, enter a Nozzle by typing “n”, 
check the Flat-bottom tank checkboxand provide the required data. 

The Layout window looks like the following. 

 

The graphics is shown next. 

 

The three nozzle stiffnesses computed can be viewed as before by using the List command 
(Ctrl+L) and selecting Nozzle Stiffnesses. 

LCS (Local Coordinate System) can be displayed for Nozzle element by a few ways: 

1. List (Ctrl+L) > Nozzles > View menu > Show LCS, -OR- 

2. List (Ctrl+L) > Nozzles > Mouse Right Click on the listed Nozzle > Show LCS, -OR- 

3. Results window > Support Loads > Other Support Loads > Nozzles > View menu > 
Show LCS, -OR- 

4. Results window > Support Loads > Other Support Loads > Nozzles > Mouse Right 
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Click > Show LCS. 
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One of the qualification requirements for a piping system is to keep the loads imparted by 
the piping on equipment nozzles within certain allowable limits. These loads consist of sets 
of three forces and three moments, for the various load combinations. There are basically 
two types of nozzle load limits: (1) nozzle loads applied to rotating equipment, and (2) nozzle 
loads applied to static equipment such as heat exchangers, tanks and vessels. 

Nozzle Loads applied to rotating equipment 

Rotating equipment consist of equipment with moving parts, such as pumps, compressors, 
turbines and fans. The pipe nozzle load limits are developed by the equipment manufacturer 
and are intended to prevent malfunction, such as shaft misalignment, or distortion of the 
casing that could impede the movement of impellers. These limits are typically based on 
actual testing of the equipment, and not on analysis. 

Some pump standards have published standard nozzle load limits, but these are only valid 
for the particular pumps for which they are published. This is the case for the American 
Petroleum Institute’s API-610 and the Hydraulic Institute’s HI 9.6.2.11 standard. 

See subsection titled “Pump” from this manual for more details. 

Similarly, API 617 provides nozzle load limits for compressors and NEMA SM-23 for 
turbines. 

See subsections titled “Compressor” and “Turbine” from this manual for further details. 

Nozzle Loads applied to static equipment 

For Nozzlesconnected to static equipment such as heat exchangers, tanks and vessels, the 
pipe load limits are based on stress or strain limits at the nozzle-to-shell intersection, both on 
the shell and nozzle sides.At present, CAEPIPE considers pipe load limits based on stress or strain 
limits only at the shell side of the nozzle intersection. 

Nozzle Evaluation Module 

The Nozzle Evaluation module implemented in CAEPIPE computes Allowable Loads and 
Local Stresses at Shell for Nozzles connecting to Spherical and Cylindrical Vessels as per the 
following codes. 

1. Allowable Loads on Nozzle – EN 13445-3:2014/A8:2019 (hereinafter referred as 
EN13445). 

2. Local Shell Stresses at Nozzle– WRC Bulletin 537 (hereinafter referred as WRC 537). 

The Nozzle Evaluation module assumes that the flexibility analysis of that piping system 
with CAEPIPE has already been performed, which will have produced a stress report as well 
as the forces and moments at the location where the nozzle is attached to the piping. 

Note that this module is separate from a piping stress model file and can be accessed from 
File Menu > Open/New command. 
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Double-clicking anywhere in the previous screen (or Edit menu > Edit (Ctrl+E)) opens a 
dialog with input fields you can edit. You will need to enter the data in this dialog. The 
different parameters required to be input are explained in detail below. 

Details on implementation for Calculation of Local Shell Stresses at Nozzles as per WRC 
Bulletin 537 are provided in Code Compliance Manual. 
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Code 

Selecting the Code as “Allowable Loads on Nozzles – EN 13445-3:2014/A8:2019” will allow 
user to compute the “Allowable Loads on Nozzles”. 

On the other hand, selecting the Code as “Local Shell Stresses at Nozzles – WRC Bulletin 
537” will allow user to compute the Local Shell Stresses at Nozzles as per WRC 537 and 
perform Stress Compliance as per ASME Section VIII Division 2. 

Nozzle to Spherical / Cylindrical Shell 

Selecting the option “Nozzle to Spherical / CylindricalShell” will show the dialog boxes as 
shown below for the two Codes. 

For EN13445, the input data required for the two types are shown below.  
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Similarly, for WRC 537, the data required to be input for the two types are shown below. 

  

Load Case 

From the option available, select the Load Case for which the three (3) forces and three (3) 
moments are being entered.  

 

Depending upon the selection of “Load Case”, CAEPIPE will compute 
Radial/Circumferential, Tangential/Longitudinal, Shear and Combined Stress Intensities as 
explained below. 

Please note, the display text for “Allowable (All)”inputfield will change 
automaticallydepending on the “Load Case” selected. 

For example, for “Sustained” Load Case, the display text for “Allowable (All)” input field 
will change to “Sustained Allowable (All)”. Similarly for “Sustained + Occasional”, the 
display text will change to “Sustained + Occasional Allowable (All)”. 
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Sustained and Sustained + Occasional 

Combined Stresses computed willexclude thefollowing BendingStresses from the Evaluation 
of Nozzle to Spherical / Cylindrical Shells respectively. 

a. Radial/Circumferential Bending Stresses due to P 

b. Radial/Circumferential Bending Stresses due to M1/MC 

c. Radial/Circumferential Bending Stresses due to M2/ML 

d. Tangential/Longitudinal Bending Stresses due to P 

e. Tangential/Longitudinal Bending Stresses due to M1/MC 

f. Tangential/Longitudinal Bending Stresses due to M2/ML 

Operating 

Combined Stresses computed will include all Membrane and Bendingstresses due to P,M1 
and M2 / P, MC and ML, Torsional stresses due to MTas well as Shear stressesdue to V1/VC 
and V2/VL. 

Once the required data are input, save the file (Nozzle evaluation will have a .noz extension). 
Now, select File menu > Analyze to calculate loads or stressesas per the code selected, which 
will be shown right below the input information. 
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Loads 

For Nozzle to Spherical Vessel, enter the following loadscomputedin piping analysis for the 
selected load case. 

1. Radial Load (P) 

2. Shear Load (V1) 

3. Shear Load (V2) 

4. Overturning Moment (M1) 

5. Overturning Moment (M2) and 

6. Torsional Moment (MT) 

Similarly, for Nozzle to Cylindrical Vessel, enter the following loads computed in piping 
analysis for the selected load case. 

1. Radial Load (P) 

2. Shear Load (VC) 

3. Shear Load (VL) 

4. Circumferential Moment (MC) 

5. Longitudinal Moment (ML) and 

6. Torsional Moment (MT) 

Vessel and Nozzle Parameters 

For Spherical Vessel, from the Vessel Drawing, read and enter the following parameters. 

Vessel Thickness (T), Vessel Mean Radius (Rm), Nozzle Outside Radius (ro), Nozzle 
Thickness (t) and Nozzle Mean Radius (rm). 

Similarly, for Cylindrical Vessel, from the Vessel Drawing, read and enter the following 
parameters. 

Vessel Thickness (T), Vessel Mean Radius (Rm) and Nozzle Outside Radius (ro). 

Fillet Radius 

Fillet Radius is required to compute the Stress Concentration Factors for Tension (Kn) and 
Bending (Kb) from Figure B-2 WRC Bulletin 537. 

Pressure Stress at Shell (Pm) 

Pm is the Average Primary Membrane Stress across the cross-section of the vessel away from 
Gross Structural Discontinuities such as a Nozzle. 

For a Spherical Shell such as Enclosure/Head to a Vessel, Pm due to internalpressure would 
be PR/2T,where P = Internal Pressure, R is the Mean Radius of the Head and T is the 
Thickness of the Head. 
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For a Cylindrical Shell such as Pressure Vessel/Pre-heater/Tank, to be conservative, Pm due 
to Internal Pressure would be the Circumferential Stress = PD/2T, where D is the Mean 
Diameter of the Cylinder. 

The Stress value thus calculated should be entered in this field.  

Bending Stress at Shell (Pb) 

Pb is the Primary Membrane Stress proportional to the distance from the Axis of the Vessel 
due to External Loads such as Weight, Wind, Earthquake, etc. away from Gross Structural 
Discontinuities such as a Nozzle. 

For a Spherical Shell such as Enclosure/Head to a Vessel, being a free end, Bending Stress 
Pb due to external loads could be 0.0.  

For a Cylindrical Shell such as Pressure Vessel/Pre-heater/Tank, Bending Stress Pb due to 
external loads could be calculated as M/Z, where M is the Bending Moment on the Shell at 
Nozzle location and Z is the Section Modulus of the Shell. 

So, Bending Stress Pb could be manually calculated or determinedusing computer programs. 

Allowable Stress (All) 

Allowable Stress (All) is to be computed and entered depending on the load case selected.  

For example, as perClause 5.2.2.4 of ASME Section VIII Division 2 (2017), the Allowable 
Stress (All) for both “Sustained” and “Sustained + Occasional” load case is to be entered as 
“1.5Sh”, where Sh is the basic allowable stress at maximum metal temperature for Shell. 

Similarly,as per Clause 5.5.6 of ASME Section VIII Division 2 (2017), the Allowable Stress 
(All) forOperating load case should be entered as “3 (SC + Sh)/2 = 1.5 (SC + Sh)”, where Sc is 
the allowable stress at minimum metal temperature for Shell and Sh is defined above. 

Stress Concentration Factors (Kn and Kb) 

CAEPIPE will automatically compute the values of Kn and Kbusing Figure B-2 of WRC 537 
when these fields are entered as 0.0.  

On the other hand, when thesefields are entered with a value great than or equal to 1.0, then 
CAEPIPE will use these values of Kn and Kbwhile computing the stresses as per WRC 537.  

Once the required data are input, save the file (Nozzle evaluation will have a .noz extension). 
Now, select File menu > Analyze to perform the evaluation, which will be shown right below 
the input information. 
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Nozzle Evaluation Module Menus 

File Menu 

 

.Analyze. 

Analyze command calculates nozzle allowable loads as per EN 13445-3:2014/A8:2019 or 
shell stressesat the attachment as per WRC Bulletin 537 and compares them to stress 
allowable specified by ASME Section VIII Division 2 (2017). 

 Print. 

 

You can print a Report by using the Print command.  You can also preview the report by 
clicking the Preview button on the print dialog. 
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Edit Menu 

.Edit. 

You can edit the data by clicking the Edit command. 

 

Options Menu 

 

.Units. 

See Units in the Layout Window Options Menu section of the CAEPIPE User’s Manual. 

.Font. 

See Font in the Layout Window Options Menu section of the CAEPIPE User’s Manual. 
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Pressure Design of Pipe and Pipe Fittings according to EN 13480-3 (2017) 

Pressure Design of Pipe and Pipe Fittings can be performed using the modules built into 
CAEPIPE which are independent of the piping flexibility analysis.  

These modules can be launched through Layout frame > Misc > Internal Pressure Design: 
EN 13480-3 and Layout frame > Misc > External Pressure Design: EN 13480-3. 

Note: 

These modules perform Pressure Design of Pipe and Pipe Fittings ONLY using the 
equations given in the EN 13480-3 (2017) Code irrespective of the Analysis Code selected 
for piping flexibility analysis in CAEPIPE.  

In case the pipe stress analysis is performed with an Analysis Code other than EN 13480-3 
(2017), the Pressure Design  modules will use the material allowable stresses corresponding 
to the maximum temperature T1 through T10 entered in the CAEPIPE stress model. 

Internal Pressure Design of Pipe and Pipe Fittings 

Snap shots shown below present a sample stress model developed to show the Internal 
Pressure Design calculations performed by CAEPIPE. 
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Internal pressure design calculations of pipe and pipe fittings according to EN 13480-3 
(2017) are independent of element lengths entered. Hence, these calculations can be 
performed from the CAEPIPE model already developed for flexibility analysis. Equations 
used for performing Internal Pressure Design as per EN 13480-3 (2017) are provided in 
Section titled “Pressure Design of Pipe & Pipe Fittings” in the Code Compliance Manual. 

Once the layout of the stress model as shown in the above snap shots is completed, the 
internal pressure design is performed through Layout window > Misc > Internal Pressure 
Design: EN 13480-3. 

When executed, CAEPIPE automatically performs the pressure design calculations for Pipes, 
Elbows, Miters, Bends and Reducers for the entire stress model and displays the results as 
shown below.   

It is observed that the ratios Uf1 and Uf2 are all less than 1.0, confirming that the Internal 
Pressure Design requirements of EN 13480-3 (2017) code are met for this stress model. 
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The results shown above can also be printed to the printer or to a file using the option File > 
Print. 
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Pressure Design of Pipe and Pipe fittings 
 

249 

External Pressure Design of Pipe and Pipe Fittings 

External Pressure Design module will function ONLY when the stress layout is defined with 
negative pressure (such as vacuum pressure). 

This module first calculates collapse pressure (same as buckling pressure), which is a function 
of span length “L” between the stiffeners placed on the piping (shown in figures below). 
Since the collapse (buckling) mode of deformation for a pipe element between two adjacent 
stiffeners is restrained by these stiffeners, shorter the span length L between the stiffeners, 
higher the collapse (buckling) pressure.   

The External Pressure Design module assumes that a stiffener is located at each node of the 
CAEPIPE model.  Hence, ensure that nodes are defined in CAEPIPE model only at 
locations where the stiffeners are attached to the piping.  Even nodes where flanges or 
certain types of supports that restrain the collapse (buckling) mode of deformation should be 
included as “stiffener locations”. All other nodes at which the collapse (buckling) mode of 
deformation is not restrained (such as resting supports) should not be included in the 
CAEPIPE model for external pressure design calculations. In other words, the CAEPIPE 
stress model (that was developed for flexibility analysis) needs to be edited before 
performing the external pressure design. 

 

Single Pipe 

 

Pipe with bend 

 

Pipe with flange connections 
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Pipe with bend or elbow with ‘L’ measured on extrados 

 

Pipe with mitre with ‘L’ measured on extrados 

The procedure given below will help in retaining ONLY those nodes of the CAEPIPE stress 
model (originally developed for flexibility analysis) prior to External Pressure Design 
calculations. 

 Create a copy of the existing CAEPIPE stress model (developed for flexibility 
analysis). 

 At whichever node the collapse (buckling) mode of deformation is NOT restrained, 
navigate to that element node in the layout window and use the option “Combine…” 
through Layout window > Edit. This action will remove that node by combining the 
two adjacent elements. 

 Repeat the above step and remove all other nodes where the collapse (buckling) 
mode of deformation is NOT restrained, thereby retaining ONLY the stiffeners, 
flanges and supportsthat restrain the collapse (buckling) mode].  

 Upon completion, save the model. 

Snap shots shown below present a sample model developed to show the External Pressure 
Design calculations performed by CAEPIPE.  As stated above, a copy of the original stress 
model was made and the model has been edited to include only those nodes on pipe where 
stiffeners, flanges and supports (that are equivalent to stiffeners from the point of view of 
restraining collapse mode of deformation) are attached.  

Refer Section titled “External Pressure Design according to SS EN 13480-3” in CAEPIPE 
Code compliance manual for details on implementation. 
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Once the layout of the stress model as shown in the above snap shots is completed, the 
external pressure design is performed through Layout window > Misc > External Pressure 
Design: EN 13480-3. 

When executed, CAEPIPE automatically performs the external pressure design calculations 
for Pipes, Miters, Elbows, Bends and Reducers for the entire stress model and displays the 
results as shown below. 

It is observed that the ratio [Pr/(KPc)] is much higher than 1.0 throughout the stress model, 
confirming that the collapse (buckling) pressures Pr calculated for all segments of the stress 
model are much higher than the corresponding peak negative pressures specified in the 
CAEPIPE model. In other words, the potential for any segment of this piping system to 
collapse (buckle) is very minimal.   
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The results shown above can also be printed to the printer or to a file using the option File > 
Print. 
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Pumps, compressors and turbines in CAEPIPE, referred to as rotating equipment, are each 
governed by an industry publication — API (American Petroleum Institute) publishes an 
API 610 for Horizontal and Vertical inline pumps, ANSI/HI 9.6.2 for Rotodynamic pumps, 
and API 617 for compressors, while NEMA (National Electrical Manufacturers Association) 
publishes the NEMA SM-23 for turbines. These publications provide guidelines for 
evaluating nozzles connected to rotating equipment among other technical information 
including the items relevant to piping stress analysis – criteria for piping design and a table of 
allowable loads. 

Modeling the rotating equipment is straightforward since it is assumed rigid (relative to 
connected piping) and modeled only through its end points (connection nozzles). 

1. In your model, anchor all of the nozzles (on the equipment) that need to be included 
in the analysis. 

2. Specify these anchored nodes during the respective equipment definition via Misc. 
menu > Pumps/Compressors/Turbines in the Layout window. 

CAEPIPE does not require you to model all of the nozzles nor their connected piping. For 
example, you may model simply one inlet nozzle of a pump with its piping. Or, you may 
model one pump with both nozzles (with no connected piping) and impose external forces 
on them (if you have that data). Further, there is no need to connect the two anchors of the 
equipment with a rigid massless element like required in some archaic methods. A flange and 
an anchor may coexist. 

A pump is input by selecting “Pumps” from the Misc menu in the Layout or List window. 
CAEPIPE produces API 610 pump compliance report after analysis for 2 types of pumps, 
namely Horizontal and Vertical inline. Also, CAEPIPE generates ANSI /HI 9.6.2 
compliance report for four types of Rotodynamic pumps: Horizontal or Vertical inline or 
Axial split case or Vertical turbine short set pumps. See Section titled “Rotating Equipment 
Qualification” from the Code Compliance Manual for related information. 
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Once you see the Pump List window, double click on an empty row for the Pump dialog and 
enter the required information. 
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Type a short description to identify the pump in Description. You must designate the pump 
nozzles as anchors, and the shaft axis must be in the horizontal plane. The nozzle locations 
(top, side or end) should be specified for suction and discharge nodes. 

See section on specifying a Direction for information on X comp/Y comp/Z comp. 

For horizontal pumps, you must enter coordinates for the center of the pump with respect 
to global origin. For pumps with two support pedestals, API 610 defines the center by the 
“intersection of the pump shaft centerline and a vertical plane passing through the center of 
the two support pedestals.” For pumps with four support pedestals, the center is defined by 
the “intersection of the pump shaft centerline and a vertical plane passing midway between 
the four pedestals.” See Section titled “Rotating Equipment Qualification” of the Code 
Compliance Manual for illustrative figures. 

You might find it helpful to first model the nozzles as anchors. In some situations, you might 
not have the discharge or suction side piping. In that case, here is how you can fix the 
location of the other side. Look up the coordinates of the nozzle (anchor) you have already 
modeled. 

Then, use the coordinates command (menu Misc > Coordinates) to note the (X, Y, Z) 
coordinates of this pump nozzle node number. Using its coordinates, you can now arrive at 
the required coordinates of the other side’s nozzle and the center of the pump. 

Example – API 610 Pump Compliance 
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In the above image, suction side piping ends at node 380. Discharge piping starts at node 

500. In the Pump definition dialog (shown next), you can see that the center of the pump 

is just behind the suction nozzle (node 380) coordinates.  The reducer between nodes 370 

and 380 is a vertically offset eccentric reducer; hence the graphics at the reducer shows a 

break. 
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A simpler example is when you do have piping on both sides of the pump. Consider the 
network below consisting of two pipe segments connected by a pump. 

(suction side) 10-20-30-…-90-100→PUMP←200-210-…-280-290-300 (discharge side) 

The suction side of the pump ends at node 100. The discharge side begins at node 200. Make 
nodes 100 and 200 as anchors so that equipment loads can be calculated. A similar method 
applies to turbines and compressors too. 

A different dialog is shown for vertical inline pumps. Only Description, Suction and 
Discharge nodes are required. 
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API 610 Report 

Upon analysis, you will see CAEPIPE produce API 610 reports under “Rotating Equipment 
Reports” in Results. 

 

In addition to the input details, for a specific load case, the calculated forces and moments 
(on the nozzle and those at the center of the pump), API allowables, ratios (of calculated to 
allowable) and status for all of them are reported.  

When you see “Failed” entries in this report, you will need to examine the cause of the high 
force or moment for that line item. Generally, the high numbers come from the expansion 
load but may well come from the weight load. You must reduce these excessive forces and 
moments by making the system or intersections more flexible before this pump can become 
compliant.  

Note: If you have input multiple temperatures, corresponding reports for additional 
operating load cases are shown. Use the black right arrow key to see them. 
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Example – ANSI/HI 9.6.2 Pump Compliance 

 

In the above image, suction side piping ends at node 10. Discharge piping starts at node 

30. Pump size is 1.5 x 8 17 with Material Group ASTM A351/A351M – Grade CF8M. 

The temperature of the pump is set to 100
0
 F. 
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ANSI/HI 9.6.2 Report 

Upon analysis, you will see CAEPIPE produce ANSI/HI 9.6.2 reports under “Rotating 
Equipment Reports” in Results. 

 

In addition to the input details, for a specific load case, the calculated forces and moments, 
ANSI/HI 9.6.2 allowables, ratios (of calculated to allowable) and status for all of them are 
reported.  

When you see “Failed” entries in this report, you will need to examine the cause of the high 
force or moment for that line item. Generally, the high numbers come from the expansion 
load but may well come from the weight load. You must reduce these excessive forces and 
moments by making the system or intersections more flexible before this pump can become 
compliant.  

Note: If you have input multiple temperatures, corresponding reports for additional 
operating load cases are shown. Use the black right arrow key to see them.
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Use a reducer to join a larger pipe to a small pipe to meet fluid flow requirements. A reducer 
is Concentric when the axes at the reducer ends are collinear; Eccentric, when they are not. 
Use an eccentric reducer only when necessary to keep the top/bottom of the line level.  

In the figures shown below, observe that the two ends of the reducers are of different 
diameters. The larger end (at node 20) has the outside diameter and thickness as OD1 and 
Thickness 1 (Thk1) with the smaller end (at node 30) having OD2 and Thickness 2 (Thk2). 
In case of the eccentric reducer, the eccentricity as shown is between the two axes of the 

ends of the reducer. The cone angle, α, is also as shown in the following figure. 

 

An eccentric reducer’s eccentricity is modeled by a change in offsets of the “To” node (node 
30 in Figure (b) above). Eccentricity is (ID1–ID2) / 2. See example 2 later in this topic. 

A reducer (concentric or eccentric) is input by typing “re” in the Type column or selecting 
“Reducer” from the Element Types dialog. 
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The Reducer dialog is shown. 

 

OD1, OD2, Thk1, Thk2 

These are the cross-sectional properties at the two ends of the reducer. OD stands for 
outside diameter and Thk stands for thickness. By default, OD1 and Thk1 contain preceding 
section’soutside diameter and thickness, but different values may be typed here. The 
Section1 and Section2 buttons can be used to quickly input OD and Thk values from 
previously defined sections. 

Cone angle 

Shown in Figure (a) above, it is used to calculate SIF at the ends of the reducer for certain 
piping codes (B31.1, B31.9, ASME Section III Class 2, RCC-M, Swedish and Norwegian). 
For these codes, if the cone angle is left blank, the maximum value of the SIF (2.0) is used. 
For all other piping codes in CAEPIPE, the cone angle is not used. 

SIF Calculation 

For B31.1, B31.9, ASME Section III Class 2, EN 13480, RCC-M, Swedish and Norwegian, 
as mentioned above, the cone angle (if input) is used to calculate the SIF. If the cone angle is 
not input, the maximum value of the SIF (2.0) is used. 

For Swedish and Norwegian piping codes, additional input is required which affects the 
calculation of SIF. 

 

Knuckles 

If the reducer is with knuckles,check this box. 
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Delta 

If the reducer is without knuckles, specify delta, which is the mismatch (difference in mean 
radii across the weld at the smaller end of the reducer). If the reducer is with knuckles, delta 
is not used. 

For other codes, if the code is not specific about a reducer’s SIF, then a value of 1.0 is used. 

Weight, Stiffness and Stress Calculation 

The properties such as weight of the reducer, stiffness, contents weight and insulation weight 
are based on the average diameter (of OD1 and OD2) and average thickness (of Thk1 and 
Thk2). 

The stresses at each end, however, are calculated using the actual dimensions at each end. 

Example 1: Concentric Reducer 

To model a concentric reducer as shown in Figure (a) earlier in the topicwith the data: 

8”x4” reducer, OD1=8.625”, Thk1=0.322”, OD2=4.5”, Thk2=0.237”. 

Create two sections, 8”/STD and 4”/STD. 

 The first node (10) is already defined. Press Enter to move to the next row.  

 Complete pipe run till node 20: type 20 for Node, type 1 (ft.) for DX, enter material, 
8” section and load names, press Enter.  

 Input reducer: Type 30 for Node, press Tab to move to the Type field, type “Re” (to 
open the Reducer dialog box, note that by default CAEPIPE displays the preceding 
8” section’s properties for OD1 and Thk1).  

 

Press the “Section 2” button to select the section at “To” node. 
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Highlight the 4” section and press OK. 4.5” for OD2 and 0.237” for Thk2 will be entered in 
the Reducer dialog. 

 

Press OK, type 11” for DX (reducer’s length) and press Enter. Now you are asked if you 
want to change section, press Yes. “Select Section” dialog will be shown. Highlight the 4” 
section and press Enter. Press Enter again on Layout to move to the next row. 

Type 40 for Node, 1 (ft.) for DX, press Enter. 

 

 

 

Example 2: Eccentric Reducer 

To model an eccentric reducer (as shown in Figure (b) earlier in the topic) with the following 
data: 8”x6” reducer, OD1=8.625”, Thk1=0.322”, OD2=6.625”, Thk2=0.28”, eccentricity = 
(ID1–ID2) / 2 = 0.958” which is modeled as change in elevation. 

Create two sections, 8”/STD and 6”/STD. 
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 The first node (10) is already defined. Press Enter to move to the next row.  

 Complete pipe run till node 20: type 20 for Node, type 12” for DX, enter material, 8” 
section and load names, press Enter.  

 Input reducer: Type 30 for Node, press Tab to move to the Type field, type “Re” (to 
open the Reducer dialog box, note that the preceding 8” section properties are 
already displayed for OD1 and Thk1).  

 

Press the “Section 2” button to select the section at “To” node. 

 

Highlight the 6” section and press OK. 

6.625” for OD2 and 0.28” for Thk2 will be entered in the Reducer dialog. 

 

Press OK, type 11” for DX (reducer’s length along X axis), -0.958” for DY (this is the 
eccentricity), then press Enter. Now you are asked if you want to change section, press 
Yes. “Select Section” dialog will be shown. Highlight the 6” section and press Enter. Press 
Enter again on Layout to move to the next row. 

 Type 40 for Node, 12” for DX, press Enter. 
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The rendered graphics is shown below: 

 

Example 3: Jacketed Reducer 

A jacketed reducer may be modeled in the following manner: Calculate the averages of OD1 
and OD2, and of Thk1 and Thk2 for the two reducers, one for the core pipe and the other 
for the jacket pipe. Create two new pipe sections with these averages as OD and Thickness. 
Insert two pipes at the location of that jacketed reducer, one for the core pipe and the other 
for the jacket pipe, having the corresponding section with average OD and thickness.  You 
may have to input SIF at the two ends of each reducer using code guidelines for a reducer. 

Alternate Method:  In a jacketed piping system, e.g., 10-20 is a JPIPE, model the reducer for 
the core pipe next as you would normally do in a non-jacketed system, i.e., 20-30 is the core 
pipe reducer, followed by a JPIPE between 30-40. Then, connect the jacket nodes 20J and 
30J with a jacket reducer (shown below) or a JPIPE (jacket pipe). In other words, on new 
rows, connect 20J to 30J with the jacket reducer or a JPIPE with average OD and thickness 
as calculated above. 
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Refinement of Nodal Mesh based on Mass Modeling Frequency 

The purpose of this feature is to ensure that there are a sufficient number of mass points for 
an accurate dynamic model for the dynamic loading under consideration. 
Intermediate mass points along a span are generated based on the free vibration of an 
equivalent simply supported beam. Optimum element length is calculated from: 

𝐿𝑜𝑝𝑡 =
1

2
√

𝜋

2. 𝑓
.  4√

𝐸. 𝐼. 𝑔

𝑤
 

Lopt = Optimum length required to capture the span dynamic behavior 
f = mass modeling frequency 
g = acceleration due to gravity 
E = modulus of elasticity of pipe material  
Although the above equation is valid for any temperature, to generate intermediate nodes, E 
is taken at the reference temperature entered in CAEPIPE. 
I = moment of inertia of pipe cross section 
w = weight per unit length of pipe (including insulation, lining and content) 
Intermediate mass points can be automatically generated in CAEPIPE by selecting the radio 
button “Dynamic Analysis” through Layout window > Edit > Refine Nodal Mesh. Enter the 
Mass modeling Frequency in the dialog box shown and press the button “OK”. See figures 
shown below for details. 
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While refining the Nodal Mesh, the new node numbers will be generated by adding the node 
increment specified through Layout window > Options > Node increment to get the new 
node numbers (without affecting the original node numbers used in the Layout window). 
Hence, set the node increment value as required before refining the Nodal Mesh. 
Upon refining the Nodal Mesh based on Mass modeling frequency, CAEPIPE will prompt 
for renumbering of nodes as shown below.  

  

Press the button “Yes” to renumber the nodes and enter the details required by CAEPIPE in 
the dialog box. See snap shot shown above.
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Example 

A sample CAEPIPE model (with graphics and layout details as shown below) was chosen for 
verification of implementation. Modal analysis was then performed by defining the cut-off 
frequency and number of modes as “110 Hz” and 175 respectively in the CAEPIPE model 
through Layout window > Options > Analysis > Dynamics with the node points as defined 
by the stress analyst. 

 

Wireframe layout without addition of mass points 

 

Rendered layout without addition of mass points 
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   ----------------------------------------------------------------------------------- 

                                          Options 

   ----------------------------------------------------------------------------------- 

     Piping code = B31.3 (2016) 

     Do not use liberal allowable stresses 

     Include axial force in stress calculations 

     Reference temperature = 40 (F) 

     Number of thermal cycles = 7000 

     Number of thermal loads = 1 

     Thermal = Operating - Sustained 

     Use modulus at reference temperature 

     Include hanger stiffness 

     Include Bourdon effect 

     Use pressure correction for bends 

     Pressure stress = PD / 4t 

     Peak pressure factor = 1.00 

     Cut off frequency = 110 Hz 

     Number of modes = 175 

     Include missing mass correction 

     Use friction in dynamic analysis 

     Vertical direction = Y 

   ----------------------------------------------------------------------------------- 

    #  Node  Type   DX(ft'in") DY(ft'in") DZ(ft'in")  Mat   Sec   Load   Data 

   ----------------------------------------------------------------------------------- 

    1 Title = 

    2    10 From                                                         Anchor 

    3    20 Bend                           11'0"      API   54I   54I 

    4    30                     -20'0"                API   54I   54I 

    5    40 Bend                -10'9"                API   54I   54I 

    6    50                                9'0"       API   54I   54I    Y restraint 

    7    60                                2'0"       API   54O   54O 

    8    65                                10'0"      API   54O   54O 

    9    70                                12'0"      API   54O   54O    Y restraint 

   10    75                                12'0"      API   54O   54O 

   11    80                                12'0"      API   54O   54O    Y restraint 

   12    85                                12'0"      API   54O   54O 

   13    90                                12'0"      API   54O   54O    Y restraint 

   14   100                                11'0"      API   54O   54O 

   15   110                                3'0"       API   54O   54O    Anchor 

   16   120                                3'0"       API   54O   54O 

   17   130 Reducer                        3'0"       API   54O   54O 

   18   140 Bend                           3'8"       API   36I   36I 

   19   150 Bend     2'11"      -4'6"      4'6"       API   36I   36I 

   20   160                                6'0"       API   36I   36I    Y restraint 

   21   165                                7'0"       API   36I   36I 

   22   170                                7'0"       API   36I   36I    Y restraint 

   23   180 Bend                           6'0"       API   36I   36I 

   24   190          7'3"                             API   36I   36I    Y restraint 

   25   200          12'0"                            API   36I   36I    Y restraint 

   26   210          12'0"                            API   36I   36I 

   27   220          12'0"                            API   36I   36I    Y restraint 

   28   230 Bend     4'5"                             API   36I   36I 

   29   240                                4'5"       API   36I   36I    Y restraint 

   30   250                                12'0"      API   36I   36I 

   31   260                                12'0"      API   36I   36I    Y restraint 

   32   270                                12'0"      API   36I   36I 

   33   280                                12'0"      API   36I   36I    XY restraint 
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   ----------------------------------------------------------------------------------- 

    #  Node  Type   DX(ft'in") DY(ft'in") DZ(ft'in")  Mat   Sec   Load   Data 

   ----------------------------------------------------------------------------------- 

   34   290                                12'0"      API   36I   36I 

   35   300                                12'0"      API   36I   36I    Y restraint 

   36   310                                12'0"      API   36I   36I 

   37   320                                12'0"      API   36I   36I    Y restraint 

   38   330                                16'0"      API   36I   36I    XY restraint 

   39   340                                12'0"      API   36I   36I 

   40   350                                12'0"      API   36I   36I    Y restraint 

   41   360                                12'0"      API   36I   36I 

   42   370                                12'0"      API   36I   36I    Y restraint 

   43   380                                12'0"      API   36I   36I 

   44   390                                12'0"      API   36I   36I    XY restraint 

   45   400                                12'0"      API   36I   36I 

   46   410                                12'0"      API   36I   36I    Y restraint 

   47   420                                12'0"      API   36I   36I 

   48   430                                12'0"      API   36I   36I    Y restraint 

   49   440                                12'0"      API   36I   36I 

   50   450                                12'0"      API   36I   36I    XY restraint 

   51   460                                12'0"      API   36I   36I 

   52   470                                12'0"      API   36I   36I    Y restraint 

   53   480                                12'0"      API   36I   36I 

   54   490                                12'0"      API   36I   36I    Y restraint 

   55   500                                12'0"      API   36I   36I 

   56   510                                12'0"      API   36I   36I    Anchor 

   57   520                                12'0"      API   36I   36I 

   58   530                                12'0"      API   36I   36I    Y restraint 

   59   540                                12'0"      API   36I   36I 

   60   550                                12'0"      API   36I   36I    Y restraint 

   61   560 Bend                           4'5"       API   36I   36I 

   62   570          -4'5"                            API   36I   36I    Y restraint 

   63   580          -12'0"                           API   36I   36I 

   64   590          -11'7"                           API   36I   36I    Y restraint 

   65   600          -12'0"                           API   36I   36I 

   66   610          -12'0"                           API   36I   36I    XY restraint 

   67   620          -12'0"                           API   36I   36I 

   68   630          -12'0"                           API   36I   36I    Anchor 

   69   640          -12'0"                           API   36I   36I 

   70   650          -12'0"                           API   36I   36I    XY restraint 

   71   660          -12'0"                           API   36I   36I 

   72   670          -10'0"                           API   36I   36I    Y restraint 

   73   680          -13'0"                           API   36I   36I    Y restraint 

   74   690 Bend     -9'0"                            API   36I   36I 

   75   700                                7'11"      API   36I   36I    Y restraint 

   76   710                                12'0"      API   36I   36I    Anchor 

   77   100 From 

   78   720 Bend                10'9"                 API   36O   36O 

   79   730                                7'0"       API   36O   36O    Y restraint 

   80   740 Bend                           9'0"       API   36O   36O 

   81   750                     16'9"                 API   36O   36O 

   82   760                     26'11"                API   36O   36O 

   83   770 Bend                5'8"                  API   36O   36O 

   84   780                                6'0"       API   36O   36O    Y restraint 

   85   790                                12'0"      API   36O   36O    Anchor 

   ----------------------------------------------------------------------------------- 
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                                          Anchors 

   ----------------------------------------------------------------------------------- 

                    (lb/inch)                 (in-lb/deg)         Releases   Anchor 

     Node  KX/kx    KY/ky    KZ/kz    KXX/kxx  KYY/kyy  KZZ/kzz X Y Z XXYYZZ In Pipe 

   ----------------------------------------------------------------------------------- 

     10    Rigid    Rigid    Rigid    Rigid    Rigid    Rigid                 GCS 

     110   Rigid    Rigid    Rigid    Rigid    Rigid    Rigid                 GCS 

     510   Rigid    Rigid    Rigid    Rigid    Rigid    Rigid                 GCS 

     630   Rigid    Rigid    Rigid    Rigid    Rigid    Rigid                 GCS 

     710   Rigid    Rigid    Rigid    Rigid    Rigid    Rigid                 GCS 

     790   Rigid    Rigid    Rigid    Rigid    Rigid    Rigid                 GCS 

   ----------------------------------------------------------------------------------- 

                                           Bends 

   ----------------------------------------------------------------------------------- 

     Bend   Radius   Thickness  Bend  Flex.   Int.  Angle  Int.  Angle 

     Node   (inch)    (inch)    Matl  Factor  Node  (deg)  Node  (deg) 

   ----------------------------------------------------------------------------------- 

     20     81     L 

     40     81     L 

     140    54     L 

     150    54     L 

     180    54     L 

     230    48     U 

     560    48     U 

     690    48     U 

     720    54     L 

     740    54     L 

     770    54     L 

   ----------------------------------------------------------------------------------- 

                                         Reducers 

   ----------------------------------------------------------------------------------- 

                     OD1      Thk1      OD2      Thk2  Cone Angle Knuc Delta 

     From    To    (inch)    (inch)   (inch)    (inch)   (deg)    kles (inch) 

   ----------------------------------------------------------------------------------- 

     120    130    54        0.375    36        0.375 

   ----------------------------------------------------------------------------------- 

                                        Restraints 

   ----------------------------------------------------------------------------------- 

     Node     X     Y     Z 

   ----------------------------------------------------------------------------------- 

     50            Yes 

     70            Yes 

     80            Yes 

     90            Yes 

     160           Yes 

     170           Yes 

     190           Yes 

     200           Yes 

     220           Yes 

     240           Yes 

     260           Yes 

     280     Yes   Yes 

     300           Yes 

     320           Yes 

     330     Yes   Yes 

     350           Yes 
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   ----------------------------------------------------------------------------------- 

                                        Restraints 

   ----------------------------------------------------------------------------------- 

     Node     X     Y     Z 

   ----------------------------------------------------------------------------------- 

     370           Yes 

     390     Yes   Yes 

     410           Yes 

     430           Yes 

     450     Yes   Yes 

     470           Yes 

     490           Yes 

     530           Yes 

     550           Yes 

     570           Yes 

     590           Yes 

     610     Yes   Yes 

     650     Yes   Yes 

     670           Yes 

     680           Yes 

     700           Yes 

     730           Yes 

     780           Yes 

   ----------------------------------------------------------------------------------- 

                        Pipe material API: API  5L Grade B 

   ----------------------------------------------------------------------------------- 

     Density = 0.283 (lb/in3),  Nu = 0.300,  Joint factor = 1.00, Type = CS 

     Yield strength =   35000 (psi) 

 

       Temp       E         Alpha     Allowable 

       (F)      (psi)     (in/in/F)     (psi) 

     ------------------------------------------- 

      -325     31.4E+6     5.00E-6      20000 

      -200     30.8E+6     5.35E-6      20000 

      -100     30.2E+6     5.65E-6      20000 

        70     29.5E+6     6.07E-6      20000 

       200     28.8E+6     6.38E-6      20000 

       300     28.3E+6     6.60E-6      20000 

       400     27.7E+6     6.82E-6      19900 

       500     27.3E+6     7.02E-6      19000 

       600     26.7E+6     7.23E-6      17900 

       650     26.1E+6     7.33E-6      17300 

       700     25.5E+6     7.44E-6      16700 

       750     24.8E+6     7.54E-6      13900 

       800     24.2E+6     7.65E-6      11400 

       850     23.3E+6     7.75E-6       8700 

       900     22.4E+6     7.84E-6       5900 

       950     21.4E+6     7.91E-6       4000 

      1000     20.4E+6     7.97E-6       2500 

      1050     19.2E+6     8.05E-6       1600 

      1100     18.0E+6     8.12E-6       1000 

   ----------------------------------------------------------------------------------- 
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   ----------------------------------------------------------------------------------- 

                                   Pipe Sections 

   ----------------------------------------------------------------------------------- 

         Nominal      O.D.   Thk   Cor.Al M.Tol Ins.Dens Ins.Th Lin.Dens Lin.Th 

   Name   Dia.   Sch (inch) (inch) (inch)  (%)  (lb/ft3) (inch) (lb/ft3) (inch) 

   ----------------------------------------------------------------------------------- 

   36I   36"     STD 36      0.375  0      0.0 

   36O   36"     STD 36      0.375  0      0.0 

   54O   Non Std     54      0.375  0      0.0 

   54I   Non Std     54      0.375  0      0.0 

   ----------------------------------------------------------------------------------- 

                                       Loads 

   ----------------------------------------------------------------------------------- 

 

     Static seismic load:  X = -0.20, Y = -0.20, Z = -0.20 (g's) 

     Acceleration load combination = Square Root of Sum of Squares 

 

     X spectrum: Malta, NY_b       Factor = 1.0000 

     Y spectrum: Malta, NY_b       Factor = 0.0430 

     Z spectrum: Malta, NY_b       Factor = 1.0000 

 

     Mode sum = SRSS               Direction sum = SRSS 

 

   ----------------------------------------------------------------------------------- 

                                    Wind Load 1 

   ----------------------------------------------------------------------------------- 

     Shape factor  = 0.60 

     Wind direction: X comp = 0.000, Y comp = 0.000, Z comp = 1.000 

 

     Elevation  Pressure 

      (feet)     (psf) 

       0          15 

       15         15 

       30         15 

       45         15 

       60         15 

   ----------------------------------------------------------------------------------- 

                                    Pipe Loads 

   ----------------------------------------------------------------------------------- 

     Load    T1    P1       T2    P2       T3    P3   Specific  Add.Wgt  Wind 

     Name   (F)  (psi)     (F)  (psi)     (F)  (psi)   gravity  (lb/ft)  Load 

   ----------------------------------------------------------------------------------- 

     36O    100   125                                                     Y 

     36I    100   125 

     54O    100   125                                                     Y 

     54I    100   125 

   ----------------------------------------------------------------------------------- 

From the Modal Analysis results shown below, it was noted that the CAEPIPE was able to 

extract 92 modes with highest frequency being 95.967 Hz. 
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   ----------------------------------------------------------------------------------- 

         Frequency  Period    Participation factors    Modal mass / Total mass 

    Mode    (Hz)     (sec)     X        Y        Z        X       Y       Z 

   ----------------------------------------------------------------------------------- 

     1      1.875   0.5335  -5.7615  -0.0004   0.5255   0.0979  0.0000  0.0008 

     2      3.288   0.3041  -6.7721  -0.0000   0.0003   0.1353  0.0000  0.0000 

     3      5.971   0.1675  -4.1919   0.0000  -0.0001   0.0518  0.0000  0.0000 

     4      6.147   0.1627   0.0909  -0.0000  -0.1021   0.0000  0.0000  0.0000 

     5      7.800   0.1282  -0.4240  -0.0000   4.5032   0.0005  0.0000  0.0598 

     6      8.102   0.1234   0.0029   0.0001   0.3321   0.0000  0.0000  0.0003 

     7      9.933   0.1007   0.0861  -0.0000  -4.2655   0.0000  0.0000  0.0537 

     8     10.146   0.0986  -0.6501   0.0002   1.6688   0.0012  0.0000  0.0082 

     9     10.241   0.0976  -2.1689  -0.0000   0.0048   0.0139  0.0000  0.0000 

     10    11.279   0.0887   3.2684  -0.0002  -7.9718   0.0315  0.0000  0.1874 

     11    11.628   0.0860   6.7199  -0.0002   5.8034   0.1332  0.0000  0.0993 

     12    13.116   0.0762  -0.0013   1.4576  -3.8221   0.0000  0.0063  0.0431 

     13    13.276   0.0753   2.6364   0.0000  -0.0001   0.0205  0.0000  0.0000 

     14    13.931   0.0718   3.3527   0.0030  -3.2879   0.0332  0.0000  0.0319 

     15    16.027   0.0624  -3.6866   0.0000  -0.3181   0.0401  0.0000  0.0003 

     16    16.038   0.0624  -2.9281  -0.0001  -0.7810   0.0253  0.0000  0.0018 

     17    17.802   0.0562  -1.8832   0.0179   2.3004   0.0105  0.0000  0.0156 

     18    21.780   0.0459   0.0000   2.7930   3.3879   0.0000  0.0230  0.0339 

     19    22.412   0.0446  -0.0006  -3.2159  -1.3274   0.0000  0.0305  0.0052 

     20    22.683   0.0441  -0.3117  -0.0005   0.0747   0.0003  0.0000  0.0000 

     21    24.003   0.0417  -0.5955  -0.0000   0.1696   0.0010  0.0000  0.0001 

     22    24.910   0.0401   2.7763  -0.0000  -0.0070   0.0227  0.0000  0.0000 

     23    26.421   0.0378  -0.2314   0.0001   0.1348   0.0002  0.0000  0.0001 

     24    27.698   0.0361  -1.3316   0.0000  -0.0002   0.0052  0.0000  0.0000 

     25    29.713   0.0337  -1.2585  -0.0000  -0.0049   0.0047  0.0000  0.0000 

     26    30.079   0.0332  -0.3437   0.0000  -0.1955   0.0003  0.0000  0.0001 

     27    30.146   0.0332   0.0215  -0.0001   0.3494   0.0000  0.0000  0.0004 

     28    31.946   0.0313  -0.6062   0.0012  -1.6290   0.0011  0.0000  0.0078 

     29    33.670   0.0297   0.9928  -0.0040   2.8297   0.0029  0.0000  0.0236 

     30    36.072   0.0277   0.0014   1.4997  -2.1277   0.0000  0.0066  0.0134 

     31    37.812   0.0264  -0.4989  -0.0074   2.1572   0.0007  0.0000  0.0137 

     32    39.097   0.0256   1.2371  -0.0000  -0.0086   0.0045  0.0000  0.0000 

     33    41.172   0.0243  -0.0001   1.2001  -6.2487   0.0000  0.0042  0.1152 

     34    41.250   0.0242  -0.3414  -0.0000   1.6185   0.0003  0.0000  0.0077 

     35    42.488   0.0235   0.7544  -0.0001  -0.0047   0.0017  0.0000  0.0000 

     36    43.804   0.0228  -0.4830   0.0108   1.2389   0.0007  0.0000  0.0045 

     37    46.065   0.0217  -0.0011   0.0686  -0.0001   0.0000  0.0000  0.0000 

     38    46.766   0.0214  -0.0098  -0.5622  -0.0023   0.0000  0.0009  0.0000 

     39    47.504   0.0211  -0.2337  -0.0029  -0.2475   0.0002  0.0000  0.0002 

     40    49.063   0.0204   0.0015   0.3511   0.0007   0.0000  0.0004  0.0000 

     41    49.295   0.0203  -0.0000  -1.0018  -0.0000   0.0000  0.0030  0.0000 

     42    49.985   0.0200   1.3732  -0.0000  -1.3809   0.0056  0.0000  0.0056 

     43    50.052   0.0200  -0.1938   0.0000  -1.9635   0.0001  0.0000  0.0114 

     44    52.178   0.0192  -0.9811  -0.0281  -0.6345   0.0028  0.0000  0.0012 

     45    52.335   0.0191   0.0000  -0.8918  -0.0000   0.0000  0.0023  0.0000 

     46    53.313   0.0188  -0.0715  -1.0283  -0.1169   0.0000  0.0031  0.0000 

     47    53.496   0.0187  -1.0974  -0.0751  -1.8548   0.0036  0.0000  0.0101 

     48    54.481   0.0184   0.0407  -1.8917   0.0845   0.0000  0.0106  0.0000 

     49    56.408   0.0177   0.4159  -1.3502   0.0358   0.0005  0.0054  0.0000 

     50    56.457   0.0177   2.6140   0.2176  -0.1253   0.0202  0.0001  0.0000 

     51    56.920   0.0176   1.8036   0.0012   0.0177   0.0096  0.0000  0.0000 

     52    57.929   0.0173  -0.2764  -0.0033  -0.0311   0.0002  0.0000  0.0000 

     53    58.372   0.0171  -1.1204   0.0366   0.3623   0.0037  0.0000  0.0004 
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         Frequency  Period    Participation factors    Modal mass / Total mass 

    Mode    (Hz)     (sec)     X        Y        Z        X       Y       Z 

   ----------------------------------------------------------------------------------- 

     54    58.736   0.0170   0.0013  -0.4068   0.0005   0.0000  0.0005  0.0000 

     55    62.338   0.0160  -0.0004   1.7473   2.3502   0.0000  0.0090  0.0163 

     56    63.166   0.0158   1.4680   0.0042   1.3132   0.0064  0.0000  0.0051 

     57    63.180   0.0158   1.1531   0.0001  -1.1840   0.0039  0.0000  0.0041 

     58    63.512   0.0157   0.0000  -0.1612   0.0000   0.0000  0.0001  0.0000 

     59    64.003   0.0156  -0.0020  -0.5988   0.0007   0.0000  0.0011  0.0000 

     60    64.339   0.0155  -0.0000  -1.1254   0.0000   0.0000  0.0037  0.0000 

     61    65.107   0.0154  -1.0551  -0.0210   1.1888   0.0033  0.0000  0.0042 

     62    65.192   0.0153   0.0016   0.3043   0.5961   0.0000  0.0003  0.0010 

     63    65.893   0.0152  -0.0078  -0.0572   0.0105   0.0000  0.0000  0.0000 

     64    69.245   0.0144  -0.0005  -0.9214   0.0006   0.0000  0.0025  0.0000 

     65    70.044   0.0143  -2.3140  -0.0000  -1.0324   0.0158  0.0000  0.0031 

     66    70.911   0.0141  -3.2315  -0.0000  -1.9392   0.0308  0.0000  0.0111 

     67    73.355   0.0136  -0.9182   0.2454   0.2391   0.0025  0.0002  0.0002 

     68    73.445   0.0136  -0.0085   1.5999   0.0018   0.0000  0.0075  0.0000 

     69    74.015   0.0135   0.0021   1.9142   0.0703   0.0000  0.0108  0.0000 

     70    74.156   0.0135  -0.0000   2.9214  -0.0000   0.0000  0.0252  0.0000 

     71    74.905   0.0134   0.0017  -3.8949   0.0017   0.0000  0.0447  0.0000 

     72    76.249   0.0131  -0.1108   0.0489   0.0287   0.0000  0.0000  0.0000 

     73    76.553   0.0131   0.0001   1.4453   0.0002   0.0000  0.0062  0.0000 

     74    76.599   0.0131   0.0000   3.2442   0.0000   0.0000  0.0310  0.0000 

     75    78.151   0.0128  -0.0001  -5.7802  -0.0001   0.0000  0.0985  0.0000 

     76    78.399   0.0128   0.1428  -1.8259   0.2005   0.0001  0.0098  0.0001 

     77    79.572   0.0126  -0.0000  -3.1388  -0.0000   0.0000  0.0291  0.0000 

     78    80.352   0.0124  -0.0611  -0.0303   0.0321   0.0000  0.0000  0.0000 

     79    80.590   0.0124  -0.4718   0.0055  -0.0030   0.0007  0.0000  0.0000 

     80    81.366   0.0123   0.0014  -1.7246   1.7171   0.0000  0.0088  0.0087 

     81    81.537   0.0123  -0.6787   0.0000   2.6001   0.0014  0.0000  0.0199 

     82    83.538   0.0120   2.6049  -0.0000   0.2580   0.0200  0.0000  0.0002 

     83    83.555   0.0120   0.0186   0.0064  -0.0224   0.0000  0.0000  0.0000 

     84    85.143   0.0117  -0.9456   0.0093  -0.0136   0.0026  0.0000  0.0000 

     85    86.260   0.0116  -0.0033  -0.7082   1.6260   0.0000  0.0015  0.0078 

     86    86.553   0.0116   0.1187  -0.0708   1.3196   0.0000  0.0000  0.0051 

     87    87.389   0.0114  -0.0038  -0.2207  -0.7108   0.0000  0.0001  0.0015 

     88    87.678   0.0114   1.8995  -0.0000  -1.1843   0.0106  0.0000  0.0041 

     89    90.219   0.0111  -0.3088  -0.2777  -0.2039   0.0003  0.0002  0.0001 

     90    93.121   0.0107  -0.5735  -0.1326   0.4279   0.0010  0.0001  0.0005 

     91    95.224   0.0105   0.0000   4.5908   0.5409   0.0000  0.0622  0.0009 

     92    95.967   0.0104   0.7252  -0.0000  -0.6981   0.0016  0.0000  0.0014 

                                               ------------------------------- 

                                                Total   0.7887  0.4496  0.8526 

   ---------------------------------------------------------------------------------- 

Now, the original model shown above was refined through the feature Layout window > 
Edit > Refine Nodal Mesh. The Mass modeling frequency was set to 110 Hz for refining the 
mesh for “Dynamic Analysis” as shown below. 

 

The resulting refined model with additional mass points added by CAEPIPE is shown in the 
snap shots below. 
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Modal analysis was then performed using CAEPIPE for the refined model (with additional 
mass points automatically added) for mass modeling frequency 110 Hz and found that the 
CAEPIPE was able to extract all the modes below the cut-off frequency 110 Hz specified in 
the analysis options. Please see the modal analysis results obtained from CAEPIPE shown 
below. 
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   ----------------------------------------------------------------------------------- 

         Frequency  Period    Participation factors    Modal mass / Total mass 

    Mode    (Hz)     (sec)     X        Y        Z        X       Y       Z 

   ----------------------------------------------------------------------------------- 

     1      1.755   0.5698  -5.7696  -0.0003   0.5155   0.0982  0.0000  0.0008 

     2      2.855   0.3502   6.7662   0.0000  -0.0002   0.1350  0.0000  0.0000 

     3      5.521   0.1811  -4.1344   0.0000  -0.0001   0.0504  0.0000  0.0000 

     4      6.151   0.1626   0.0878  -0.0000  -0.1088   0.0000  0.0000  0.0000 

     5      7.722   0.1295   0.4309   0.0000  -4.5502   0.0005  0.0000  0.0611 

     6      8.119   0.1232   0.0315   0.0001   0.3840   0.0000  0.0000  0.0004 

     7      9.824   0.1018   0.0839  -0.0000  -4.3165   0.0000  0.0000  0.0550 

     8     10.063   0.0994   2.3014   0.0000   0.0054   0.0156  0.0000  0.0000 

     9     10.134   0.0987  -0.6185   0.0003   2.3174   0.0011  0.0000  0.0158 

     10    11.111   0.0900   2.0288   0.0003  -8.3004   0.0121  0.0000  0.2032 

     11    11.613   0.0861  -7.1492   0.0006  -4.4135   0.1508  0.0000  0.0575 

     12    12.635   0.0791  -0.0006   1.5513  -3.8503   0.0000  0.0071  0.0437 

     13    13.233   0.0756   2.6877   0.0000  -0.0007   0.0213  0.0000  0.0000 

     14    13.640   0.0733   2.9690   0.0034  -4.0182   0.0260  0.0000  0.0476 

     15    15.725   0.0636   3.7891  -0.0000   0.3498   0.0423  0.0000  0.0004 

     16    15.805   0.0633   3.1354   0.0024   0.9356   0.0290  0.0000  0.0026 

     17    16.409   0.0609   2.2658  -0.0169  -2.5046   0.0151  0.0000  0.0185 

     18    17.349   0.0576  -0.0000  -2.7191  -3.1311   0.0000  0.0218  0.0289 

     19    20.661   0.0484   0.0007   3.2479   1.4079   0.0000  0.0311  0.0058 

     20    22.737   0.0440   0.2479   0.0001  -0.0877   0.0002  0.0000  0.0000 

     21    23.733   0.0421   0.7055  -0.0000  -0.0963   0.0015  0.0000  0.0000 

     22    23.782   0.0420  -2.9878   0.0000   0.0053   0.0263  0.0000  0.0000 

     23    26.507   0.0377   0.1027   0.0005  -0.1910   0.0000  0.0000  0.0001 

     24    27.187   0.0368  -0.6336   0.0000  -0.0045   0.0012  0.0000  0.0000 

     25    29.021   0.0345  -1.1191   0.0000   0.0002   0.0037  0.0000  0.0000 

     26    29.061   0.0344   0.3323  -0.0000   0.1679   0.0003  0.0000  0.0001 

     27    30.289   0.0330  -0.4261   0.0036  -1.0079   0.0005  0.0000  0.0030 

     28    31.215   0.0320   1.0457  -0.0087   2.3123   0.0032  0.0000  0.0158 

     29    33.583   0.0298   0.4478  -0.0064   1.5750   0.0006  0.0000  0.0073 

     30    36.362   0.0275  -1.1690   0.0000  -0.0052   0.0040  0.0000  0.0000 

     31    37.505   0.0267  -0.0033   1.4151  -2.1430   0.0000  0.0059  0.0135 

     32    37.885   0.0264   0.4183   0.0121  -2.4989   0.0005  0.0000  0.0184 

     33    40.194   0.0249   0.1951  -0.0000  -1.5005   0.0001  0.0000  0.0066 

     34    40.968   0.0244   0.0001  -1.1979   6.4128   0.0000  0.0042  0.1213 

     35    43.038   0.0232   0.3511  -0.0019  -1.2983   0.0004  0.0000  0.0050 

     36    43.372   0.0231  -0.4795   0.0000  -0.0105   0.0007  0.0000  0.0000 

     37    46.870   0.0213   0.0021  -0.0008   0.0010   0.0000  0.0000  0.0000 

     38    47.541   0.0210  -0.0144  -0.7462  -0.0080   0.0000  0.0016  0.0000 

     39    48.377   0.0207  -0.2963  -0.0021  -0.3487   0.0003  0.0000  0.0004 

     40    50.010   0.0200  -0.4830   0.0001  -1.8955   0.0007  0.0000  0.0106 

     41    50.132   0.0199  -0.0043  -0.3850  -0.0040   0.0000  0.0004  0.0000 

     42    50.285   0.0199   0.0000   1.2526   0.0000   0.0000  0.0046  0.0000 

     43    51.219   0.0195   1.2828   0.0000  -1.6462   0.0049  0.0000  0.0080 

     44    51.778   0.0193   1.4654   0.0565   1.8643   0.0063  0.0000  0.0103 

     45    53.561   0.0187   0.0000  -1.1367  -0.0000   0.0000  0.0038  0.0000 

     46    53.672   0.0186  -0.1396   0.0329   0.4238   0.0001  0.0000  0.0005 

     47    54.731   0.0183   0.0027  -1.2178   0.0180   0.0000  0.0044  0.0000 

     48    56.221   0.0178  -0.0024  -2.0037   0.0429   0.0000  0.0118  0.0000 

     49    57.051   0.0175  -1.6501  -0.0050  -0.0543   0.0080  0.0000  0.0000 

     50    57.365   0.0174  -0.2648  -0.0208   0.4221   0.0002  0.0000  0.0005 

     51    58.161   0.0172  -0.0620  -1.7053   0.0076   0.0000  0.0086  0.0000 

     52    58.480   0.0171  -2.8218   0.0672   0.2197   0.0235  0.0000  0.0001 

     53    59.590   0.0168   0.0011  -1.6797  -2.3900   0.0000  0.0083  0.0168 
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   ----------------------------------------------------------------------------------- 

         Frequency  Period    Participation factors    Modal mass / Total mass 

    Mode    (Hz)     (sec)     X        Y        Z        X       Y       Z 

   ----------------------------------------------------------------------------------- 

     54    59.697   0.0168   1.3631  -0.0003  -0.0002   0.0055  0.0000  0.0000 

     55    60.969   0.0164  -0.0001   1.4746   0.5326   0.0000  0.0064  0.0008 

     56    61.166   0.0163  -0.0003   0.3240  -0.0009   0.0000  0.0003  0.0000 

     57    63.791   0.0157   1.1014  -0.0167   1.6815   0.0036  0.0000  0.0083 

     58    65.476   0.0153   0.0000  -0.0239  -0.0000   0.0000  0.0000  0.0000 

     59    66.097   0.0151  -2.0302  -0.0513   0.5933   0.0122  0.0000  0.0010 

     60    66.996   0.0149   0.6629   0.0000  -1.1896   0.0013  0.0000  0.0042 

     61    67.413   0.0148   0.0051  -0.4949  -0.0031   0.0000  0.0007  0.0000 

     62    67.702   0.0148   0.0000  -1.4164  -0.0000   0.0000  0.0059  0.0000 

     63    69.973   0.0143  -0.0065  -0.2969   0.0052   0.0000  0.0003  0.0000 

     64    70.117   0.0143   0.0002  -2.2385   0.7487   0.0000  0.0148  0.0017 

     65    70.175   0.0143  -2.4152  -0.0000  -0.9261   0.0172  0.0000  0.0025 

     66    74.234   0.0135   3.4185   0.0003   1.5639   0.0345  0.0000  0.0072 

     67    74.560   0.0134   0.0042   1.0701  -0.0017   0.0000  0.0034  0.0000 

     68    74.843   0.0134  -1.3329   0.8236   0.1534   0.0052  0.0020  0.0001 

     69    76.927   0.0130  -0.4107  -1.5744   0.2386   0.0005  0.0073  0.0002 

     70    78.576   0.0127  -0.1023   0.0017  -0.0013   0.0000  0.0000  0.0000 

     71    80.082   0.0125   0.0006  -0.5746   1.6438   0.0000  0.0010  0.0080 

     72    80.485   0.0124   0.0002  -2.1498   0.0002   0.0000  0.0136  0.0000 

     73    81.701   0.0122  -0.2466  -0.0537   0.0757   0.0002  0.0000  0.0000 

     74    81.749   0.0122  -0.0002   3.4973   0.0000   0.0000  0.0361  0.0000 

     75    82.787   0.0121  -0.0004   4.3124  -0.0023   0.0000  0.0549  0.0000 

     76    84.316   0.0119   1.6969   0.0000  -3.1197   0.0085  0.0000  0.0287 

     77    85.065   0.0118  -0.0026  -0.4712   0.8256   0.0000  0.0007  0.0020 

     78    85.440   0.0117   0.0000   3.7852  -0.0000   0.0000  0.0423  0.0000 

     79    85.507   0.0117  -0.0001   1.4996   0.0009   0.0000  0.0066  0.0000 

     80    87.100   0.0115  -0.0680   0.0853  -1.2077   0.0000  0.0000  0.0043 

     81    87.358   0.0114  -0.0000   3.5186  -0.0000   0.0000  0.0365  0.0000 

     82    87.548   0.0114   1.1884  -0.0035  -0.0409   0.0042  0.0000  0.0000 

     83    87.820   0.0114   0.1975  -0.0174   0.6688   0.0001  0.0000  0.0013 

     84    88.217   0.0113  -0.0001   6.8293  -0.0003   0.0000  0.1376  0.0000 

     85    88.587   0.0113   0.0003  -0.6062  -1.1192   0.0000  0.0011  0.0037 

     86    89.553   0.0112   2.9233  -0.0000   0.1706   0.0252  0.0000  0.0001 

     87    91.995   0.0109  -0.2639  -0.2144  -0.3238   0.0002  0.0001  0.0003 

     88    92.948   0.0108   0.1126   0.0508   0.0909   0.0000  0.0000  0.0000 

     89    93.055   0.0107   1.1698  -0.0041   0.6341   0.0040  0.0000  0.0012 

     90   102.283   0.0098   0.0000  -0.0302  -0.0000   0.0000  0.0000  0.0000 

     91   103.208   0.0097   0.0131   5.0475   0.3381   0.0000  0.0751  0.0003 

     92   103.322   0.0097  -0.6291  -0.0242   0.3139   0.0012  0.0000  0.0003 

     93   109.288   0.0092  -0.7946  -0.1550   0.6055   0.0019  0.0001  0.0011 

     94   110.299   0.0091   1.2405  -0.0000   0.3050   0.0045  0.0000  0.0003 

                                               ------------------------------- 

                                                Total   0.8148  0.5606  0.8574 
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General 

During an overpressure event, the discharge of a PRV imposes a load, referred to as a 
reaction force, on the collective installation. The flowrate and associated reaction force 
increase from nominally zero to some value, remain relatively constant at that value for the 
duration of the release, and then decrease to zero again, i.e., when the relief valve opens, the 
discharge fluid creates a jet force that acts on the piping system. This force increases from 
zero to its full value over a time frame similar to the opening time of the valve. The relief 
valve remains open until sufficient fluid is vented to relieve the overpressure situation. As the 
valve closes, the reduction in flow reduces the jet force to zero. 

Simplified Analysis Approach 

American Petroleum Institute’s API 520, Part II (1994), provides a basis for calculation of 
the reaction force in the event of a vapor or a two-phase release directly to the atmosphere. 
There is no discussion in this section of API 520, Part II, about the reaction force developed 
during a liquid release. Furthermore, no guidance is presented with respect to applying these 
results or determining if an installation is acceptable; instead, the burden is placed on the 
designer to ensure that the installation is appropriately designed. While this may be 
reasonable for the design of new facilities, evaluating the adequacy of existing facilities 
becomes much more complicated. 

The formula (section 2.4.1.1) in US Customary units from API 520, Part II (1994), for vapor 
relief devices discharging to the atmosphere, is shown below: 

)(
)1(366

AP
Mk

kTW
F 


  

where, 

F = Reaction force at the point of discharge to the atmosphere,(lbf.) 
k = Ratio of specific heats (CP/CV) at the outlet conditions 
W = Flow rate of any gas or vapor, pound mass (lbm.)/hr 
CP = Specific heat at constant pressure 
CV = Specific heat at constant volume 
T = Temperature at the outlet, °R 
M = Molecular weight of the process fluid 
A = Area of the outlet at the point of discharge, in2 
P = Static pressure within the outlet at the point of discharge, psig 
Using the reaction force computed from the above formula along with the following PRV 
parameters, namely 

 Valve Opening Time, 

 Valve Closing Time and 

 Relief duration (all obtained from the PRV manufacturer), 

One can generate a PRV load profile and apply it in CAEPIPE to perform a simplified 
analysis.
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Detailed Analysis Approach 

Section 2.4.2 of API 520, Part II (1994) also states the following. 

“Pressure relief devices that relieve under steady-state flow conditions into a closed system 
usually do not create large forces and bending moments on the exhaust system. Only at 
points of sudden expansion will there be any significant reaction forces to be calculated. 
Closed discharge systems, however, do not lend themselves to simplified analytical 
techniques. A complex time history analysis of the piping system may be required to obtain 
the true values of the reaction forces and associated moments.” 

Such complex time history analysis of the piping system can be carried out as follows. 

 Perform a fluid transient analysis on the piping system using a fluid dynamics 
software tool such as, “PipeNet”, “RELAP”, "ROLAST", etc. 

 Apply the resulting output obtained (forces as a function of frequency) at the bend 
node after the relief valve in a pipe stress analysis software (CAEPIPE). 

 Compute forces, moments and stresses in the piping system due to this loading. 

As one can see, this method is detailed, time consuming and expensive and hence, not 
covered here. 

Example 1: 

Step 1: 

By assuming the following data, one can apply the relief valve loading in CAEPIPE. Please 
see the model below for details. 

1. Reaction force (F) computed using the formula above = 6854 lb. 

2. Relief Valve Opening time = 8 ms (milliseconds) 

3. Relief Valve Closing time = 8 ms 

4. Relief duration = 1 s 

6. Pressure = 475 psig 

7. Temperature = 51°F 

The steps followed in generating the model are given below. 
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Step 2: 

After creating your piping model (with node 75 being the center node of the discharge bend 
where the PRV reaction force will be applied), 

Select “Relief valve loading” from CAEPIPE Layout window > Misc and enter the data in 
the dialog box as shown in the figure below. 
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Step 3: 

After entering the data as shown in the dialog above, press the button “OK”. Using the 
above input values for Relief Valve Loading, CAEPIPE internally generates a time-history 
loading function, which is then applied on a single degree-freedom spring-mass system with 
each intermediate frequency (between 0.0 Hz and the maximum frequency) to generate the 
“Force Spectrum Load” shown below. 
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Step 4: 

Apply the Force Spectrum Load thus generated at the bend center node 75 after the relief 
valve in downward direction (-FY by specifying negative Scale Factor) as shown below. 

 

 

Step 5: 

Check “Force Spectrum” for analysis through Layout window > Load cases. Click on OK. 
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Step 6: 

Save and Analyze the model. After analysis, CAEPIPE displays Occasional stresses which 
include the effects of the PRV load. 

 

Step 7: 

Another load case called “Force Spectrum” will be available for which you can study 
displacements, support loads, support load summary (for sizing supports), etc. 

 

 

 



Relief Valve Load Analysis 
 

295 



Restraint 
 

296 

This support type is a convenient way to specify a translational two-way rigid restraint in the 
global X, Y and Z directions.  

A restraint is input by typing “re” in the Data column or selecting “Restraint” from the Data 
Types dialog. Alternately, simply typing “X” or “Y” or “Z” in the data type field inputs a 
restraint in the respective direction and moves the cursor to the next row.  

 

The Restraint dialog is shown. 

 

Use the check boxes to apply the restraint in a particular direction (both ways). Click on the 
vertical button for a rigid vertical restraint. All three directions may be checked too. 

Rigid restraint has a stiffness of 1×10
12

 (lb/in.). 



Rigid Element 
 

297 

Use this element to model any “stiff” (relative to pipe) inline component. 

The stiffnesses of 1 x 10
12

(lb/inch) in translational directions (axial and shear), and 1 x 10
12

 

(inch-lb./rad.) in rotational directions (bending and torsional) are used. 

A rigid element is input by typing “ri” in the Type column or selecting “Rigid element” from 
the Element Types dialog. 

 

The Rigid element dialog is shown. 

 

Weight 

The required input is weight. It is applied as a distributed load along the length of the rigid 
element. To this empty weight, the Additional weightspecified under Load column is added 
(to include weight of snow etc.).  

Weight is to be input in lbf or kgf and NOT in mass units. Whenever mass is required for a 
calculation as in the case of forming Mass matrix for dynamic analysis, or in calculating 
inertia force as (mass x acceleration) for static seismic analysis, CAEPIPE internally 
computes the mass to be equal to (weight / g-value). 

For Sustained load case analysis, weights of content, insulation and lining (as calculated using 
insulation thickness and its density as well as lining thickness and density) are added 
internally in CAEPIPE when the option “Add Content, Insulation and Lining weights 
(CIL)” is turned ON. 

For the Empty Weight load case analysis, only weights of insulation and lining will be 
included, while the weight of content will be excludedwhen the option “Add Content, 
Insulation and Lining weights (CIL)” is turned ON. 

Material density does not affect the weight of the rigid element. 
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Thermal expansion of the rigid element is calculated using the coefficient of thermal 
expansion from the Material column and temperatures from the Load column. Wind load is 
calculated using the section properties inclusive of insulation thickness. 

Rigid, weightless Elements 

These may be needed when you want to account for some hard-to-model element’s thermal 
growth, or to connect the center line of a large pipe to its outside surface, again to account 
for its (radial) thermal growth/contraction (which impacts the branch line), or to model a 
rigid, massless link between two points on the stress model.  

To model any of these, input a rigid element, type zero for weight and ensure that the 
corresponding Load (specified on the Layout window under the Load column) used for this 
element does not have any Additional weight specified. 
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A rod hanger is a rigid one-way vertical support. The rod hanger node is rigidly supported 
against downward movement but able to move freely in the upward direction. That is, the 
rod hanger is rigid in tension (downward movement) and has no stiffness in compression 
(upward movement). CAEPIPE considers a rod hanger to always act in the vertical direction. 

A rod hanger is input by typing “ro” in the Data column or selecting “Rod Hanger” from the 
Data Types dialog. 

 

By default, one rod hanger without a connected node is input. The number of hangers and 
the node to which it may be connected to may be specified in the Rod Hanger dialog. 

 

Number of Hangers 

The number of hangers is the number of separate rod hangers connected in parallel at this 
node. 

Connected to Node 

By default the rod hanger is connected to a fixed ground point which is not a part of the 
piping system. A rod hanger can be connected to another node in the piping system by 
entering the other node number in the “Connected to” nodefield. This node must be directly 
above the rod hanger node. 

A rod hanger in CAEPIPE functions as a vertical limit stop, that is, it functions as a 
nonlinear one-way restraint. It is rigid in -Y direction and fully flexible in +Y direction (in a 
Y-vertical system). The rod hanger offers no resistance in +Y direction. 

Rod hanger results are included in the hanger report, which reports results for the first 
operating case (W+P1+T1). In the hanger report, a rod hanger’s spring rate may be shown 
either as Rigid or zero, the latter potentially confusing to the user. 
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It simply means that there is possibly liftoff at the rod hanger location for the first operating 
case. You can confirm this by studying vertical displacement (Y or Z) at the rod hanger for 
the first operating case (which will be 0 or positive). If this vertical displacement is zero, it 
means the rod hanger is in tension and its sprig rate is shown as Rigid; on the other hand, if 
this vertical displacement is positive, then the rod hanger is in compression and its spring 
rate is shown as zero. You can find reports for other operating load cases under Support 
Loads > Other Supports > Rod Hangers. 

Liftoff (i.e., zero spring rate and a positive operating condition displacement) indicates that 
the rod hanger may not be needed and hence could be removed. You will need to study the 
effect on the system at other supports after removing the rod hanger.  

 

In dynamic analysis, the status of the rod hanger from the first operating case (W+P1+T1) is 
used, i.e., if the rod hanger is in tension in the first operating case, a rigid vertical two-way 
restraint is used in dynamic analysis. If the rod hanger is in compression in the first operating 
case (possible liftoff), no vertical restraint is used at that location in dynamic analysis. 
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A Section denotes the cross-sectional properties of a pipe used to build a piping model. You 
may define as many sections as needed. To define each section, you will need properties such 
as outside diameter (or Nominal Dia.), thickness of pipe, corrosion allowance, insulation, 
inside lining, and a name that is used under the Section column on the Layout window while 
building your model. 

Click on “Sect” on the Header row or select Sections from the Misc menu. 

 

CAEPIPE presents a List window that lists all defined sections in the model (none defined 
yet in the image below). Double click on an empty row to define a new one. 

 

The section dialog is shown. 
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Section name 

Type an alpha-numeric name (up to 5 characters long) in this field. Example: If you have 
three 8” sections with different schedules, you could name them thus: 8-STD, 8-80 and 8-
80S. 

Nominal Dia, Schedule 

Four databases of pipe sizes are built-into CAEPIPE — ANSI (American National 
Standards Institute, default), DIN (Deutsche Industrie Norm), JIS (Japanese Industrial 
Standard) and ISO (International Organization for Standardization).  

When you click on the drop-down combo box for pipe sizes, CAEPIPE shows the list of 
pipe sizes that pertains to the selected database (ANSI, DIN, JIS or ISO). ANSI pipe sizes 
range from 1/8” to 48”, DIN from 15 to 1600, JIS from 8A to 1500A, and ISO from 15 to 
1000. Select the required nominal pipe size and schedule (wall thickness). To change to a 
different database (JIS, DIN or ISO), click on the appropriate radio button. On selection, 
CAEPIPE populates the correct OD and Thickness. 

For pipe sizes you do not see on the list, each database allows you a nonstandard definition 
(“Non std” in the pipe sizes list) too. In other words, you are not restricted only to the 
choices available in the databases. You may define any size and thickness as needed. You will 
need to enter the Outside diameter and Thickness of such a nonstandard pipe, in addition to 
the other parameters. 

Corrosion Allowance 

The corrosion allowance reduces the wall thickness of the pipe and is used to calculate the 
allowable pressure for the pipe section. Additionally, for some piping codes (B31.3, B31.4, 
B31.5, B31.8, B31.12, B31.1 (1967), CODETI, Canadian Z183 and Z184), corrosion 
allowance is used for reducing the section modulus and cross-sectional area only for 
calculating sustained and occasional stresses. 

Mill Tolerance 

The mill tolerance (in percent) is also used to reduce the wall thickness of the pipe while 
calculating allowable pressure. For example, if the mill tolerance is input as 12.5 (%), the pipe 
thickness (while calculating allowable pressure) is = 0.875 x nominal thickness. 

Reduced thickness = (1 − Mill tolerance/100) × nominal thickness − Corrosion allowance 

If defined while modeling, corrosion allowance, mill tolerance, insulation and lining densities 
are automatically carried forward while defining a new section.
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Insulation 

Type the pipe insulation density and thickness here. Click on the Insulation button for the 
insulation library, or enter your own. 

 

Highlight the desired insulation material and press Enter. The insulation density is entered on 
the section property dialog. CAEPIPE uses insulation thickness and density to calculate the 
insulation weight which is added to the weight of the pipe. Insulation thickness is also used 
to calculate the projected area exposed to wind load(s). 

Lining 

Lining is used to prevent internal corrosion that might occur during transportation of a gas 
or a liquid. CAEPIPE has the ability to model these protective coatings inside the pipe. 

 

Lining is different from insulation. Insulation is around and outside of the pipe. Lining is on 
the inside of the pipe. Both have respective thicknesses and densities, which are used to 
calculate the respective weight which is then added to the weight of the pipe. See previous 
figure. 

While calculating the weight of the liquid/gas inside the pipe, CAEPIPE accounts for lining 
thickness by reducing the pipe’s internal diameter by twice the lining thickness. 
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Note: 

CAEPIPE requires “Weight Density” to be input in lbf/in3 or kgf/m3 and NOT its 
“Mass Density” for insulation and lining. 

Whenever mass is required for a calculation as in the case of forming Mass matrix for 
dynamic analysis, or in calculating inertia force as (mass x acceleration) for static 
seismic analysis, CAEPIPE internally computes the mass for each item to be equal to 
(weight / g-value). 

Using values input for Insulation Thickness, Insulation Density, Lining Thickness 
and Lining Density for each pipe section in astress model, CAEPIPE will compute 
their weight and include the same in theanalysis. In addition, CAEPIPE considers 
Insulationand/or Lining as integral parts of the piping, and that there is no relative 
motion between insulation and piping and lining and piping.Accordingly, CAEPIPE 
does not account for any friction between pipe and insulation and pipe and lining. 
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A Skewed Restraint is a two-way support that resists translation along or rotation about any 
specified direction at a node. You have to use either a manufacturer-supplied stiffness or 
calculate it for the support you want to model. 

Use this restraint to model sway braces, sway struts and similar supports. You can also use 
this to model vertical/horizontal supports, though it is used more commonly to resist lateral 
forces. 

The figure below shows an application. 

 

A skewed restraint is input by typing “sk” in the Data column or selecting “Skewed restraint” 
from the Data Types dialog. 
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The Skewed Restraint dialog is shown. 

 

Type 

Translational: Use this type to restrain translation along the specified direction.  

Rotational: Use this type to restrain rotation about the specified direction. 

Stiffness 

Type in the translational or rotational stiffness of the support. As an illustration, assume that 
you had a rod (in tension only) which you were modeling as a skewed restraint. You can 
calculate the stiffness (required to be input) in the following manner: Assume a 2.5 in. dia. 
rod 2 feet long, modulus of elasticity of rod material = 30×106 psi. 

The translational (axial) stiffness is 𝐴𝐸/L=
𝜋

4
(2.5)2 × 30 × 106/24=6,135,925 lb./in. 

The rotational stiffness is 𝐺𝐽/L =
𝐸

2(1+𝜈)
×

𝐽

𝐿
= 1,843,727 in. -lb./rad., where 𝐺 is the 

shear  

modulus, 𝜈 is the Poisson’s ration and 𝐽is polar moment of inertia. 

Direction 

If you have no “connected to node,” the direction in which the skewed restraint is oriented 
must be specified in terms of its global X, Y and Z components. See topic on specifying a 
Direction. 

If the skewed restraint node is connected to an externally fixed point (ground), then for the 
Direction vector components (X comp, Y comp, Z comp), you can specify the offsets (DX, 
DY, DZ) from the skewed restraint node to the fixed point. 

Or use one of the preset buttons to orient the skewed restraint axis: 

1. Axial: To set the axis along the local-x direction (pipe axis) 

2. Shear y: To set the axis in the local-y direction 

3. Shear z: To set the axis in the local-z direction 
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If you have connected the skewed restraint node to another node, then the direction must 
not be input. It is calculated from the locations of the skewed restraint node and the 
connected node, and it is oriented from the skewed restraint node towards the connected 
node. In order for CAEPIPE to calculate the direction, the skewed restraint node and the 
connected node must not be coincident. 

Connected to node 

If the skewed restraint node is connected to an externally fixed point (ground), leave the 
“Connected to node” blank. You may connect a skewed restraint node to another node that 
is not coincident with the skewed restraint node. Note that during skewed restraint force 
calculations, the relative displacement of the skewed restraint node is calculated with respect 
to the connected node. 

Example: Modeling a Sway Brace 

Assume that we need to model two sway braces in the same arrangement as shown in the 
figure at the beginning of this section. The translational stiffness of the sway braces is given 
as 894 lb./in. As can be surmised from the figure, the orientation of the sway braces (sway 
struts in the figure) is at 45° from the Y- and Z-axes. We shall model the support on the 
right hand side first followed by the support on the left hand side. 

The following steps describe the modeling procedure: 

 Create node (on pipeline) where support is required. In this case, the node is 50. 
Position highlight on this row.  

 First support (right): Type “sk” in the Data column to open the skewed restraint 
dialog box.  

Ensure that Type is set to Translational; if not, click on the Translational radio button. 
Type 894 for Stiffness, type 1 for Y comp and –1 for Z comp, press Enter.  
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 Second support (left): type 50 for Node on an empty row, press Tab to move to next 
field, press “l(L)” for Location. This will open the Data types dialog.  

 

Select Skewed restraint by clicking on it to open the skewed restraint dialog. Enter the 
skewed restraint dialog similar to the first skewed restraint except in this case type 1 for Z 
comp, press Enter. 

The Layout window is shown below: 

 

The graphics is shown below: 
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The rendered graphics is shown below: 
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A slip joint allows for axial (through telescopic action) and torsional movement between 
adjacent pipes (due to thermal expansion or contraction). The joint itself can be fixed using 
an anchor if so designed. Slip joints are susceptible to lateral buckling due to internal 
pressure, and may become less effective when subjected to small bending loads. Proper 
guiding to prevent buckling and keeping the two telescopic parts concentric are therefore 
necessary. 

Since the primary purpose of a slip joint is to absorb axial growth, the joint is ideal for 
placing it towards the end of long pipe runs, while its growth is directed axially by the use of 
one or more guides. 

A Slip Joint is input by typing “s” under the Type column or by selecting “Slip joint” from 
the Element types dialog. 

 

The Slip joint dialog is shown. 

 

A slip joint manufacturer should be able to provide you the required data for a slip joint. 

A slip joint will have axial deflection or rotation only when the external forces exceed the 
friction force or friction torque respectively. If the pressure thrust area is input, CAEPIPE 
imposes a thrust load of: Pressure x Thrust area on both nodes of the slip joint. The weight 
is the empty weight of the joint. The contents, insulation and additional weight are added to 
the empty weight. A slip joint is considered to be rigid in lateral directions in CAEPIPE. 

Weight of the slip joint is input in lbf or kgf and NOT its mass. Whenever mass is required 
for a calculation as in the case of forming Mass matrix for dynamic analysis, or in calculating 
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inertia force as (mass x acceleration) for static seismic analysis, CAEPIPE internally 
computes the mass  to be equal to (weight / g-value). 

Example: 

Assume that we want to model a (telescoping action) slip joint that allows only axial 
movement with no torsion. The outer sleeve of the joint is anchored to hold it in place while 
the other end is free to translate axially. The axial (friction) force has to exceed 1,100 lb. (you 
will need to get this datum from a manufacturer’s catalog) to make the slip joint move and 
the slip joint cannot rotate about the axial direction. So, the data would look similar to that 
shown next between nodes 30 and 40. 

 

And, the modeling on the layout screen would look thus: 
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See the topic on Nonlinearities for related information. 
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A snubber provides only translational restraint in a specified direction for seismic and 
dynamic cases only.  In other words, a snubber engages only during movements caused by a 
dynamic load.  It does not restrain against static loads such as weight and thermal. 

A snubber is input by typing “sn” in the Data column or selecting “Snubber” from the Data 
Types dialog. 

 

The Snubber dialog is shown. 

 

The stiffness defaults to Rigid, however a stiffness may be input for flexible snubbers. See 
section on specifying a Direction for information on X comp, Y comp, Z comp.  A snubber 
can be made active in any direction by using this combination of Direction Cosines (X comp, 
Y comp, and Z comp). 

Since the snubber is considered to be attached to an externally fixed point, for the Direction 
vector components (X comp, Y comp, Z comp), it is easier to specify the offsets (DX, DY, 
DZ) from the snubber node to the fixed point. 

Connected to node 

If the snubber is connected to an externally fixed point (ground), leave the “Connected to 
node” blank. You may connect a snubber node to another node that is not coincident with 
the snubber node. Note that during snubber force calculations, the relative displacement of 
the snubber node is calculated with respect to the connected node. 
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Use a spider (also called a spacer) to connect the coincident nodes of a jacketed pipe (i.e., the 
node on the core pipe and the corresponding node on the jacket pipe). The spider acts as an 
internal guide. At the spider location, the local x-axis is calculated along the pipe direction. 
The spider connects the local y and z translations for the core and jacket nodes. It prevents 
any radial movement but allows sliding, rotating and bending movement between core and 
jacket pipes. No gap is allowed between the core pipe and the spider. See section on Jacketed 
pipe for related information. 

A spider is input at a jacketed pipe node by typing “sp” in the Data column or selecting 
“Spider” from the Data Types dialog. 
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Starting Version 10.30, CAEPIPE has the built-in feature to calculate g-load values using the 
procedure given in ASCE/SEI 7-16 as described below. 

.Static Seismic Load – ASCE/SEI 7-16. 

Guidelines from ASCE/SEI 7-16 “Minimum Design Loads for Buildings and Other 
Structures” are explained below. 

Structure Occupancy Category (Risk Category): 

Table 1.5-1 of ASCE/SEI 7-16 provides the Risk Category of Buildings and Other 
Structures for Flood, Wind, Snow, Earthquake, and Ice Loads Structure. Based upon your 
project specification, select the Structure Occupancy Category from the options available. 

 

Site Class: 

Based on the site soil properties, the site shall be classified as Site Class A, B, C, D, E & F.  

Refer Chapter 20 of ASCE/SEI 7-16 for details on Site Class. Depending on your project 
specification, select the Site Class from the options provided. 

Note: Para. 11.4.3 of ASCE/SEI 7-16 states that “Where the soil properties are not known 
in sufficient detail to determine the site class, Site Class D shall be used unless the authority 
having jurisdiction or geotechnical data determines Site Class E or F soils are present at the 
site”.  
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Mapped MCE Spectral Acceleration at Short Period S(S): 

The USGS maintains a website http://earthquake.usgs.gov/designmaps with which the site 
latitude and longitude, as well as the value of S(S) can be retrieved. 

Users can also retrieve the above said values from https://hazards.atcouncil.org. 

For example, for Centralia, WA, the value of S(S) is retrieved as 1.125 with Structure 
Occupancy Category III and Site Class D from the link https://hazards.atcouncil.org as 
shown below. 

 

Component Height in Structure (z) 

Component Height in Structure (z) is the point of attachment of components with respect to the 
base. As per para. 13.3.1 of ASCE/SEI 7-16, for components at or below the base, z shall be taken as 
0. In addition, the value of z/h need not exceed 1.0. 

For example, for a Piping attached to a Boiler Nozzle located at an Elevation 150’0” with a 
Ground Level of 25’0”, z can be computed as 125’ (= 150’ – 25’). 

Structure Height (h) 

Structure height (h) is the average roof height of the structure with respect to the base. From 
the above example, the average roof height of structure (h) with respect to the base can be 
calculated as 125’ (= 150’ – 25’). 

Component Amplification Factor, a(p) 

Table 13.6-1 Seismic Coefficients for Mechanical and Electrical Components of ASCE/SEI 
7-16 provides values of Component Amplification Factor “a(p)” for various components. As 
per para. 13.3.1 of ASCE/SEI 7-16, the component amplification factor is from 1.00 to 2.50. 

For example, Piping in accordance with ASME B31, including in-line components with 
joints made by welding or brazing, the value of Component Amplification Factor “a(p)” is 
listed as 2.50. 

  

http://earthquake.usgs.gov/designmaps
https://hazards.atcouncil.org/
https://hazards.atcouncil.org/
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Component Response Modification Factor, R(p) 

Table 13.6-1 Seismic Coefficients for Mechanical and Electrical Components of ASCE/SEI 
7-16 provides values of Component Response Modification Factor “R(p)” for various 
components. As per para. 13.3.1 of ASCE/SEI 7-16, component response modification 
factor should be from 1.00 to 12.00 

For example, Piping in accordance with ASME B31, including in-line components with 
joints made by welding or brazing, the value of Component Response Modification Factor 
“R(p)” is listed as 12.00. 

Importance Factor, I(p) 

Para. 13.1.1 of ASCE/SEI 7-16 provides a guideline to arrive at component Importance 
Factor “I(p)”. The value of “I(p)” can be between 1.0 and 1.5. 

Allowable Stress Design Factor, ADS(a) 

Enter Allowable Stress Design Factor, ADS(a) as specified in the project specification. If this 
data is not available, then it can be specified as 1.0.  

Para. 13.1.8 of ASCE/SEI 7-16 states that the earthquake loads determined in accordance 
with Section 13.3.1 of ASCE/SEI 7-16 shall be multiplied by an Allowable Stress Design 
Factor ADS(a) of 0.7. 

Example: 

For a power plant required to operate in an emergency, located in Centralia, WA, USA, with 
Occupancy Category as III, Site Class as D (with Stiff soil) and Importance Factor 1.5, use 
ASCE/SEI 7-16 and compute the design earthquake load coefficient for piping required to 
operate the plant. 

1. From the map above with Occupancy Category as III and Site Class as D, the Mapped 
MCE Spectral Acceleration at Short Period ‘S(S)” = 1.215. 

2. Component Height in Structure (z) = 150’0” – 25’0” = 125’0” 

3. Structure Height (h) = 150’0” – 25’0” = 125’0” 

4. Component Amplification Factor, a(p) = 2.50 (as per Table 13.6-1 of ASCE/SEI 7-16, for 
Piping in accordance with ASME B31, including in-line components with joints made by welding or 
brazing) 

5. Component Response Modification Factor, R(p) = 12.00 (as per Table 13.6-1 of 
ASCE/SEI 7-16, for Piping in accordance with ASME B31, including in-line components with 
joints made by welding or brazing) 

6. Importance Factor, I(p) = 1.5 (given) 

With the data provided above, 

a. Site Coefficient at Short Period, F(a) = 1.014 (as per Table 11.4-1 for S(S) = 1.215 is 
and Site Class D)  
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b. As per equation 11.4-1 of ASCE/SEI 7-16, Maximum MCE Spectral Acceleration at 
Short Period S(MS) = F(a)*S(S) = 1.014 * 1.215 = 1.232 g 

c. As per equation 11.4-3 of ASCE/SEI 7-16, Design Spectral Acceleration at Short 
Period S(DS) = (2/3)*S(MS) = (2/3)*1.232 = 0.821 g 

d. As per equation 13.3-1 of ASCE/SEI 7-16,  

Horizontal Seismic g-load value = H(g) = 0.4*S(DS)*[a(p)/R(p)]*I(p)*[1 + 2(z/h)]  

 = 0.4*0.821*(2.5/12.0)*1.50*[1+(2*(125/125))] = 0.308 g 

e. As per equation 13.3-2 of ASCE/SEI 7-16,  

Maximum Horizontal Seismic g-load value H(g.max)  = 1.6*S(DS)*I(p) 

   = 1.6*0.821*1.5 = 1.97 g 

f. As per equation 13.3-3 of ASCE/SEI 7-16,  

Minimum Horizontal Seismic g-load value H(g.min)  = 0.30*S(DS)*I(p)  

   = 0.30*0.821*1.5 = 0.369 g 

g. As per Para 13.3.1 of ASCE/SEI 7-16,  

Vertical Seismic g-load V(g)  = 0.20*S(DS)  

  = 0.20*0.821 = 0.164 g 

As per Para. 13.3.1 of ASCE/SEI 7-16, H(g) >= H(g.min) and H(g) <= H(g.max) 

Hence,  

Horizontal Seismic g-load value H(g) = 0.369 g.  

Vertical Seismic g-load value V(g) = 0.164 g 

From the above, as per Para. 13.1.7 of ASCE/SEI 7 – 16,  
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Allowable Stress Design Horizontal Seismic g-load value = H(g)*ADS(a)  

= 0.369 * 0.70 = 0.258 g 

Allowable Stress Design Vertical Seismic g-load value = V(g)*ADS(a)  

= 0.164 * 0.70 = 0.115 g 

CAEPIPE Output 
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.Static Seismic Load – ANSI A58.1-1988. 

The procedure from ANSI A58.1-1988, “Minimum Design Loads for Buildings and Other 
Structures,” is used in the below example to calculate the g-load values for input into 
CAEPIPE. 

Piping is assumed to be equivalent to equipment, thus giving a force coefficient, Cp as 0.3. 

1. First, based on the map below (Contiguous 48 States+Alaska/Hawaii/Puerto Rico), 
identify the seismic zone and its corresponding coefficient (Z).  

 

Seismic Zone Coefficient Z 

4 1.0000 
3 0.7500 
2 0.3750 
1 0.1875 
0 0.1250 

Determine the Importance Factor, I as follows:  

I = 1.5,  For piping required in an emergency or piping with contents representing a 
significant hazard to human life  

I = 1.0, For other piping  

Calculate the acceleration (g’s) as 0.3 × Z × I 

Example: 

For a power plant required to operate in an emergency, located in Anchorage, Alaska, 
calculate the design earthquake load coefficient for piping required to operate the plant. 

1. From the map above, the seismic zone is 4; from the table above, the corresponding 
Coefficient Z is 1.0.  
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2. For piping required to operate in an emergency, the Importance Factor I = 1.5. 

3. Calculate horizontal acceleration as 0.3 × 1.0 × 1.5 = 0.45g, Vertical g-load (g) = 0.75 * 
horizontal acceleration = 0.34g. 

The above accelerations need to be applied in the desired horizontal and vertical directions 
as long as the piping system is predominantly routed at grade level.  
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CAEPIPE provides many support types, as listed under the Data types menu (See section on 
Data Types in the CAEPIPE User’s Manual).  

 

You can use one or more such support types at one nodal location to model almost all types 
of real-world pipe support hardware, thereby incorporating accurate mathematical 
representation of those supports in the CAEPIPE stress model.  For example, you could use 
two lateral limit stops with unequal gaps to simulate a pipe shoe (see example under Limit 
Stop). 

To input more than one support at a node, use the “Location” data type. 

Anchor 

An anchor can be modeled as a flexible or rigid support which by default restrains the three 
translations and three rotations either in the global or local directions at the applied node (six 
degrees of freedom). Use this to model all anchor blocks, and nodes where piping connects 
to equipment (pumps, compressors, turbines, etc.).  See section on Anchor for further 
details. 

Restraint 

A restraint is a two-way rigid support which restrains the translations (negative and positive 
directions) along the specified global directions. You can apply a restraint in all the three 
directions at the same time. See section on Restraint for further details. 

Skewed Restraint 

This is a flexible two-way support that can be oriented in any direction. Use this support to 
resist either translational movement along or rotational movement about the specified 
direction. Use this to model rigid or flexible sway struts and sway braces. See section on 
Skewed Restraint for further details. 

Hanger, User hanger, Rod hanger, Constant support 

These should be used as vertical supports only. Use a Hanger when you want to design (i.e., 
select from a built-in catalog) a variable spring hanger(s) for your piping system (there are 
30+ hanger catalogs built-in to CAEPIPE for your convenience). Use a User Hanger when 
you want to analyze piping system with existing variable spring hangers. Use a Rod Hanger 
for a rod hanger assembly. Use a Constant Support to design a constant support or a 
constant force hanger. See corresponding sections for further details. 
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“Bottomed-out” Springs 

To analyze this situation, use a variable spring hanger and a limit stop at this node. Type in 
the maximum allowable hanger travel for one of the limits of the limit stop. Once the hanger 
traverses the maximum distance allowed, the limit stop becomes active. 

Guide 

A Guide is a rigid or flexible restraint which resists lateral pipe movements (in directions 
perpendicular to the axis of the pipe). You can specify an annular gap, if required, inside the 
guide. A friction coefficient is optional. Use a Guide to model U-straps, U-Bolts, pipe guide 
assemblies, pipe slides and similar supports. See section on Guide for further details. 

Limit stop 

A limit stop, a nonlinear restraint, can be oriented in any direction with a gap specified on 
both sides of the pipe. A limit stop allows free movement for the distance of the gap and 
then acts as a rigid or flexible restraint.   

A Line Stop is a support that restricts axial movement of pipe. This support can be modeled 
using a limit stop with its direction oriented along the pipe’s axis. Use this support to model 
pipe slide assemblies, pipe skirts and similar arrangements. See topic on Limit Stop for an 
example. 

A limit stop can be used to model 1-way supports for pipe racks where vertical downward 
movement is restrained while upward movement is not. See example for pipe rack modeling 
in the Beam topic. 

Support Tag 

All the Supports described above and Nozzle can have Tags (Support Tags). Each Tag can 
be up to 14 characters long. Tags are useful in identifying supports while modeling, reviewing 
of reports and in field erection. Tag Name entered in this field is shown in all reports. 

Level Tag 

Level Tag shall be assigned for the multi-level response spectrum analysis. It will be disabled 
if a single level spectrum or no spectrum levels are defined. The CAEPIPE will automatically 
assign the level tag to all support for a single level. See section on Spectrum Load in Users 
Manual for more information.  

Refer to the respective CAEPIPE support term in this manual for further details. 
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Physical tees, even though integral components, are not modeled as such in CAEPIPE.  
Instead, they are modeled as three pipes coming together at a common node. 

 

In this figure, you can see that three pipe elements (20-30, 30-40, and 30-60) come together 
at node 30 to form a tee. 
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Modeling 

The method of modeling is as simple as its representation. 

Step 1: 

You could model the pipe run first from 20 to 30 (1st element), then from 30 to 40 (2nd 
element), and finally, from 30 to 60 (3rd element).  See example layout window below. 

 

Alternately, you could model from 20 – 30 – 60, and then 30 – 40.  Or from 60 – 30 – 20, 
and then 30 – 40.  Modeling order is immaterial to analysis (but sometimes complicates the 
merge files process. See Merge under Layout window > Merge in the User’s Manual). 

Step 2: 

There is one final step remaining.  You need to designate the type of tee connection it is.  In 
this example, the tee is a “Welding Tee”.  So, on any row that contains node 30 (i.e., row #4 
or row #8), type “Br” (Branch SIF) and select “Welding Tee” from the drop down list. Since 
row #4 already has a hanger specified, you can use row #8 to specify the Branch SIF. 

 

The shown Branch SIF list is piping code-dependent.  In other words, the list of tee types 
shown comes from the selected piping code that dictates how an SIF for each of the listed 
tee types is calculated.  See Section titled “Piping Code Compliance” from the Code 
Compliance Manual for information on Branch SIFs for different piping codes.  
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Based on a more rigorous analysis, if you have another more accurate SIF value for a joint 
you want to insert (instead of the code’s), then skip Step (2) above and use User-SIF data 
type at the same node to input your own SIF. 

 

For 45° laterals, a piping code committee member opines as follows: 

Use the SIF for an unreinforced fabricated tee and evaluate the branch stress using the 
section modulus of the branch. The connection footprint on the run pipe itself has a section 
modulus greater than the branch section modulus and this will compensate for the 
unreinforced fabricated tee SIF which should be lower than the unreinforced fabricated 
lateral SIF. Ignore the fact that a reduced outlet branch connection requires an “effective 
section modulus” in accordance with ASME B31.1 (2014) Para. 104.8.4(C) or ASME B31.3 
(2014) Para. 319.4.4(c) and just calculate the intensified stress as the unreinforced fabricated 
tee SIF x the branch moment / branch section modulus (whether you use the SIF times the 
resultant moment approach of B31.1 or the in-plane and out-plane SIFs times the in-plane 
and out-plane moments, respectively, approach of B31.3, use the same philosophy of 
ignoring the “effective modulus.” 

Pay particular attention to the fabrication of the lateral making sure that the Code required 
cover fillet dimensioned t(c) in ASME B31.1 (2014) Fig. 127.4.8(D)(a) or ASME B31.3 
(2014) Fig. 328.5.4D(1) meets the required size. If the cover fillet is larger than t(c), that 
improves the lateral SIF. The figures and dimensions shown are a bit unfortunate, especially 
for a lateral because a strict reading of the Code would seem to require a bigger weld on the 
obtuse side of the branch and a smaller weld on the acute side of the branch when just the 
opposite is true. Having a constant cover fillet weld leg length all around the branch would 
improve the requirement and the committee has been working on that. Personally, I think 
the larger the run and branch pipes are, the larger the cover fillet should be. Ask for or 
calculate whether area replacement requirements ASME B31.1 (2014) Para. 104.3.1(D) or 
ASME B31.3 (2014) Para. 304.3.3 are met noticing that the required reinforcement for a 
lateral is greater by the factor (2 - sin alpha). 
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Tie rod is a nonlinear element with different stiffnesses and gaps in tension and compression, 
used to model tie rods in bellows, chains, etc. The force versus displacement relationship for 
a tie rod is shown below. Around expansion joints, a tie rod continuously restrains the full 
pressure thrust while allowing only lateral deflection, bending and torsional rotation.  

 

When the tie rod is in tension, and the displacement is greater than the tension gap, tension 
stiffness is used. If the displacement is less than the tension gap, zero stiffness is used. 
Similarly when the tie rod is in compression, and the displacement is greater than the 
compression gap, compression stiffness is used. If the displacement is less than the 
compression gap, zero stiffness is used. A Tie rod is input by typing “t” in the Type column 
or selecting “Tie rod” from the Element Types dialog. 

 

The Tie Rod dialog is shown. 

 

A tie rod can be made “Tension only” by setting the compression stiffness to zero. Similarly 
it can be made “Compression only” by setting the tension stiffness to zero. Both Tension 
and Compression stiffnesses cannot be zero. If there is no tension or compression gap, leave 
it blank or specify it as zero.  See the earlier “Expansion Joints” topic for examples. 
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Pumps, compressors and turbines in CAEPIPE, referred to as rotating equipment, are each 
governed by an industry publication — API (American Petroleum Institute) publishes an 
API 610 for pumps and an API 617 for compressors while NEMA (National Electrical 
Manufacturers Association) publishes the NEMA SM-23 for turbines. These publications 
provide guidelines for evaluating nozzles connected to equipment among other technical 
information including the items relevant to piping stress analysis – criteria for piping design 
and a table of allowable loads.  

Modeling the equipment is straightforward since it is assumed rigid (relative to connected 
piping) and modeled only through its end points (connection nozzles). 

1. In your model, anchor all of the nozzles (on the equipment) that need to be included in 
the analysis. 

2. Specify these anchored nodes during the respective equipment definition via Misc. menu 
> Pumps/Compressors/Turbines in the Layout window. 

CAEPIPE does not require you to model all of the nozzles nor their connected piping. For 
example, you may model simply one inlet nozzle of a turbine with its piping. Or, you may 
model one turbine with all its nozzles (with no connected piping) and impose external forces 
on them (if you have that data). Further, there is no need to connect the anchors of the 
equipment with a rigid massless element like required in some archaic methods. A flange and 
an anchor may coexist. 

A turbine (like a pump or a compressor) is input by selecting “Turbines” from the 
Miscellaneous (Misc) menu in the Layout window. CAEPIPE, upon analysis, produces a 
NEMA SM-23 turbine compliance report. See Section titled “Rotating Equipment 
Qualification” in the Code Compliance Manual for related information on NEMA SM-23, 
for Turbines. 

 

Once you see the Turbine List window, double click on an empty row for the Turbine dialog 
and enter the required information. 
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A short description to identify the turbine may be entered for Description. The nozzle nodes 
must be anchors and the shaft axis must be in the horizontal plane. Some of the nozzle 
nodes may be left blank if they are not on the turbine (e.g., extraction nodes). 

See under Pumps for related modeling tips and the topic on specifying a Direction for 
information on how to specify X comp/Y comp/ Z comp for Shaft axis. 
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NEMA SM-23 Report 

 

See Section titled “Rotating Equipment Qualification” of the Code Compliance Manual for 
more information on how to interpret the NEMA SM-23 report. 

Note: If you have input multiple temperatures, corresponding reports for additional 
operating load cases are shown. Use the black right arrow key to see them. 
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Use the “User Hanger” type for analyzing piping systems with existing variable spring 
hangers, which are different from spring hangers that need “to be designed” (for which you 
use the “Hanger” data type).A user hanger is input by typing “u” in the Data column and 
pressing Enter or selecting “User Hanger” from the Data Types dialog. 

 

The User Hanger dialog is shown. 

 

Spring Rate 

The spring rate is required. For a constant support user hanger, input the spring rate as zero. 

Number of Hangers 

Type in the number of separate hangers connected in parallel at this node. The stiffness and 
load of each hanger are multiplied by the number of hangers to find the effective stiffness 
and load of the hanger support at this node. 

Hanger Load and Load type 

Input the hanger load, if known. Otherwise, leave it blank and CAEPIPE will calculate the 
load. 

The hanger load may be specified as hot or cold using the Load type radio buttons.  
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When Cold Load and Spring Rate are input for User Hanger 

Snap shots shown below are from a CAEPIPE model with two (2) User Hangers defined at 
Nodes 20B and 115B. In this model, Spring rate and Cold load are input for each User 
Hanger as given below.  

 

User Hanger at Node 20B   User Hanger at Node 115B 
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Analysis Options 

 

Details of Layout 
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From the analysis results, Hanger Report as well as Displacements and Support Loads for 
Sustained & Operating load cases are presented below.  
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Given below are the Steps performed by CAEPIPE to arrive at the results shown above for 
User Hangers when “Cold load” and “Spring rate” are input. 

Step 1: Compute Hot Load from Preliminary Sustained Load Analysis 

Performs a preliminary sustained load analysis and computes hot loads for the two User 
Hangers by replacing them with Vertical Restraints.  

To verify this step, remove the User Hangers at nodes 20B and 115B and instead add 
Vertical Rigid Restraints at those two nodes and perform a sustained load analysis. From the 
Analysis results, you will observe that the “Loads on Restraints” at nodes 20B and 115B for 
Sustained load case will be identical to the hot loads reported above in the Hanger Report for 
the model with User Hangers.  
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Step 2: Compute Vertical Travel from Preliminary Operating Load Analysis 

Vertical Restraints added in Step 1 above at User Hanger locations are removed. The hot 
loads (calculated in Step 1) are applied as upward forces at the hanger locations. Vertical 
displacements at the hanger locations obtained from the operating load case analysis are the 
hanger travels.  

To verify this step, remove the Vertical Restraints at Nodes 20B and 115B from the model 
developed in Step 1 above. Apply the hot loads as upward forces at Nodes 20B and 115B by 
choosing “Add to W+P” in CAEPIPE’s Force dialog and perform the analysis. Vertical 
displacement results at the User Hanger locations for the Operating load case will be 
identical to the Vertical Travel values reported above in the Hanger Report for the model 
with User Hangers.  

Step 3: Perform Detailed Analysis 

Performs once again the Sustained and Operating load case analyses by including the “Spring 
Rate” and “Cold load” input into CAEPIPE model at User Hanger locations. 

To verify this step, to the model developed under Step 2 above add a skewed restraint in 
vertical direction at each User Hanger location with its stiffness equal to the “Spring Rate” 
for that User Hanger. In addition, add to the sustained load case (i.e., choose “Add to W+P” 
in CAEPIPE’s Force dialog) an upward force at each skewed restraint node that is equal to 
the Cold load for the corresponding User Hanger. The resulting Step 3 model is then 
analyzed. Displacements for the Sustained and Operating load cases obtained from this Step 
3 model will be identical to the displacements obtained for Sustained and Operating load 
cases reported above for the model with User Hangers.  

Now, from the Step 3 model results, we observe the following at the two skewed restraints. 

Sustained load case 

Support load at Node 20B [A]  = Spring Rate x Sustained displacement at Node 20B  

= 800 lb/in x 0.248” 

=198.4 lb (comparing well with CAEPIPE result of 198 lb) 

Support load at Node 115B [B] = 340 lb/in x 0.166” 

= 56.44 lb (comparing well with CAEPIPE result of 56 lb) 

Operating load case 

Support load at Node 20B [C]  = Spring Rate x Operating displacement at Node 20B  

= 800 lb/in x 0.575” 

= 460 lb (comparing well with CAEPIPE result of 460 lb) 

Support load at Node 115B [D] = 340 lb/in x 1.030” 

  = 350.2 lb (comparing well with CAEPIPE result of 350 lb) 

Using the above Support load and Cold load, CAEPIPE is computing and reporting the 
Loads on User Hangers as follows. 
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When the option “Include hanger stiffness” is turned ON 

Sustained load case 

Load on Hanger at 20B = -Cold load + Spring Rate x Sustained displacement at Node 20B   

  = -Cold Load + A 

  = -3787 + 198.4 = -3588.6 lb (matches with Hanger loads results) 

Operating load case 

Load on Hanger at 20B = -Cold load + Spring Rate x Operating displacement at Node 20B  

  = -Cold Load + C 

  = -3787 + 460 = -3327 lb (matches with Hanger loads results) 

When the option “Include hanger stiffness” is turned OFF 

Sustained load case 

Load on Hanger @ 20B = -Hot load = -3327 lb 

Operating load case 

Load on Hanger @ 20B = -Hot load = -3327 lb 
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When Hot Load and Spring Rate are input for User Hanger 

Snap shots shown below are from a CAEPIPE model with two (2) User Hangers defined at 
Nodes 20B and 115B. In this model, Spring rate and Hot load are input for each User 
Hanger as given below.  

 

User Hanger at Node 20B   User Hanger at Node 115B 
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Analysis Options 

 

Details of Layout 
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From the analysis results, Hanger Report as well as Displacements and Support Loads for 
Sustained & Operating load cases are presented below.  
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Given below are the Steps performed by CAEPIPE to arrive at the results shown above for 
User Hangers when “Hot load” and “Spring rate” are input. 

Step 1: Compute Vertical Travel from Preliminary Operating Load Analysis 

Performs a preliminary operating load analysis by including the hot loads input as upward 
forces at the hanger locations. Vertical displacements at the hanger locations obtained from 
the operating load case analysis are the hanger travels.  

To verify this step, remove the User Hangers at Nodes 20B and 115B and instead apply the 
respective hot loads as upward forces at those two nodes by choosing “Add to W+P” in 
CAEPIPE’s Force dialog and perform the analysis. Vertical displacement results at the User 
Hanger locations for the Operating load case will be identical to the Vertical Travel values 
reported above in the Hanger Report for the model with User Hangers. 

  



User Hanger 
 

343 

Step 2: Compute Cold Load  

The Cold load is then computed using the Hot load entered and Vertical Travel obtained 
from Step 1 above as stated below. 

Cold load = Hot load + Spring Rate x Vertical Travel 

For example, at Node 20B,  

Cold load = 3327 + 800 x 0.576 = 3787.8 lb.  

Similarly, at Node 115B, 

Cold load = 1473 + 340 x 1.030 = 1823.2 lb.  

Step 3: Perform Detailed Analysis 

Performs once again Sustained and Operating load case analyses by including the “Spring 
Rate” and “Cold load” (obtained in Step 2 above) into CAEPIPE model at User Hanger 
locations. 

To verify this step, to the model developed under Step 1 above add a skewed restraint in 
vertical direction at each User Hanger location with its stiffness equal to the “Spring Rate” 
for that User Hanger. In addition, add to the sustained load case (i.e., choose “Add to W+P” 
in CAEPIPE’s Force dialog) an upward force at each skewed restraint node that is equal to 
the Cold load computed in Step 2 above for the corresponding User Hanger. The resulting 
Step 3 model is then analyzed. Displacements for the Sustained and Operating load cases 
obtained from this Step 3 model will be identical to the displacements obtained for Sustained 
and Operating load cases reported above for the model with User Hangers.  

Now, from the Step 3 model results, we observe the following at the two skewed restraints. 

Sustained load case 

Support load at Node 20B [A]  = Spring Rate x Sustained displacement at Node 20B  

= 800 lb/in x 0.248” 

=198.4 lb (comparing well with CAEPIPE result of 198 lb) 

Support load at Node 115B [B] = 340 lb/in x 0.166” 

= 56.44 lb (comparing well with CAEPIPE result of 56 lb) 

Operating load case 

Support load at Node 20B [C]  = Spring Rate x Operating displacement at Node 20B  

= 800 lb/in x 0.576” 

= 460.8 lb (matching with CAEPIPE result of 461 lb) 

Support load at Node 115B [D] = 340 lb/in x 1.030” 

= 350.2 lb (matching with CAEPIPE result of 350 lb) 

Using the above Support load values and Cold load, CAEPIPE is computing and reporting 
the Loads on User Hangers as follows. 
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When the option “Include hanger stiffness” is turned ON 

Sustained load case 

Load on Hanger at 20B = -Cold load + Spring Rate x Sustained displacement at Node 20B   

= -Cold Load + A 

= -3787.8 + 198.4 = -3589.4 lb (matches with Hanger loads results) 

Operating load case 

Load on Hanger at 20B = -Cold load + Spring Rate x Operating displacement at Node 20B  

= -Cold Load + C 

= -3787.8 + 460.8 = -3327 lb (matches with Hanger loads results) 

When the option “Include hanger stiffness” is turned OFF 

Sustained load case 

Load on Hanger at 20B = -Hot load = -3327 lb 

Operating load case 

Load on Hanger at 20B = -Hot load = -3327 lb 

Connected to Node 

By default the hanger is connected to a fixed ground point which is not a part of the piping 
system. A hanger can be connected to another node in the piping system by entering the 
node number in the “Connected to” node field. This node must be directly above or below the 
hanger node. 
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User SIF (Stress Intensification Factor) may be used to specify SIF at a node where there is 
normally no SIF internally calculated (i.e., at a non-bend or non-tee node) or to override any 
internally calculated SIF at the node. 

Use this for any component that needs an SIF value such as non-right angle tees, 
nonstandard tees or branch connections, flanges, etc., for which the chosen piping code does 
not specify a SIF, or you want to override the code’s SIF. For example, in case of a bend or a 
tee, CAEPIPE calculates the SIF according to the selected piping code. To override the 
calculated SIF, specify a User SIF. Note that a User SIF is applied to all elements that come together at 
this node. 

A User SIF is input by typing “user s” in the Data column or selecting “User SIF” from the 
Data types dialog. 

 

Depending on the piping code selected, either a single value User SIF (B31.1)or in-plane, 
out-of-plane and Axial values of User SIF (B31.3) or in-plane, out-of-plane, Axial and 
Torsion values of User SIF (B31J) may be input. The corresponding dialog will be shown. 

B31.1 code 

 

B31.3 code    B31J Turned ON 
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Use this element to model any type of valve.  A valve is relatively more rigid than a pipe.  
CAEPIPE uses the data input to calculate the rigidity. 

A Valve is input by typing “v” in the Type column or selecting “Valve” from the Element 
Types dialog. 

 

The Valve dialog is shown. 

 

Weight 

The weight is the empty weight (without contents, insulation, etc.). CAEPIPE applies this 
weight as a uniformly distributed load along the length of the valve. Additional weight, if 
specified, is treated as a concentrated weight offset from the center of the valve. 

CAEPIPE requires “Weight” to be input in lbf or kgf and NOT its “Mass”. Whenever mass 
is required for a calculation as in the case of forming Mass matrix for dynamic analysis, or in 
calculating inertia force as (mass x acceleration) for static seismic analysis, CAEPIPE 
internally computes the mass  to be equal to (weight / g-value). 

Length 

If the valve length is input, the DX, DY, DZ in Layout is adjusted to match the valve length, 
(assuming that the local x-axis of valve is in the same direction as the local x-axis of the 
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preceeding element). If the valve length is left blank, the valve length is calculated from DX, 
DY, DZ input in Layout. 

Thickness X 

The thickness multiplier (Thickness X) is used for stiffness calculation (i.e., the thickness of 
the pipe section is multiplied by Thickness multiplier by increasing only the OD of the valve 
and not changing its ID in the calculation of the valve stiffness). Typical value for Thickness 
multiplier is 3 which is the default value if left blank. 

Insulation weight X 

The insulation weight multiplier (Insulation weight X) is used if the valve has additional 
insulation compared to adjacent pipe (i.e., weight of insulation calculated from the insulation 
thickness of the pipe section is multiplied by Insulation weight X multiplier). Typical value 
for insulation weight multiplier is 1.75 which is the default value if left blank. 

Additional weight 

The additional weight is a concentrated weight which may be specified at an offset from the 
center of the valve, such as for a valve operator. As stated above, CAEPIPE requires 
“Additional Weight” to be input in lbf or kgf and NOT its “Mass”.  

Valve Library 

Cast Iron, Steel and Alloy valve (Flanged and Butt Welding ends) libraries are provided. The 
Type of Valve, Connection Type and Rating are indicative in the filenames listed in the 
libraries. Valve weights are included for different categories of valves. If necessary, you may 
create your own user-definable valve library. A new valve library can be created from menu 
File > New > Valve Library in the main opening CAEPIPE window. 
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The valve library may be accessed by clicking on the Library button of the Valve dialog. 
Navigate to the folder called “Valve_Library” or similar under your CAEPIPE program files 
folder. 

 

 

Selecting one of these valve types will display a list of valves for you to select from. 
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Select one from the displayed list. The weights of the valves (in the Extended Library) are 
provided. If a valve is flanged, the mating flanges at the two ends of the valve must be 
separately input using the Flange data type and their corresponding weight. Please confirm 
the data with your valve manufacturer’s catalog, and input the correct weight. 
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Calculation of Moment of Inertia 

The inside diameter of the valve is calculated from the section O.D. (outside dia.) and the 
section Thickness. 

I.D. = Section O.D. − 2 ×Section Thickness 

Then the new O.D. and Thickness for the valve are calculated as: 

New Thickness = Section Thickness × Thickness X multiplier 

New O.D. = I.D. (inside dia.) + 2 × New Thickness 

The moment of inertia for the valve is now based on the New O.D. and New Thickness. For 
a thin-walled pipe, Thickness X and Inertia multipliers are approximately the same. The 
weight of the contents of the valve is based on the I.D. as calculated above.  

The weight of the insulation is the weight calculated from the section O.D. and insulation 
thickness and density (from section properties) multiplied by the insulation weight multiplier. 

Angle/Relief Valve 

Angle and relief valves which have the outlet pipe at some angle (typically 90°) from the inlet 
pipe may be modeled by two valves one after the other and at that angle. The total weight of 
the actual valve must be divided between these two modeled valves. 
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Use this data type to input a Weld at a node. Type “w” in the Data column or select “Weld” 
from the Data types dialog. 

 

The Weld dialog is shown. Four types of welds are available: Butt, Fillet, Concave Fillet, and 
a Tapered transition. The type of the weld should be selected from the “Type” drop-down 
combo box. 

 

Butt weld and Tapered transition require the input of weld mismatch. Mismatch is the 
difference in the mean radii across the weld. 

 

The SIF for a weld is calculated according to the selected piping code (see Section titled 
“Piping Code Compliance” from the Code Compliance Manual for details) and is 
incorporated in the stress calculations. If you have an unlisted weld type, you could specify 
the SIF for it using the User SIF data type. 

Any SIF value specified using the “User SIF” Data item will always overwrite any other SIF 
value calculated/determined at that node using any other method(s). 
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.Wind Load – ANSI A58.1 - 1982. 

CAEPIPE calculates Design Wind Force F as follows to calculate wind load acting on each 
pipe element. 

F = q x Shape factor x Af (lbs) 

where,  

Af is the area of the piping plus insulation projected on a plane normal to the wind direction 

q = Dynamic pressure due to wind (lbs/ft2) = 0. 0.00256V2 x I2 x (Kz Gz Cf)  

V = Basic Wind Speed, V (mph), from Basic Wind Speed Map, for your region. 

Shape factor = 0.6 for Circular cross-section (to be input into CAEPIPE for Wind) 

“Section 6” of ANSI A58.1 - 1982, Minimum Design Loads for Buildings and Other 
Structures can be referred to arrive at the values for [I2 x (Kz Gz Cf)]. 

Importance Factor, I2, is determined according to structure category and location: 

Value of I2 for: Other Areas Within 100 mi 
of Ocean line 

Chemical plants, refineries, industrial facilities, and 
power plants not required inan emergency 

1.00 1.11 

Power Plants required in an emergency 1.15 1.24 

Determine combined Velocity Coefficient, Gust Factor, and Force Coefficient, Kz Gz Cf) 
according to height of piping; 

Height of Piping KzGzCf 

At or below 50’ above ground 1.23 

Above 50’ at or below 100’ above ground 1.44 

Above 100’, at or below 200’ above ground 1.68 

Note: 

If Wind Speed as a function of Elevation is input, the factor SQRT[(I2 x (Kz Gz Cf))] has to 
be multipliedwith the Actual Wind Velocity as a function of elevation to arrive at the Wind 
Speed that is to be input at each elevation manually. 

For example, if the Actual Wind Speed is 60 mph at an elevation of 50’, I2 as 1.00 and 
Kz.Gz.Cf as 1.23, SQRT[1.00 x 1.23] = 1.109. So, V = 60 x 1.109 for up to 50’ elevation = 
66.54 mph. This should be input in the CAEPIPE Wind dialog. 

If Pressure as a function of Elevation is input in CAEPIPE, the factor [I2 x (Kz Gz Cf)] and 
the Shape Factor have to be incorporated in the Pressure input at each elevation manually. 
This is because CAEPIPE currently uses the Shape Factor input into Wind dialog only for 
Velocity vs Elevation option and not for Pressure vs Elevation option. 
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.Wind Load – ASCE/SEI 7-16. 

The determination of wind loads for the structural design of buildings is a complex subject that 
many building codes simplify by presenting tables of net wind pressures versus height above 
grade. Wind loads on a building in any particular locality depend on many factors, including 
recorded wind speeds in the area, the terrain around the building, and the shape and height of the 
building. It is now common for wind tunnel model tests to be conducted for tall buildings to 
determine wind loads - which may be more severe than the minimum code requirements. 

American Society of Civil Engineers Standard (ASCE) SEI 7-16 contains detailed information 
and formulas for computing wind loads on buildings in various geographic locations. The 
procedure described in this code has been updated in CAEPIPE starting Version 10.30 and can 
be accessed through this option Layout Window > Misc > ASCE/SEI 7-16.  

By defining the basic wind parameters in the dialog shown, CAEPIPE will compute the Design 
Wind Force internally as per ASCE/SEI 7-16 and apply the same to the piping system. For 
details on implementation, refer Appendix “ASCE/SEI 7-16” from Code Compliance Manual. 

 

Structure Occupancy Category 
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Structure Occupancy Category (Risk category) can be I, II, III or IV as provided in the Table 
below.  

 

Basic Wind Speed (V) 

Depending upon the Risk Category, Basic Wind Speed (V) can be determined from the Figures 
26.5.-1A, 26.5-1B and 26.5-1C provided in Chapter 26 of ASCE/SEI 7-16. 

For example, Basic Wind Speed (V) at Caledonia, MS (near Aberdeen, MS) with Risk Category 
III is 114 mph (as per Figure 26.5-1B of ASCE/SEI 7-16). 

Alternatively, one can use the link https://hazards.atcouncil.org/#/ to determine the Basic Wind 
Speed (V) as per ASCE/SEI 7-16 by entering the location as shown below.  

 

Wind Directionality Factor (Kd) 

https://hazards.atcouncil.org/#/
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This Wind Directionality Factor (Kd) accommodates the cross-sectional shape of the structure. 
The wind directionality factor (Kd) can be determined from Table 26.6-1 of ASCE/SEI 7-16. 
This table is provided below for quick reference. 

 

For example, Chimneys, Tanks, and Similar Round Structures, Kd = 0.95. 

Exposure Category 

Exposure Category can be B, C or D.  

For each wind direction considered, an exposure category that adequately reflects the 
characteristics of ground surface irregularities shall be determined for the site at which the 
building or structure is to be constructed. For a site located in the transition zone between 
categories, the category resulting in the largest wind forces shall apply. Account shall be taken of 
variations in ground surface roughness that arises from natural topography and vegetation as well 
as from constructed features.  

The exposure category for an individual structure shall be based upon the site conditions that will 
exist at the time when all adjacent structures on the site have been constructed, provided that 
their construction is expected to begin within one year of the start of construction for the 
structure for which the exposure category is determined.  

For further details, refer para. 26.7.3 of ASCE/SEI 7-16 on Exposure Categories.  

Topographical Parameters 

Topography or large vertical displacements of the ground surface can have a significant effect on 
the wind speed profile. The wind flow in a realistic environment is not merely over a single 
ground feature such as hills, ridges, escarpment, but as well over undulating and mountainous 
terrain. It is important to understand that the flow over one hill will affect that around the next. 
The effects of undulating and mountainous terrain are almost similar to those of a very rough 
surface. Ridges and escarpments are mainly two dimensional land feature, and hills are mainly 
three dimensional. 
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Hills differ from ridges in that the wind can diverge over sides in addition to speeding up over 
crests. The speed-up effects of a hill are thus generally less than that those of a ridge of the 
identical slope. In general, the wind increases its speed when it moves up the windward slope of 
a hill or a ridge. The maximum increase in wind speed is usually experienced at or near the crest. 

 

Parameters such as Hill Type, Height of Hill or Escarpment (H), Crest Distance (Lh), Height 
above ground level (z) and Distance from Crest to Site (x) are required by ASCE/SEI 7-16 for 
computing the Topographical Factor (Kzt) required in computing the Velocity Pressure (qz).  

Refer para. 26.8.2 of ASCE/SEI 7-16 for more details on Topographical Parameters. 

Type of Surface 

Type of Surface can be “Moderately Smooth”, “Rough” or “Very Rough”. This parameter is 
used to compute the force coefficient (Cf) required in computing the design wind force (F).  

For further details, refer para. 29.5 from ASCE/SEI 7-16. 

Gust-effect Factor (G) 

As per para 26.9.1, Gust-effect factor for a rigid building and other structures is permitted to be 
taken as 0.85. 

Upon defining the above parameters, the user can apply Wind Load by selecting the wind code 
as “ASCE/SEI 7-16” through Layout Window > Loads > Wind1/Wind2/Wind3/Wind4. 
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.Wind Load – EN 1991-1-4 (2010). 

Eurocode 1 EN 1991-1-4 Action on structures (wind load) and EN 1991-1-4 (2010) contains 
detailed information and formulas for computing wind loads on buildings in various geographic 
locations. The procedure described in this code has been included in CAEPIPE starting Version 
10.30 and can be accessed through this option Layout Window > Misc >Wind Load – EN 1991-
1-4 (2010).  

By defining the wind parameters in the dialog shown, CAEPIPE will compute the Design Wind 
Force internally as per EN 1991-1-4 (2010) and apply the same to the piping system. For details 
on implementation, refer to Appendix “EN 1991-1-4 (2010)” from Code Compliance Manual. 

 

Fundamental value of the basic wind velocity can be obtained from National Annex for EN 
1991-1-4. 

Terrain Category 

Based on the location of the structure, Terrain Category classification can be obtained from the 
Annex A and Table A.1 of EN 1991-1-4. 
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Directional and Seasonal Factors (Cdir & Cseason) 

In order to calculate the Basic Wind Velocity as per Expression (4.1) of EN 1991-1-4 (2010), we 
need to determine the directional and seasonal factors (Cdir &Cseason).  National Annex for EN 

1991-1-4 simplifies this calculation as the suggested values of these factors are equal to 1.0. 

Terrain Orography 

The recommended value of the Terrain Orography factor is 1.0. 

Where orography (e.g. hills, cliffs etc.) increases wind velocities by more than 5% the effects 
should be taken into account using the orography factor Co(z). 

The procedure to be used for determining Co(z) may be given in the National Annex. The 
recommended procedure is given in A.3 of EN 1991-1-4 (2010). 
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The effects of orography may be neglected when the average slope of the upwind terrain is 
less than 3°. The upwind terrain may be considered up to a distance of 10 times the height of 
the isolated orographic feature. 

 

 

 

 

 

 

 

 

 

 

 

 

Turbulence Factor (Kt) 

Turbulence factor (Kt) may be given in the National Annex. The recommended value for Kt 
is 1.0. 

Roughness Length and Minimum Height 

Roughness Length (Zo) and the Minimum Height (Zmin) are provided for each Terrain 
Category in Table 4.1 of EN 1991-1-4 (2010). 

Upon defining the above parameters, the user can apply Wind Load by selecting the wind code 
as “EN 1991-1-4 (2010)” through Layout Window > Loads > Wind 1/Wind 2/Wind 3/Wind 4. 
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The “Dynamic Susceptibility” Method for Piping Vibration –A Screening Tool for 
Potentially Large Alternating Stresses 

Dr. R. T. Hartlen, Plant Equipment Dynamics, Ontario, CANADA 

Summary 

The enhanced output of the “Modal Analysis” load case in CAEPIPE shows modal 
frequencies and mode shapes AND now two new outputs called “dynamic stresses” and 
“dynamic susceptibility”. The dynamicstresses are the dynamic bending stresses associated 
with vibration in a natural mode. That is to say, the modal analysis result has been generalized to 
include the alternating bending stresses associated with the vibration in a natural mode. The 
dynamic susceptibility for any mode is the ratio of the maximum alternating bending stress to 
the maximum vibration velocity. This “susceptibility ratio” provides an indicator of the 
susceptibility of the system to large dynamic stresses. Also, the associated animated mode 
shapes include color-spot-markers identifying the respective locations of maximum vibration 
velocity and maximum dynamic bending stress. The susceptibility ratio and the graphics 
feature provide incisive insights into the reasons for high susceptibility and how to make 
improvements. This new feature is illustrated by application to the CAEPIPE “Sample 
problem” stress model. 

1. Dynamic Susceptibility: New Analytical Tool Available for Vibration of Piping 

When addressing vibration issues, the piping designer does not have the specific 
requirements, nor the analytical tools and technical references typically available for other 
plant equipment such as rotating machinery. Typically, piping vibration problems only 
become apparent at the time of commissioning and early operation, after a fatigue failure or 
degradation of pipe supports. Discovery of a problem is then followed by an ad hoc effort to 
assess, diagnose and correct as required. The “Dynamic Susceptibility” analysis, now 
included in CAEPIPE, provides a new analytical tool to assist the piping designer at any 
stage, from preliminary layout to resolution of field problems. 

CAEPIPE’s Dynamic Susceptibility feature utilizes the “Stress per Velocity” method, an 
incisive analytical tool for “screening” the vibration modes of a system. It readily identifies 
which modes, if excited, could potentially cause large dynamic stresses. Furthermore, it 
reveals which features of the system layout and support are responsible for the susceptibility 
to large dynamic stresses. At the design stage, the method allows the designer to quickly 
identify and correct features that could lead to large dynamic stresses at frequencies likely to 
be excited. Where problems are encountered in the field, the method provides quick and 
incisive support to efforts of observation, measurement, assessment, diagnosis and 
correction. 

The technical foundation of this method lies in an underlying fundamental relationship 
between the kinetic energy of vibratory motion, and the corresponding potential energy 
stored in elastic stresses. That is to say, the kinetic energy at zero displacement and maximum 
system velocity must equal the stored elastic energy at zero velocity and maximum 
displacement. This implies a fundamental relationship between vibration velocity and 
dynamic bending stresses, which is the foundation of the stress per velocity approach for 
“susceptibility screening” of vibration modes. 

The key analytical step is to determine, mode by mode, the ratio of maximum dynamic stress 
to maximum vibration velocity. This ratio will lie in a lower “baseline range” for 
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uncomplicated systems such as classical uniform-beam configurations. For more complex 
systems, the stress / velocity ratio will increase due to typical complications such as three-
dimensional layout, discrete heavy masses, changes of cross-section and susceptible branch 
connections. System modes with large stress-velocity ratios are the potentially susceptible modes. 

The Stress / Velocity method, implemented in CAEPIPE as the Dynamic Susceptibility 
feature, automatically and quickly finds these modes and quantifies the susceptibility. Evaluation of the 
results, including special-purpose color animation, helps to identify which details of layout 
and support are responsible for the large stresses. 

This technical note is to present and explain the “dynamic susceptibility” outputs now 
included in the modal analysis load case, and to illustrate by application to the standard 
CAEPIPE “Sample problem” system. 

2. Underlying Fundamental Basis of the Method 

2.1 Kinetic Energy and Potential Energy; Vibration Velocity and Dynamic 

Stresses 

The underlying theoretical basis for the Stress / Velocity method is a deceptively 
straightforward but universally-applicable relationship between kinetic energy and potential 
(elastic) energy for vibrating systems. Stated simply, for vibration at a system natural frequency, the 
kinetic energy at maximum velocity and zero displacement must then be stored as 
elastic (strain) energy at maximum displacement and zero velocity. Since the strain 
energy and kinetic energy are respectively proportional to the squares of stress and velocity, it 

follows that dynamic stress, , will be proportional to vibration velocity, v. For idealized 
straight-beam systems, consisting of thin-walled pipe and with no contents, insulation or 

concentrated mass, the ratio  / v is dependent primarily upon material properties, (density  and 
modulus E) ,and is remarkably independent of system-specific dimensions, natural-mode number and 
vibration frequency. For real continuous systems of course, the kinetic and potential energies are 
distributed over the structure in accordance with the respective modes shapes. However, 
integrated over the structure, the underlying energy- equality holds true. Provided the spatial 
distributions are sufficiently similar, i.e. harmonic functions, the RMS or maximum stress will 
still be directly related to the RMS or maximum vibration velocity. 

2.2 The “Screening” Approach 

As stated above, for idealized pure beam systems the stress-velocity ratio will depend 
primarily upon material properties. 

For real systems, the spatial patterns of the mode shapes will depart from the idealized 
harmonic functions, and the stress-velocity ratios accordingly increase above the theoretical minimum or 
baseline value. System details causing the ratios to increase would include the three-
dimensional layout, large unsupported masses, high-density contents in thin-walled pipe, 
susceptible branch connections, changes of cross section, etc. The more “unfavorable "the system 

layout and details are, the larger the  / v ratios for some modes will be. 

Thus, the general susceptibility of a system to large dynamic stresses can be assessed by 

determining the extent to which the  / v ratios for any mode exceed the baseline range. 

Furthermore, by determining which particular modes have the high ratios, and whether these 
modes are known or likely to be excited, the at-risk vibration frequencies and mode shapes 
are identified for further assessment and attention. This is the basis of the Stress / Velocity 
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method of analysis and its implementation as the “dynamic susceptibility” feature in 
CAEPIPE. 

2.3 Relation to Velocity-based Vibration Acceptance Criteria 

There are various general and application-specific acceptance criteria based upon vibration 
velocity as the quantity of record. Some, in order to cover the worst case scenarios, are 
overly conservative for many systems. Others are presented as being applicable only to the 
first mode of simple beams, leading to the misconception that the stress / velocity 
relationship does not apply at all to higher modes. In any case, there are real and perceived 
limitations on the use of screening acceptance criteria based upon a single value of vibration 
velocity. 

The dynamic susceptibility method turns this apparent limitation into a useful 
analytical tool! Specifically, large stress / velocity ratios, well above the baseline values, are 
recognized as a “warning flag.” Large values indicate that some feature(s) of the system make 
it particularly susceptible to large dynamic stresses in specific modes. 

3 What the Dynamic Susceptibility Method Does  

3.1 General Approach  

The Dynamic Susceptibility method is essentially a post processor to fully exploit the modal 
analysis results of the system. Mode shape tables of dynamic bending stress and vibration 
velocity are searched for their respective maxima. Dividing the maximum stress by the 

maximum velocity yield the “/v ratio” for each mode. That ratio is the basis for assessing 
the susceptibility to large dynamic stresses. Larger values indicate higher susceptibility 
associated with specific details of the system. 

3.2 Specific Implementation in CAEPIPE 

The Stress / Velocity method has been implemented as additional analysis and output of the 
CAEPIPE modal analysis. The modal analysis load case now includes additional outputs and 
features as follows: 

Dynamic Stresses  This output provides the “mode shapes” of dynamic bending 
stresses, tabulated along with the conventional mode shape of 
vibration magnitude. 

Dynamic Susceptibility  This output is a table of s/v ratios, in psi / ips, mode by 
mode, in rank order of decreasing magnitude. In addition to 
modal frequencies and s/v ratios, the table also includes the 
node locations of the maxima of vibration amplitude and 
bending stresses. 

 With the dynamic susceptibility output selected, the animated 
graphic display of the vibration mode shape includes the 
added feature of color spot markers showing the locations of 
maximum vibration and maximum dynamic bending stress. 

These outputs will assist the designer through a more-complete understanding of the 
system’s dynamic characteristics. They provide incisive quantified insights into how specific 
details of components, layout and support could contribute to large dynamic stresses, and 
into how to make improvements. 
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4 What the Dynamic Susceptibility Method Does Not Do Directly 

The Stress / Velocity method of assessment, and its implementation in CAEPIPE as 
dynamic susceptibility, is based entirely upon the system’s dynamic characteristics per se. Thus the 
vibration velocities and dynamic stresses employed in the analysis, although directly related 
to each other, are of arbitrary magnitude. There is no computation of the response to a 
prescribed forcing function, and no attempt to calculate actual dynamic stresses. Thus the 
dynamic susceptibility results do not factor directly into a pass-fail code compliance 
consideration. Rather, they assist the designer to assess and reduce susceptibility to large 
dynamic stresses if necessary, in order to meet whatever requirements have been specified. 

An example follows next. 

5 Illustrative Example of the Dynamic Susceptibility Analysis 

The “dynamic susceptibility” feature of CAEPIPE will be illustrated here by application to 
the standard CAEPIPE Example system. The modal analysis was performed for frequencies 
up to 200 Hz, resulting in a reporting-out for 12 modes. 

 

The frequencies range from mode 1 at 14.5 Hz to mode 12 at 192 Hz. In two instances, very 
similar horizontal and vertical modes appear in pairs, i.e. modes 3 & 4 and 7 & 8. 

The relevant features of this system can be readily identified and understood, by reference to 
the dynamic-susceptibility table and the animated graphic display of mode shape. Results will 
be considered here in the order of decreasing susceptibility. 
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5.1 Axial movement of long pipe run (large added mass in motion) 

From the dynamic susceptibility table, the top of the list is mode 2 at 20.8 Hz, having a 
dynamic susceptibility of 651 psi / ips. 

 

From the animated graphic display, note that the maximum dynamic bending stresses are at 
the anchored point, node 50. Note also that the dominant motion is a “Z” motion of the 
straight run between nodes 20 and 40 (i.e., in effect an axial motion of that run as a rigid 
body). The designer’s interpretation here is that the vertical rise from node 50 to node 40 is 
effectively a cantilevered beam with an effective large added mass at the tip; that feature of 
layout accounts for the high susceptibility. 

5.2 Effects associated with the valve (local rigidity to bending, and added mass) 

The next-highest values of susceptibility are for the two pairs of modes, modes 7 & 8 at 129 
and 133 Hz, and modes 3 & 4 at 27.7 and 31.2 Hz. As will be shown here, these are 
associated with effects of the valve, 
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The susceptibility for modes 7 & 8, respectively 594 and 589 psi / ips, is attributable to the 
rigidity of the valve element within an otherwise flexible pipe run. This can be seen from a 
close look at the animated graphic. Notice that these relatively high frequency modes feature 
a reversal of bending curvature along the run between nodes 30 and 80. Notice also that 
there is a stronger localized curvature on approach to the valve body. The designer’s 
interpretation here is that, since there cannot be any curvature of the rigid valve itself, there 
must be a more concentrated curvature of the adjacent pipe. 

The dynamic susceptibility of modes 3 & 4, respectively 522 and 526 psi / ips, is associated 
with the more straightforward “concentrated mass” effect of the valve. 

 

 

From the animated graphic, these modes feature a large amplitude vibration at the valve. The 
kinetic energy of this added mass must be stored as strain energy in the flexing (i.e., spring) 
element, resulting in elevated dynamic stresses. 

5.3 Beam modes with “moderate” added mass effects of adjacent spans 

Modes 1,5 and 6, with frequencies of 14.5, 47.4 and 52.4 Hz, show progressively decreasing 
“intermediate to low” values of susceptibility at respectively 458, 384 and 339 psi / ips. 
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Reference to the animated graphics shows that these modes involve predominantly transverse 
vibration (as contrasted with the prominent axial movement of mode 2) and involve little 
participation at the valve (which accounted for the elevated susceptibility of modes7 & 8 and 3 
& 4). Notice that these modes, 1, 5, and 6, involve varying degrees of the influence of 
effective added mass of adjacent spans, and of length of the cantilevered span contributing 
most to stiffness. 

5.4 Modes approaching the “simple-beam baseline” behavior 

Modes 10, 11 and 12 have significantly higher frequencies, 164 to 192 Hz, and 
correspondingly short wavelengths. Consequently, the vibration pattern tends to be 
transverse beam vibration “within the span,” with little or no effect from connected spans or 
the valve. For these modes, the susceptibility ratios range from 256 to 272 psi / ips. These 
values are approaching the baseline values for uncomplicated mode shapes of the pipe 
section and pipe contents of this system. 
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NOTE: Mode 9, at 138 Hz, is clearly an exception, with a susceptibility of only 104 psi / ips, 
well below the baseline level. From the animated display, it can be seen that this is not really a 
“bending” mode; rather, the spring effect for this mode is an axial stretching of the run 
between nodes 80 and 30. Consequently, the bending stresses are low, as reflected in the 
abnormal susceptibility ratio. In effect, this mode lies outside the intended application of the 
dynamic susceptibility approach. Notice however, that the low susceptibility ratio has in 
effect “flagged” this mode as “not a bending mode”; that in itself provides the designer 
additional insight into system characteristics and behavior. 

5.5 Summary Comment 

As per paragraphs 5.1 to 5.4, the dynamic susceptibility method has incisively identified the 
key features of the Sample model, with respect to potentially large dynamic stresses. This of 
course is a relatively simple system. An experienced designer, with some appreciation of 
dynamics, might view the results as obvious. However, the method will do the same job, 
automatically and directly, on any larger or more complex system for which nothing is 
obvious! 

6 Summary of “Dynamic Susceptibility” Analytical Capability 

The stress / velocity method, implemented in CAEPIPE as the “Dynamic Susceptibility” 
feature, provides quantified insights into the stress versus vibration characteristics of the 
system layout per se. 

In particular, the dynamic susceptibility table identifies specific modes that are susceptible to 
large dynamic stresses for a given level of vibration. The larger the stress / velocity ratio, the 
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stronger the indication that some particular feature of layout, mass distribution, supports, 
stress raisers, etc., is causing susceptibility to large dynamic stresses. 

The animated mode-shape display identifies, by the color-spot-markers, the locations of the 
respective maxima in dynamic stress and vibration velocity. Review of these animated plots 
will reveal the offending pattern of motion, and provide immediate insight into what features 
of the system are responsible for the large dynamic stresses. 

Finally, the “dynamic stresses” table provides the distribution of dynamic stresses around the 
system, i.e., in effect, the mode shape of dynamic stresses to go along with the conventional 
mode shape of vibration. This information allows identification of other parts of the system, 
if any, with dynamic stresses comparable to the identified maximum. 

7 Suggested Applications and Associated Benefits  

7.1 At the Design Stage 

At the design stage, the dynamic susceptibility feature allows the designer to quickly 
determine whether the system may be susceptible to very large dynamic stresses. This could 
be a broad look at all frequencies, or could be focused on particular frequencies where excitation is likely 
to occur. On identifying high susceptibility, the designer can then make changes to improve 
the design. It is important to note that this method is based upon the dynamic-stress versus 
vibration-velocity characteristics of the system per se. There is no need to specify a forcing 
function and perform a response calculation and stress / fatigue analysis. However, where such 
analysis is a requirement, the dynamic susceptibility module can assist the designer to achieve a 
system layout that will meet the requirements and criteria. 

7.2 Commissioning, Acceptance Testing 

The dynamic susceptibility feature can also contribute to planning acceptance testing and 
associated measurements where these are undertaken whether by formal requirement or by 
choice. Locations for measurement of vibration or dynamic strain can be selected based 
upon knowing the locations of the maxima and the distribution of vibration and dynamic 
stress. Reference to the dynamic susceptibility results can help assure that the modes of most 
potential concern are well covered by the minimum set of practically-achievable measurements. Furthermore, 
mode-specific acceptance criteria can be readily established to avoid the restrictions of generally 
over-conservative guideline type criteria, while providing assurance that any highly-susceptible situations are 
identified and addressed. 

7.3 Troubleshooting and Correction 

As mentioned earlier, when vibration and/or fatigue problems are recognized at start up or 
early operation, there is typically an ad hoc program of observation, measurement, 
assessment, diagnosis and correction. It is not uncommon for there to be some uncertainty 
about what to measure and what is acceptable. The dynamic susceptibility module can 
contribute very effectively in these situations. 

Normally, the overall symptoms, approximate frequency and pattern of vibration are known 
to some extent from observation and/or a few measurements. After modeling the system, 
and obtaining the dynamic susceptibility results, the subsequent steps can be highly focused on 
specific frequencies and locations, the optimum measurements, and system-specific acceptance 
criteria. 
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Equally or more importantly, the proposed solution options can be modeled and evaluated to make 
sure they will achieve the required improvement. 

7.4 General 

The dynamic susceptibility module does not apply directly to meeting code or other formal stress analysis 
requirements. However, it is an incisive analytical tool to help the designer understand the 
stress / vibration relationship, assess the situation and to decide how to modify the design if 
necessary. It can be used for design, planning acceptance tests, and troubleshooting and 
correction. 

8 Information for Reference 

The Stress /Velocity method for screening piping system modes was developed and brought 
to the attention of SST Systems by Dr. R.T Hartlen of Plant Equipment Dynamics Inc. 

The background material provided here is intended to provide only a concise summary of 
the underlying fundamentals, the universality for idealized systems, and the expected detail-
dependent variations for real systems. The stress / velocity method, although not yet widely 
known and applied, is fundamentally theoretically sound. However, complete theoretical 
rigor is beyond the scope of this note. 

For users who may wish to independently examine and validate the underlying theoretical 
fundamentals, a few key references are provided. References 1, 2 and 3 deal with 
fundamentals. References 5 and 6 deal with application to piping. The CEA research projects 
reported in References 3 and 4 were initiated and guided by Dr. Hartlen. 
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Annexure II 

Nozzle Stiffness Calculations
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Six stiffnesses are shown below at the nozzle-vessel interface — three are calculated and the 
other three are assumed rigid. 

 

 

 

 

The coordinate system is as shown in the figure. The six components of the forces and 
moments at the nozzle-vessel interface are: 

P = Radial load MC = Circumferential moment 

VC = Circumferential load MT = Torsional moment 

VL = Longitudinal load ML = Longitudinal moment 

Of the six components of stiffnesses, only three stiffnesses, axial (Kx), circumferential (Kyy), 

and longitudinal (Kzz), are calculated. The remaining three are assumed to be rigid. 

Several graphs are given at the end of this annexure. The stiffness coefficients are obtained 
by interpolating logarithmically from these graphs. 

The first two, Figures D-1 and D-2, are used to calculate nozzle stiffness coefficients for 
Nozzles on cylindrical vessels. Figure D-1 is used to calculate the axial stiffness coefficient 
and Figure D-2 is used to calculate circumferential and longitudinal stiffness coefficients. 
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Nomenclature 

𝐷 = mean diameter of vessel 

𝑑 = outside diameter of nozzle 

𝑇 = thickness of vessel 

𝑡 = thickness of nozzle 

λ = (𝑑/D)√𝐷/T 

Λ = 𝐿/√𝐷𝑇 

𝐿 = unsupported length of cylinder 

 = 8𝐿1𝐿2/(√𝐿1 + √𝐿2)
2
 

𝐿1 = distance from nozzle center line to vessel end 

𝐿2 = distance from nozzle center line to vessel end 

𝐸 = modulus of elasticity of vessel material 

Axial Stiffness(𝑲𝒙) 

𝐾𝑥 = 𝛼 ×
4.95𝐸𝑇2

𝐷√𝛬
 

where 

𝛼 = stiffness coefficient read from Figure D-1 

Circumferential Stiffness(𝑲𝒚𝒚) 

𝐾𝑦𝑦 = 𝛽 × 𝐸𝑇3 

where 

𝛽 =1stiffness coefficient read from Figure D-2. 

The bottom three curves in Figure D-2, marked Circumferential moment MCare used to 

find𝛽. 

Longitudinal Stiffness(𝑲𝒛𝒛) 

𝐾𝑧𝑧 = 𝛾 × 𝐸𝑇3 

where 

γ = stiffness coefficient read from Figure D-2. 

The top two curves in Figure D-2, marked Longitudinal moment MLare used to findγ. 

(1) 

(2) 

 (3) 
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Calculation of Nozzle stiffnesses for Nozzles on Flat-bottom tanks 

This procedure is similar to the previous one. 

 

As before, only three stiffnesses are calculated as the other three are assumed to be rigid. The 

ones that are calculated are axial(𝐾𝑥), circumferential(𝐾𝑦𝑦), and longitudinal (𝐾𝑧𝑧). 

For Nozzles on flat-bottom tanks, twelve graphs are given at the end of this annexure, 
Figures D-3 through D-14. Six are for “with reinforcing pad (on vessel)” with the other six 
for no reinforcing pad on the vessel. The stiffness coefficients are obtained using the 
appropriate graph. 
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Nomenclature 

𝑅 = Mean radius of vessel  

𝑡 = thickness of vessel 

2𝑎 = outside diameter of nozzle 

Axial Stiffness(𝑲𝒙) 

𝐾𝑥 = 𝐾𝑅 × 𝐸 × (2𝑎) 

where 

𝐾𝑅 = axial stiffness coefficient. 

Circumferential Stiffness(𝑲𝒚𝒚) 

𝐾𝑦𝑦 = 𝐾𝐶 × 𝐸 × (2𝑎)3 

where 

𝐾𝐶  = circumferential stiffness coefficient. 

Longitudinal Stiffness(𝑲𝒛𝒛) 

𝐾𝑧𝑧 = 𝐾𝐿 × 𝐸 × (2𝑎)3 

where 

𝐾𝐿 =longitudinal stiffness coefficient. 

The graphs for stiffness coefficients follow: 

(4) 

(5) 

(6) 
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Figure D-1:Stiffness coefficient for axial load on nozzle 
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Figure D-2:Stiffness coefficients for moment loads on nozzle 
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Figure D-3:Stiffness coefficient for axial load (with reinforcing pad)(L/2a = 1.0) 

 

Figure D-4:Stiffness coefficient for circumferential moment (with reinforcing 
pad)(L/2a=1.0) 
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Figure D-5: Stiffness coefficient for longitudinal moment (with reinforcing pad)(L/2a = 1.0) 

 

Figure D-6:Stiffness coefficient for axial load (with reinforcing pad)(L/2a = 1.5) 
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Figure D-7:Stiffness coefficient for circumferential moment (with reinforcing pad) 
(L/2a = 1.5) 

 

Figure D-8:Stiffness coefficient for longitudinal moment (with reinforcing pad)(L/2a=1.5) 
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Figure D-9:Stiffness coefficient for axial load (no reinforcing pad)(L/2a = 1.0) 

 

Figure D-10:Stiffness coefficient for circumferential moment (no reinforcing pad)(L/2a= 
1.0) 
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Figure D-11:Stiffness coefficient for longitudinal moment (no reinforcing pad)(L/2a = 1.0) 

 

Figure D-12:Stiffness coefficient for axial load (no reinforcing pad)(L/2a = 1.5) 



Nozzle Stiffness Calculations 
 

386 

 

Figure D-13:Stiffness coefficient for circumferential moment (no reinforcing pad) 
(L/2a = 1.5) 

 

Figure D-14:Stiffness coefficient for longitudinal moment (no reinforcing pad)(L/2a=1.5)
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A 

absolute sum, 82, 83 
acceleration, 205, 320, 321 

spectral, 205 
vector, 78, 83, 84, 205 

additional weight, 19, 172, 175, 297, 346, 347 
anchor, 3 

displacements, 4 
releases for hanger selection, 4 
settlement, 5 
stiffness, 3 

angle 
valve, 350 

animate 
mode shape, 85 

ANSI pipe sizes, 27, 302 
API, 69, 256 
API 610 report, 256, 263, 265 
API 617, 256 
API 617 report, 69 
API 650, 221, 225 
axes 

elastic element, 87 
local beam, 13 
local coordinate system, 176 

axial force, 111 
axial stiffness, 220 

B 

ball joint, 9 
friction, 217 
rotation limit, 10 
stiffness, 9 

beam, 12 
additional weight, 19 
AISC library, 16 
beta angle, 13 
end releases, 13 
load, 18 
local coordinate system, 20 
material, 13 
orientation, 20 
section, 14 

bellows, 24 
stiffness, 24 
tie rods, 328 

bend, 26 
examples, 28 

180° bend, 31 
45° bend, 30 
90° bend, 29 
base supported, 39 
flanged, 32 
reducing, 35 
supported by a hanger, 37 

flexibility factor, 27 

intermediate nodes, 28 
long radius, 26, 27 
material, 27 
radius, 27 
short radius, 26, 27 
SIF, 28, 35 
tangent intersection point, 26 
thickness, 27 

bottomed-out springs, 323 
branch connection 

nonstandard, 345 
branch line, 48, 135 
branch SIF, 47 
buried piping, 50 

general procedure, 50 
ground level, 53 
nomenclature, 54 

C 

circumferential 
joint factor, 196, 198, 202 
stiffness, 222, 375, 376, 377, 378 

closely spaced modes, 83 
cold load, 144 
cold spring, 66 
comment, 68 
compressor, 69 
concentrated mass, 72 
cone angle, 266, 267 
connected node, 164, 299 

hanger, 143 
skewed restraint, 306 

constant support, 73 
user defined hanger, 332 

coordinates, 135, 216 
core pipe, 155, 159, 185, 314 
core properties, 158 
corrosion allowance, 301 
cut pipe, 66 

D 

data types, 74 
density, 202 
design 

hanger, 142 
pressure, 174 
temperature, 174 

DIN pipe sizes, 27, 302 
direction, 75 
displacement vector, 78, 82 
displacements 

anchor, 4 
nozzle, 222 

dynamic analysis, 78 
closely spaced modes, 83 
effective modal mass, 81 
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friction, 218, 220 
modal analysis, 78 
modal equations, 79 
orthogonality, 79 
participation factors, 80, 81 
response spectrum, 82 
support motion, 80 
time history, 83 

dynamic susceptibility, 85 
environment variable, 85 
method, 363 

E 

effective modal mass, 81 
eigenvalues, 78 
eigenvector, 78 

normalized, 205 
elastic element, 87 

stiffness, 87 
elbow, 26 
element forces and moments 

in local coordinate system, 178 
element stresses 

FRP, 103 
environment variable 

CPITER, 220 
dynamic susceptibility, 85 
HARTLEN, 85 

exit, 220 
expansion joints, 24, 88 

bellows, 88, 90, 93 
tied bellows, 88, 90, 93 

F 

fiber reinforced plastic piping (FRP), 103, 104 
flexibility factor, 104 
moduli, 104 
SIF, 104 
siffness matrix, 104 

flange, 107 
allowable pressure, 108 
equivalent pressure, 108 
flange and bolt stresses, 115 
gasket diameter, 108 
library, 110 
rating, 108 

flange and bolt stresses, 115 
flange module, 115 
flexibility factor 

bend, 27 
FRP, 104 
miter bend, 209 

force, 128 
force spectrum, 129 

convert time function, 132 
load, 133 
read from a text file, 132 

frequencies 

closely spaced, 83 
frequency 

circular, 81, 205 
natural, 364 

friction, 218 
ball joint, 220 
guide, 219 
hinge joint, 219 
in dynamic analysis, 218, 220 
limit stop, 218 
slip joint, 219 

friction coefficient, 140, 164, 217, 323 
friction force, 140, 162, 164, 218, 310 
friction torque, 9, 148, 218, 219, 310 
From node, 135 

G 

gasket diameter, 108 
generic support, 137 
global 

coordinate system, 176 
origin, 53 

guide 
friction, 219 
friction coefficient, 140 
gap, 141 
local coordinate system, 141 
stiffness, 141 

H 

hanger, 142 
below, 143 
catalog, 144, 322 
cold load, 143 
connected node, 143 
constant support, 73 
design procedure, 144 
hot load, 144 
load variation, 144 
manufacturer, 144 
number of, 143 
report, 299 
rod, 299 
short range, 143 
stiffness, 143 
to be designed, 142 
travel, 144, 218, 323 
type, 143 
user, 332 

harmonic analysis, 84 
hinge joint, 147 

angular stiffness, 148 
axis direction, 149 
example, 150 
friction, 219 
friction torque, 148 
rotational limit, 148 
rotational stiffness, 148 
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Weight, 149 
hydrotest 

load, 153 
load case, 154 

I 

input 
new material, 198 

insulation, 303 
density, 303 
thickness, 303 

intermediate nodes, 28 
internal nodes, 159 

J 

jacket end cap, 155 
jacket pipe, 195 
jacket properties, 158 
jacketed bend, 157 

internal nodes, 159 
jacketed pipe, 156 

internal nodes, 157 
jacketed piping 

jacketed bend, 157 
jacketed reducer, 159 

JIS pipe sizes, 27, 302 
joint factor, 202 

circumferential, 202 
longitudinal, 198, 202 

K 

knuckles 
reducer, 267 

L 

lateral tee, 49 
left out force, 205 
limit stop, 162 

friction, 218 
nonlinearities, 217 

solution procedure, 217 
lining, 303 
load 

additional weight, 175 
Design pressure, 175 
Design temperature, 175 
pressure, 174 
snow, 175 
specific gravity, 175 
static seismic-ANSI A58.1-1988, 320 
static seismic-ASCE/SEI 7-16, 315 
temperature, 174 
wind, 175 

load cases 
cold spring, 66 
force spectrum, 133 

hydrotest, 154 
loads 

acceleration, 321 
force spectrum, 130 

local coordinate system, 176 
element forces and moments, 178 
for a beam, 20 
for a bend, 178 
for a guide, 141 
for a pipe, 176 

local forces, 178 
location, 185 
logarithmic interpolation, 82, 375 
long radius, 26, 27 
longitudinal 

joint factor, 198, 202 
pressure stress, 202 

longitudinal stiffness, 222, 375, 376, 378 

M 

material 
create library, 17, 202 
define, 195 
density, 202 
description, 201 
input, 198 
name, 201 
selectr from library, 200 
type, 201 

missing mass correction, 205 
miter bend 

closely spaced, 209 
flexibility factor, 209 
modeling procedure, 210 
parameters, 209 
widely spaced, 208, 209 

modal analysis, 78 
modal displacements, 79 

N 

node, 216 
internal, 159 
list coordinates, 216 
specifying coordinates, 216 

nominal diameter, 302 
nonlinearities, 217 

ball joint, 220 
friction, 218 
guide, 219 
hinge joint, 219 
limit stop, 218 
misconvergence, 220 
number of iterations, 220 
slip joint, 219 
types, 217 

nonstandard 
branch connection, 345 
pipe, 302 
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nozzle, 221 
axial stiffness, 222, 375, 376, 378 
circumferential stiffness, 222, 375, 376, 378 
coordinate system, 222, 375 
displacements, 225 
example 

on a cylindrical vessel, 226, 227 
on a flat-bottom storage tank, 228 

longitudinal stiffness, 222, 375, 376, 378 
on a cylindrical vessel, 221 
reinforcing pad, 225 
settlement, 226 
stiffness calculations, 375 
stiffness coefficients, 375 

Nozzle Evaluation, 231 
NRC Guide 1.92, 83 
number of modes, 205 
number of thermal loads, 19, 172 

O 

occasional load, 134 

P 

pad thickness, 47 
participation factor, 80, 81, 205 
period, 82 
pipe skirt, 323 
pipe slide assembly, 323 
pipe slide/shoe assembly, 167 
Poisson’s ratio, 202 
pressure 

gauge, 174 
negative, 174 

pump, 256 

R 

reducer, 266 
concentric, 266 

example, 268 
cone angle, 266, 267 
delta, 268 
eccentric, 266 

example, 269 
example 

concentric, 268 
eccentric, 269 

jacketed, 271 
knuckles, 267 
SIF, 267 
stresses, 268 
weight, stiffness and stress calculation, 268 

reducing tee, 48 
releases for hanger selection, 3 
relief valve, 350 
report 

flange, 113 
response spectrum, 82, 226 

restraint, 296 
stiffness, 296 

rigid body force, 205 
rigid element, 297 

stiffness, 297 
weight, 297 

rod hanger, 299 
stiffness, 299 

rotation limit 
ball joint, 10 
hinge joint, 148 

S 

section, 301 
ANSI pipe sizes, 302 
corrosion allowance, 302 
DIN pipe sizes, 302 
insulation, 303 
JIS pipe sizes, 302 
lining, 303 
mill tolerance, 302 
name, 302 
nominal diameter, 302 
nonstandard, 302 
schedule, 302 

section modulus, 302 
settlement 

anchor, 5 
nozzle, 226 

shear 
area, 15 
deflection, 15 

shear deflection, 15 
short radius, 26, 27 
SIF 

branch, 47 
FRP, 104 
reducer, 267 
user, 345 
weld, 351 

sign conventions, 178 
skewed restraint, 305 

connected node, 307 
direction, 306 
example 

sway brace, 307 
rotational, 306 
stiffness, 306 
translational, 306 
type, 306 

slip joint, 310 
friction, 219 
friction force, 310 
friction torque, 310 
pressure thrust area, 310 

snow load, 19, 172, 175 
snubber, 313 

stiffness, 313 
specific gravity, 175 
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spider, 314 
spring rate, 73, 144, 299, 332 
SRSS, 82 
stiffness 

anchor, 3 
ball joint, 10 
bellows, 24 
elastic element, 87 
guide, 141 
hanger, 143 
hinge joint, 148 
limit stop, 164 
nozzle, 221, 375 
reducer, 268 
restraint, 296 
rigid element, 297 
rod hanger, 299 
snubber, 313 
tie rod, 328 
user hanger, 332 
valve, 347 

stiffness matrix, 78, 83, 84, 144, 217, 218 
FRP, 104 

stresses 
FRP, 105 
occasional, 302 
reducer, 268 
sustained, 302 

support motion, 80 
supports 

anchor, 322 
generic, 137 
guide, 323 
hangers, 322 
limit stop, 323 
restraint, 322 
skewed restraint, 322 

sway brace, 305, 307, 322 
sway struts, 305, 322 

T 

tangent intersection point, 26, 178 
tee 

SIF, 47 
Tee, 325 
tensile strength, 202 
thermal loads, 4, 172, 226 

tie rod, 328 
stiffness, 328 

time history, 83 
turbine, 329 

U 

u-bolt, 323 
user hanger, 332 

constant support, 332 
load, 332 
spring rate, 332 
stiffness, 332 

user SIF, 345 
u-strap, 323 

V 

valve, 346 
additional weight, 347 
angle, 350 
calculation of moment of inertia, 350 
insulation weight X, 347 
length, 346 
library, 348 
relief, 350 
stiffness, 347 
thickness X, 347 
weight, 346 

velocity vector, 83 

W 

weight multiplier, 350 
weld, 351 
wind, 352 
wind load, 175 
WRC 297, 221 

Y 

Y factor, 201 

Z 

zero length element, 9, 147 

 

 


